Welcome
Welcome to Time America's TA100 Pro User's Guide. This manual is shipped with each new TA100 Pro software package and is intended solely for use by the licensee. This User Guide describes the installation and operation of the TA100 Pro system.

Accuracy of Information
The content of this manual is subject to change without notice. Before using this manual, verify that the information contained in it is current. Proper installation, configuration, and operation of the software are contingent upon reading and following the procedures contained in the latest revision of the manual.

Additional Copies
Additional copies of this manual may be obtained from our website at www.timeamerica.com or from your local Time America dealer.

User Comments
Every effort is made to ensure that the information contained in this manual is accurate at the time of publication. If you find an error or omission while reading this manual, direct your comments to:

Time America, Inc.
Attn: Technical Publications
15990 N. Greenway Hayden Loop
Suite #D-500
Scottsdale, AZ 85260

Or you can send emails to:
training@timeamerica.com

We welcome your comments and suggestions.

Software Release Version
4.00A
# TABLE OF CONTENTS

## CHAPTER I  ABOUT THIS MANUAL
- Disclaimer ................................................... 9
- Technical Support ........................................... 9
  When Calling Technical Support for Assistance .......... 9

## CHAPTER II  INSTALLATION
- System Requirements ........................................ 10
- Installing the System ........................................ 10
- Hardware Keys .............................................. 16
  Main System Key ........................................... 16
  Polling Key ................................................... 16
  Demo Key ...................................................... 17

## CHAPTER III  GETTING STARTED
- Starting TA100 Pro and Logging In ....................... 19
  Note on User Accounts ...................................... 19
  Launching and Logging In to TA100 Pro ................. 19
  Exiting the System ......................................... 20
- Tips and Techniques ........................................ 21
- Using the Keyboard .......................................... 21
  Underlined Letters .......................................... 21
  Hot Keys ....................................................... 22
  Additional Keyboard Access ................................ 22
- Help .......................................................... 23
  Access the Online Help Window .......................... 23
  Use Help Contents ......................................... 23
  Use the Help Index ......................................... 23
  Use Help Find ............................................... 24
  Return to the Help Topics Window ....................... 24
  Print a Help Topic .......................................... 24
- Configuring the System Environment .................... 25
  Play Bell Tones ............................................. 25
  Change Screen Background .................................. 25
  Large Button Toolbar ...................................... 26

## CHAPTER IV  CONFIGURATION
- Main Company .............................................. 28
- Divisions .................................................... 34
  Configure Divisions ....................................... 34
  Add a Division .............................................. 35
  Edit a Division .............................................. 35
  Delete a Division .......................................... 35
- Categories .................................................. 37
  Configure Categories ..................................... 38
  Add a Category ............................................ 41
  Edit a Category ............................................ 41
  Delete a Category ......................................... 42
- Policies ..................................................... 43
  Configure Policies ........................................ 43
| Add a Policy | 53 |
| Edit a Policy | 54 |
| Delete a Policy | 54 |

**SHIFTS** | 55
---|---
Configure a Shift Group | 55
Add a Shift Group | 64
Edit a Shift Group | 64
Delete a Shift Group | 65
Add a Shift | 65
Edit a Shift | 65
Delete a Shift | 66
Add a Rounding Rule | 66
Edit a Rounding Rule | 67

**HOLIDAYS** | 68
---|---
Configure Holidays | 68
Add a Holiday | 69
Edit a Holiday | 69
Delete a Holiday | 70

**GROUPS** | 70
---|---
Configure Groups | 70
Add a Group | 71
Edit a Group | 71
Delete a Group | 72

**DEPARTMENTS** | 73
---|---
Configure Departments | 73
Add a Department | 76
Edit a Department | 76
Delete a Department | 76

**JOBS** | 77
---|---
Configure Jobs | 77
Add a Job | 79
Edit a Job | 80
Delete a Job | 80

**BELL SCHEDULES** | 81
---|---
Configure Bell Schedules | 81
Add a Bell Schedule | 82
Edit a Bell Schedule | 83
Delete a Bell Schedule | 83

**SECURITY** | 84
---|---
Configure Security Levels | 85
Add a Security Level | 94
Edit a Security Level | 94
Delete a Security Level | 95
User Maintenance | 95
Who's Logged In | 102
Change Password | 102

**BENEFIT ACCRUALS** | 103
---|---
Configure Benefit Accruals | 103
Configure Benefit Accumulators | 105
Add a Benefit Accruals Policy | 108
Edit a Benefit Accruals Policy | 110
Delete a Benefit Accruals policy | 110
Update to Current | 111

**CHAPTER V** **OPTIONAL MODULES** | 112
TABLE OF CONTENTS, Cont.

BELL SCHEDULES ................................................................. 112
BENEFIT ACCRUALS .............................................................. 112
PC CLOCK ........................................................................... 112
THIRD PARTY TERMINALS ............................................... 113

CHAPTER VI  ADDITIONAL EMPLOYEE FEATURES ................................................................. 114

PC CLOCK ........................................................................... 114
  Accessing PC Clock ........................................................ 114
  Default Settings to Use PC Clock .................................... 114
  Default Clock In .............................................................. 115
  Default Clock Out .......................................................... 115
  Default Clock Out for Lunch ......................................... 116
  Default Clock In from Lunch ......................................... 116
  Default Transfer Department ........................................ 116

CHAPTER VII  EMPLOYEE MAINTENANCE .............................................................................. 117

CONFIGURE EMPLOYEE ................................................... 117
EMPLOYEE LIST ................................................................. 118
EMPLOYEE TIMECARD (DESCRIPTION) TAB ................. 119
EMPLOYEE SCHEDULE TAB ............................................. 123
  Configure Employee Schedules .................................... 123
  Assign or Edit an Employee Schedule ......................... 124
  Delete a Schedule .......................................................... 126
  Create a Rotating Schedule .......................................... 127
  Create an Employee Schedule Template ...................... 128
  Copy an Employee Schedule Template ....................... 129

EMPLOYEE TRANSACTIONS TAB ........................................ 131
  Description .................................................................... 131

EMPLOYEE STATUS TAB ................................................... 132
  Configure Employee Status ......................................... 132
  Add Employee Status ..................................................... 133
  Edit Employee Status ..................................................... 134
  Delete Employee Status ................................................. 134

EMPLOYEE BENEFITS TAB ................................................. 135
  Benefit Entitlement: Configure .................................... 135
  Benefit Entitlement: Employee Benefit Details ............... 136
  Benefit Entitlement: Grant Benefit Time ....................... 137
  Benefit Entitlement: Delete a Detail ............................... 137
  Benefit Accruals: Configure .......................................... 138
  Benefit Accruals: Update Employee Benefits ................. 139
  Benefit Accruals: Employee Benefit Details ... ............... 139
  Benefit Accruals: Manual Benefit Adjustment ............... 140
  Benefits Accrual: Delete a Manual Adjustment ............. 141

EMPLOYEE MESSAGES TAB ............................................... 142
  Configure ....................................................................... 142
  Add a Message ............................................................... 143
  Edit a Message ............................................................... 144
  Delete a Message ........................................................... 144

EMPLOYEE WAGES .......................................................... 144
  Configure Employee Wages .......................................... 144
  Add a Global Wage ....................................................... 146
  Edit a Global Wage ....................................................... 146
  Delete a Global Wage ................................................. 147
  Add an Employee Level Wage ..................................... 147
  Edit an Employee Level Wage .................................... 148
## TABLE OF CONTENTS, Cont.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EMPLOYEE BADGES TAB</strong>  ...................................................................</td>
<td>148</td>
</tr>
<tr>
<td>Configure Employee Badges</td>
<td>148</td>
</tr>
<tr>
<td>Add a Badge</td>
<td>149</td>
</tr>
<tr>
<td>Edit a Badge</td>
<td>150</td>
</tr>
<tr>
<td>Delete a Badge</td>
<td>150</td>
</tr>
<tr>
<td><strong>EMPLOYEE CLOCKS TAB</strong>  ..................................................................</td>
<td>150</td>
</tr>
<tr>
<td>Configure Hand Readers</td>
<td>150</td>
</tr>
<tr>
<td>Configure TA7000</td>
<td>152</td>
</tr>
<tr>
<td><strong>EMPLOYEE DETAILS TAB</strong>  ..................................................................</td>
<td>153</td>
</tr>
<tr>
<td>Configure Employee Details</td>
<td>153</td>
</tr>
<tr>
<td>Add an Employee</td>
<td>154</td>
</tr>
<tr>
<td>Edit an Employee</td>
<td>155</td>
</tr>
<tr>
<td>Delete an Employee</td>
<td>157</td>
</tr>
<tr>
<td><strong>CHAPTER VIII  TIMECARD AND TRANSACTION MAINTENANCE</strong></td>
<td>158</td>
</tr>
<tr>
<td>ONLINE TIMECARD</td>
<td>158</td>
</tr>
<tr>
<td>Accessing the Online Timecard from the Configure Employee Screen</td>
<td>158</td>
</tr>
<tr>
<td>Accessing the Online Timecard from the Approval Editor</td>
<td>158</td>
</tr>
<tr>
<td>NAVIGATING IN THE ONLINE TIMECARD TAB</td>
<td>159</td>
</tr>
<tr>
<td>NAVIGATING IN THE TRANSACTIONS TAB</td>
<td>160</td>
</tr>
<tr>
<td>ADDING AND EDITING TRANSACTIONS</td>
<td>160</td>
</tr>
<tr>
<td>Add Transaction</td>
<td>161</td>
</tr>
<tr>
<td>Add Miscellaneous Transaction</td>
<td>162</td>
</tr>
<tr>
<td>Edit a Transaction</td>
<td>164</td>
</tr>
<tr>
<td>Edit/Add Start</td>
<td>164</td>
</tr>
<tr>
<td>Edit/Add Stop</td>
<td>165</td>
</tr>
<tr>
<td>Multiple Miscellaneous</td>
<td>165</td>
</tr>
<tr>
<td>From Schedule</td>
<td>167</td>
</tr>
<tr>
<td>DELETE A TRANSACTION</td>
<td>167</td>
</tr>
<tr>
<td>AUDIT TRAILS</td>
<td>168</td>
</tr>
<tr>
<td>Print the Audit Trails</td>
<td>169</td>
</tr>
<tr>
<td>APPROVAL EDITOR</td>
<td>170</td>
</tr>
<tr>
<td>STATUS BOARD</td>
<td>173</td>
</tr>
<tr>
<td>TASK ORGANIZER</td>
<td>174</td>
</tr>
<tr>
<td><strong>CHAPTER IX  GLOBAL COMMANDS</strong></td>
<td>176</td>
</tr>
<tr>
<td>SELECTING EMPLOYEES IN GLOBAL OPERATION DIALOG BOXES</td>
<td>176</td>
</tr>
<tr>
<td>Select Employees Individually</td>
<td>176</td>
</tr>
<tr>
<td>Select Employees Globally</td>
<td>176</td>
</tr>
<tr>
<td>Select Employees by Group</td>
<td>176</td>
</tr>
<tr>
<td>Select Employees by Division</td>
<td>177</td>
</tr>
<tr>
<td>GLOBAL MESSAGE ASSIGNMENT</td>
<td>177</td>
</tr>
<tr>
<td>GLOBAL ADD TRANSACTION</td>
<td>178</td>
</tr>
<tr>
<td><strong>CHAPTER X  REPORTS</strong></td>
<td>180</td>
</tr>
<tr>
<td>IMPORTANT INFORMATION ON PRINTING REPORTS</td>
<td>180</td>
</tr>
<tr>
<td>Configure Printer</td>
<td>180</td>
</tr>
<tr>
<td>RUNNING A REPORT</td>
<td>181</td>
</tr>
<tr>
<td>Running a Report by Range</td>
<td>181</td>
</tr>
<tr>
<td>Running a Report by Individual</td>
<td>186</td>
</tr>
<tr>
<td>ON SCREEN REPORT PREVIEW</td>
<td>191</td>
</tr>
<tr>
<td>EMAILING A REPORT</td>
<td>193</td>
</tr>
<tr>
<td><strong>CHAPTER XI  TERMINAL CONFIGURATION</strong></td>
<td>195</td>
</tr>
<tr>
<td>TYPES OF CONNECTIONS</td>
<td>195</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS, Cont.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TA500, TA600 AND TA7000 SERIES (TA520/530, TA620, TA7000)</td>
<td>196</td>
</tr>
<tr>
<td></td>
<td>Configure a TA500/TA600/TA7000 Series Clock</td>
<td>196</td>
</tr>
<tr>
<td></td>
<td>TA715, TA777 AND TA780 SERIES</td>
<td>206</td>
</tr>
<tr>
<td></td>
<td>Configure a TA715/TA777/TA780 Series Clock</td>
<td>206</td>
</tr>
<tr>
<td></td>
<td>CONFIGURING PC CLOCK</td>
<td>214</td>
</tr>
<tr>
<td></td>
<td>Configure a PC Clock</td>
<td>214</td>
</tr>
<tr>
<td></td>
<td>TASC</td>
<td>216</td>
</tr>
<tr>
<td></td>
<td>Configure a TASC Clock</td>
<td>217</td>
</tr>
<tr>
<td></td>
<td>ATS SERIES CLOCKS</td>
<td>224</td>
</tr>
<tr>
<td></td>
<td>Configure ATS Clock</td>
<td>224</td>
</tr>
<tr>
<td></td>
<td>HAND READER CLOCKS</td>
<td>227</td>
</tr>
<tr>
<td></td>
<td>Configure a Hand Reader Clock</td>
<td>227</td>
</tr>
<tr>
<td></td>
<td>ADD A CLOCK</td>
<td>232</td>
</tr>
<tr>
<td></td>
<td>EDIT A CLOCK</td>
<td>233</td>
</tr>
<tr>
<td></td>
<td>DELETE A CLOCK</td>
<td>233</td>
</tr>
<tr>
<td></td>
<td>SET DATE AND TIME</td>
<td>234</td>
</tr>
<tr>
<td></td>
<td>CHAPTER XII TERMINAL POLLING AND AUTOPROCESSING</td>
<td>236</td>
</tr>
<tr>
<td></td>
<td>Polling</td>
<td>236</td>
</tr>
<tr>
<td></td>
<td>Polling Time Clocks</td>
<td>236</td>
</tr>
<tr>
<td></td>
<td>CONFIGURE AN AUTOPROCESS</td>
<td>238</td>
</tr>
<tr>
<td></td>
<td>Run as Service</td>
<td>238</td>
</tr>
<tr>
<td></td>
<td>Add an AutoProcess</td>
<td>239</td>
</tr>
<tr>
<td></td>
<td>Edit an Auto Process</td>
<td>243</td>
</tr>
<tr>
<td></td>
<td>Delete an AutoProcess</td>
<td>243</td>
</tr>
<tr>
<td></td>
<td>CHAPTER XIII UTILITIES</td>
<td>245</td>
</tr>
<tr>
<td></td>
<td>IMPORTING</td>
<td>245</td>
</tr>
<tr>
<td></td>
<td>Advanced Import</td>
<td>245</td>
</tr>
<tr>
<td></td>
<td>EXPORTING DATA</td>
<td>247</td>
</tr>
<tr>
<td></td>
<td>SYSTEM UTILITIES</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td>Repair Database</td>
<td>251</td>
</tr>
<tr>
<td></td>
<td>Reindex Database</td>
<td>251</td>
</tr>
<tr>
<td></td>
<td>Update Databases</td>
<td>252</td>
</tr>
<tr>
<td></td>
<td>Initialize Databases</td>
<td>252</td>
</tr>
<tr>
<td></td>
<td>Change Employee Number</td>
<td>253</td>
</tr>
<tr>
<td></td>
<td>Change Employee Number Width</td>
<td>253</td>
</tr>
<tr>
<td></td>
<td>Set Reprocess Date</td>
<td>254</td>
</tr>
<tr>
<td></td>
<td>Fix Unassigned Badges</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Repost from R-Files</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Purge R-Files</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Post Historical Data</td>
<td>257</td>
</tr>
<tr>
<td></td>
<td>Archive</td>
<td>258</td>
</tr>
<tr>
<td></td>
<td>Restore Archive</td>
<td>260</td>
</tr>
<tr>
<td></td>
<td>System Backup</td>
<td>261</td>
</tr>
<tr>
<td></td>
<td>System Restore</td>
<td>262</td>
</tr>
<tr>
<td></td>
<td>ADDITIONAL UTILITIES</td>
<td>263</td>
</tr>
<tr>
<td></td>
<td>Calculator</td>
<td>263</td>
</tr>
<tr>
<td></td>
<td>Calendar</td>
<td>264</td>
</tr>
<tr>
<td></td>
<td>About</td>
<td>264</td>
</tr>
<tr>
<td></td>
<td>System Configuration</td>
<td>265</td>
</tr>
<tr>
<td></td>
<td>Conversion Table</td>
<td>265</td>
</tr>
<tr>
<td></td>
<td>Macros</td>
<td>266</td>
</tr>
</tbody>
</table>

© July 2007 Time America, Inc.
Chapter I  About this Manual

This section describes how to use this manual. In addition to providing you with step-by-step knowledge for performing various procedures, this manual will help you get the most out of TA100 Pro.

Disclaimer

Every attempt is made to keep this manual up-to-date. However, software enhancements do occur, and the content of this manual is subject to change without notice. Before using this manual, verify that the information contained in it is current. Proper installation, configuration, and operation of the software are contingent upon reading and following the procedures contained in the latest version of the manual.

Technical Support

If you encounter a problem or need technical support after reading this manual, please contact your local Sales and Service Representative. Your local representative has received training in the areas of software installation, configuration, operation, and advanced troubleshooting. They are qualified to provide you with the highest level of technical support.

When Calling Technical Support for Assistance

If possible, contact your authorized local Sales and Service Representative while at the computer experiencing the problem so you can quickly answer questions and implement the solutions suggested by your representative.

Before calling, gather the following information. Your local Sales and Service Representative will need this information to assist you.

- The version and serial number of your TA100 Pro software.
- The name and version of the Operating System. The type of network being used (if applicable).
- The model number and EPROM revision of the data collection terminal(s) used with the TA100 Pro software.
- The name of all software options and/or modules installed.
- The make and model of the host computer (PC).
- The operations being performed when the problem occurred.
- A printout of any error message that was displayed.
Chapter II  Installation

This section describes how to install the TA100 Pro software, the Sentinel System Driver, and attach the hardware key.

System Requirements
To use the TA100 Pro system, the following are the recommended minimum system requirements must be present.

- Windows 95/98/2000/NT/ME/XP.
- Pentium III 500 or better.
- 128MB of total memory (RAM).
- A mouse, trackball, or other pointing device.

Additional Requirements
- 500MB of available disk space either on a workstation or accessible on a network drive.
- **NOTE**: A dedicated database server is not required.
- Additional disk space and an enhanced wide-area network connection may be required based on the number of employees, network distance, communication method, and the amount of live data contained in the system.

Polling PC
- An available serial port with a default address and interrupt.
- An available parallel port.

Installing the System

**NOTE**: Do not launch or run any other applications during the installation process.

1. Insert the TA100 Pro Installation CD into the CD ROM drive of the computer on which you wish to install the software. The InstallShield Wizard should automatically appear.

2. If the InstallShield does not automatically run, you may start the installation by navigating to My Computer and double-clicking the icon for **TA100 PRO**.

3. The **TA100 Pro Setup** window will appear.
4. Click the **Next** button to advance to the next screen. The *License Agreement* screen will appear.

![Figure 3: TA100 Pro License Agreement](image)

5. Click **Yes** to accept the License Agreement. The *Choose Destination Location* screen will appear.

![Figure 4: Choose Destination Location](image)

6. TA100 Pro will be installed in the C:\TA100PRO directory by default. If you wish to install to a different directory, click the **Browse** and select the directory to which you wish to install. Click the **Next** button when you are ready to proceed. The *Setup Type* screen will appear.
7. Choose the type of installation you wish to perform.
   a) “Full” will install both the software and the database files on this computer. (Typical)
   b) “Workstation” will install just the software.

8. Click the **Next** button to continue with the installation. The **Select Program Folder** screen will appear.

9. The TA100 Pro folder will be created automatically. You may type a new folder name if you wish. Click **Next** to continue. The installation will begin.

10. When the installation is finished, the **InstallShield Wizard Complete** screen will appear. Click the **Finish** button to proceed.

11. If you selected “Full” in the Setup Type screen, the **Sentinel System Driver** installation will begin automatically. If you selected “Workstation,” the installation will end at this point.
12. The Sentinel System Driver—InstallShield Wizard will appear. The Sentinel System Driver is necessary for TA100 Pro to be able to access the database files.

13. Click the Next button to begin the Sentinel System Drive Installation. The Setup Type screen will appear.

14. Verify that Complete is selected and click Next to continue. The Ready to Install screen will appear.
15. Click **Install** to begin the installation.

16. When the installation is finished, the *InstallShield Wizard Complete* screen will appear. Click the **Finish** button to proceed.

17. This concludes the installation. The *Installation Complete* message will appear.
18. The FoxPro LIB—InstallShield Wizard will appear. The FoxPro LIB is for the TA100 Pro database files.

19. Click the Next button to begin the FoxPro LIB installation. The Ready to Install screen will appear.

20. When the installation is finished, the InstallShield Wizard Complete screen will appear. Click the Finish button to proceed.
21. Click OK. TA100 Pro will now appear in your Start Menu and on your desktop.

22. You must attach a hardware key to the computer’s parallel port prior to being able to start and operate TA100 Pro. See Hardware Keys.

Hardware Keys

When the installation is complete, a hardware key must be attached to the computer’s parallel port in order to start and operate the TA100 Pro software. There are three types of hardware keys - each designed for a specific purpose.

- Main System Key
- Polling Key
- Demo Key

Attach the hardware key to the computer’s parallel port. If you have a printer attached to the parallel port, place the hardware key between the computer’s parallel port and the printer cable as shown in Figure 17: Using a Hardware Key with a Printer Cable below.

![Figure 17: Using a Hardware Key with a Printer Cable](image)

When the system is first launched, TA100 Pro searches for and verifies the presence of a hardware key. If a key is not found, the system will not start.

Main System Key

The Main System Key is shipped with each new software package. One key per system is required. The Main System Key allows you to start and operate the software as well as poll your time clock(s). The Main System Key is identified by the code 4HJDAB-B on the outer shell.

Polling Key

The Polling Key allows TA100 Pro to communicate with time clocks from a workstation other than where the Main System Key resides. This key is identified by the code 4EQSGH-B on the outer shell.

On local or wide-area networks, a remote workstation can launch and operate the software as long as the Main System Key is detected somewhere on the network. However, the workstation cannot poll time clocks unless it has an Additional Polling Key attached.
**Demo Key**

The Demo Key is an accessory for resellers of TA100 Pro systems. This key is identified by the code **4EIWEH-B** on the outer shell.

The following restrictions are present when TA100 Pro detects the Demo Key:

- The TA100 Pro software is limited to five employees and two users.
- **NOT FOR RESALE** is displayed on all screens.
Chapter III  Getting Started

This section explains how to launch the TA100 Pro system, including logging on and off, using Help, using the keyboard instead of the mouse and customizing the TA100 Pro environment.

Starting TA100 Pro and Logging In

Note on User Accounts

When starting TA100 Pro, you will be prompted for a User ID and password. The User ID and password are used to determine who is able to login and what areas of the program are accessible. These "User Accounts" are defined in the Security Access portion of TA100 Pro, which will be covered later in this manual.

SYSOP

There is a built-in administrator account that grants full access to all parts of the application. The User ID for this account is SYSOP and the initial password is "password." (This password can and should be changed.) This account will be referred to as SYSOP throughout this manual.

The first time you login, you must use the SYSOP account, as no other accounts exist. You will also use this account to perform system maintenance, etc. The SYSOP account can perform all functions within TA100 Pro, including certain database management functions that no other account can access.

Launching and Logging In to TA100 Pro

The instructions in this section assume that you already know the User ID and password to be used. Check with your system administrator if you are unsure of which User ID to use.

1. Click the Start, Programs, TA100 Pro, TA100 Pro, or double-click the TA100 Pro Icon on the Desktop.

2. TA100 Pro will open and display the Login screen.

Figure 18: TA100 Pro Login Screen
3. Type your User ID in the **User ID** field, then press either **ENTER** or the **TAB** key to advance to the **Password** field.

4. Type your password in the **Password** field and press either **ENTER** or the **TAB** key to access TA100 Pro.

5. The **Main Window** will open.

### Exiting the System

You can use any of the following methods to close or exit out of TA100 Pro.

- Click **File, Exit** on the menu bar.
- Click the **Exit** button on the toolbar.
- Click the Windows Close button (the X at the far right of the menu bar).
- Press **ALT+ F4** on the keyboard.
Tips and Techniques

TA100 Pro is designed to be user-friendly, and as such there are common techniques to making working in TA100 Pro easier. Some of these tips are listed below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply</strong></td>
<td>You may click the <strong>Apply</strong> button in any screen to commit the changes you have made without exiting the current screen. This allows you to &quot;save as you go&quot; and is a good practice.</td>
</tr>
<tr>
<td><strong>Name vs. Number listing</strong></td>
<td>You will notice that most of the configuration dialog boxes provide a list of the existing items at the side of the screen. (For example, the <strong>Divisions</strong> dialog box gives you a list of Divisions.) These lists can be sorted according to <strong>Name</strong> or <strong>Number</strong>, depending upon your preference.</td>
</tr>
<tr>
<td><strong>Show Inactives</strong></td>
<td>Check this button to show inactive items in the list at the side of any dialog box.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>You may click the <strong>Print</strong> button in any dialog to print the report associated with the current screen. For example, clicking the <strong>Print</strong> button in the <strong>Configure Category</strong> dialog box prints the <strong>Category Listing</strong> report.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>You may click the <strong>Cancel</strong> button in any dialog box to close the screen without saving changes.</td>
</tr>
</tbody>
</table>

Using the Keyboard

TA100 Pro system is designed so you can perform all operations from your keyboard as well as with the mouse.

**Underlined Letters**

All menus, menu items, and buttons have an underlined letter, which allows keyboard access to that item.
• To access a menu, press the ALT key in conjunction with the letter that is underlined.
• To access an item on the menu, first open the menu and then press the letter that is underlined.
• To select a button, press the CTRL key in conjunction with the letter that is underlined

**Keyboard Usage Examples**

<table>
<thead>
<tr>
<th>To: Select an item from the Main Window.</th>
<th>Do This: Press ALT and the underlined letter. For example, press ALT+F to open the File menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a menu command.</td>
<td>Press the underlined letter only. This is true for submenus too. For example, type S to select Security.</td>
</tr>
<tr>
<td>Select a button.</td>
<td>Press CTRL plus the underlined letter. For example, press CTRL+E to choose the Edit button.</td>
</tr>
</tbody>
</table>

**Hot Keys**

Some menus, such as the Help menu, are accessible using Hot Keys. These keys or key combinations correspond to a menu item. Instead of typing the underlined letter in the command, you can simply press the Hot Key. For example, to view your system configuration, press F11. Also, all date fields have a calendar dropdown, to access right click on the date.

**Additional Keyboard Access**

Other keys and key combinations are available in the system. They are explained below

<table>
<thead>
<tr>
<th>To: Exit the current function or window without saving the data.</th>
<th>Press: ESC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Help topic associated with the current window.</td>
<td>F1</td>
</tr>
<tr>
<td>Display the Calculator.</td>
<td>F2</td>
</tr>
<tr>
<td>Display the Calendar/Diary.</td>
<td>F3</td>
</tr>
<tr>
<td>Display the Help &gt; About menu window.</td>
<td>F9</td>
</tr>
<tr>
<td>Display Conversion Table</td>
<td>F12</td>
</tr>
<tr>
<td>Activate the menu bar in the Main Window.</td>
<td>F10 or ALT</td>
</tr>
<tr>
<td>Exit the TA100 Pro system.</td>
<td>ALT+F4</td>
</tr>
<tr>
<td>Display Rounded Start and Stop times in the Online Timecard.</td>
<td>R</td>
</tr>
</tbody>
</table>
Help

TA100 Pro incorporates an Online Help system to answer questions about functions, procedures, and commands.

You can access context-sensitive Help from anywhere in the application by pressing the F1 function key. You will automatically be taken to the Help topic appropriate for the screen that you are in currently.

You may also access the Online Help feature through the Help menu, from which you can perform searches and browse the Help topics. There are three ways you can look for information: Browse the Contents, Search the Index, or do a text Find. There are three tabs across the top of the Help Topics window to access each of these methods.

Access the Online Help Window

1) Click the Help menu, Help. The Help Topics window will open.

![Figure 19: Help Topics](image)

Use Help Contents

6. In the Help Topics window, click the Contents tab.
7. Double-click the topic you wish to browse. This will expand the sub-topics below it.
8. If necessary, double-click the sub-topic you wish to browse.
9. When you find the article you are interested in, double-click it to open the article.

Use the Help Index

10. In the Help Topics window, click the Index tab.
11. Type in the topic you are looking for.
12. When you find the article you are interested in, double-click it to open the article.
Use Help Find

13. In the Help Topics window, click the Find tab.
14. Type in the topic you are looking for.
15. If necessary, select a word from the list of suggestions.
16. When you find the article you are interested in, double-click it to open the article.

Return to the Help Topics Window

After reading an article, you may return to the Help Topics window by clicking the Help Topics button on the toolbar.

Figure 20: Help Article

Print a Help Topic

You can print any help topic by clicking the Print button on the toolbar.

Figure 21: Help Article

1. Click the Print button on the TA100 Pro Help toolbar. The Print window will open.
2. Select the printer to which you wish to print and click the Print button. The topic will print.

Configuring the System Environment

Environmental settings control various display and functional characteristics of your system. The default settings can be modified. Bell, Background and Large Toolbar are available environment options. A check mark (✓) in front of the option means that the option is activated.

Figure 23: Environment Menu

Play Bell Tones

You can customize TA100 Pro to play a tone at the end of a field when entering data.

1. Click the File menu, Environment, Bell. This will cause a bell tone to play whenever you come to the end of a field when entering data.

   NOTE: To remove follow Step 1.

Change Screen Background

You can customize the TA100 Pro background to display a graphic of your choice. The graphic must be in bitmap (.bmp) format.
1. Click the **File** menu, **Environment**, **Background**. The *Select Background* window will open.

![Select Background](image)

**Figure 24: Select Background**

2. Choose the graphics file you wish to use for your background.
   - Click the directory or file to select it.
   - Click the [...] icon to go to a previous directory.

3. Click **OK** to accept the selected file.

4. Your graphic will appear on the background of TA100 Pro.

**NOTE:** To reset the background settings to the defaults:

   - Click the **File** menu, **Environment**, **Background**. The *Select Background* window will open.
   - Click the **Defaults** button.

**Large Button Toolbar**

You can customize the main toolbar to display large buttons that are easier to see.

1. Click the **File** menu, **Environment**, **Large Button Toolbar**. The buttons on the toolbar will enlarge.

**NOTE:** Once *Large Button Toolbar* has been activated, the menu item will change to *Small Button Toolbar* so that you can revert to the original toolbar easily.
Chapter IV  Configuration

This section explains how to configure and customize TA100 Pro for your company's requirements. To make this chapter easier to follow, the topics in this section are arranged in the sequence that Time America recommends completing them. This also happens to be the order in which they appear on the Configure menu in the TA100 Pro Main Window. This order is:

- Main Company
- Divisions (optional)
- Categories
- Policies
- Shifts
- Holidays
- Groups (optional)
- Department
- Job
- Security
- Bell Schedules
- Benefit Accruals
Main Company

The Main Company window is where you identify your company, define the overall configuration of the system, and specify the payroll service to which time and attendance data will be exported.

1. Click the **System Setup** menu, **Company, Main Company**. The **Main Company** window will open and the **General** tab will be selected by default.

   ![Figure 25: Main Company: General tab](image)

2. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter your company's name. This field is required and can contain up to 30 characters.</td>
</tr>
</tbody>
</table>
| **Address** | Enter the first line of your company's primary address. This field can accept up to 30 characters.  
**NOTE**: Divisions can be used to allow for additional branch addresses. |
| **Address** | Enter the second line of your company's primary address (such as suite number.) This field can accept up to 30 characters and may be left blank. |
| **City**    | Enter your company's primary address City. This field can accept up to 30 characters. |
| **State**   | Enter the two-character code for your company's State. TA100 Pro automatically capitalizes your entry. |
| **Zip**     | Enter your company's zip code. You may enter the 5 or 9 digit zip code. |
| **Phone Number** | Enter your company's primary phone number. |
| **Fax Number** | Enter your company's primary fax number. |
3. When all settings are complete, click the Configure tab. The Configure screen will appear.

![Configure Main Company](image)

**Figure 26: Main Company: Configure tab**

4. Fill in the settings as appropriate

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Daylight savings</strong></td>
<td>Check this box if your company is in a state that observes daylight savings time. Typically you will check this box.</td>
</tr>
</tbody>
</table>
| **Divisions** | Check this box to enable the Divisions feature. A Division is a "subset" of the main company, such as a branch, different location, or subsidiary company.  

**TIP:** Companies who submit multiple company codes to their payroll service may want to use Divisions. |
| **Department** | Check this box to enable the Departments feature. Departments reflect the business units within your company and are the top level of Job Costing.  

**NOTE:** You will have the opportunity to customize this nomenclature in the next screen. |
| **Job** | Check this box to enable the Job level. Jobs are the second level of Job Costing.  

**NOTE:** You will have the opportunity to customize this nomenclature in the next screen. |
<p>| <strong>Lunches</strong> | Check this box to enable this option if your employees will punch for lunch or lunch will be deducted automatically. |
| <strong>Breaks</strong> | Check this box to enable this option if your employees will punch for break or break will be deducted automatically. |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use level wage before default assignment wage</td>
<td>&quot;Level Wage&quot; refers to the hourly rate associated with a department, job, step, operation or task. The &quot;default assignment wage&quot; refers to the wage associated with an individual employee. Check this box if you wish the Level Wage for the department an employee works in to take precedence over the Default Assignment Wage when calculating an employee's earnings.</td>
<td></td>
</tr>
<tr>
<td>Paid lunches and breaks do not accrue toward overtime</td>
<td>Check this box if paid lunches and breaks are not considered in calculating hours for overtime.</td>
<td></td>
</tr>
<tr>
<td>Use SMTP for email</td>
<td>This option allows you to define the e-mail configuration per user in security.</td>
<td></td>
</tr>
<tr>
<td>Tip reporting</td>
<td>Check this box to enable tip reporting.</td>
<td></td>
</tr>
<tr>
<td>Wages</td>
<td>Check this box to enable the wages features throughout TA100 Pro. This makes it possible to enter wage information in the Employee Maintenance screen.</td>
<td></td>
</tr>
<tr>
<td>Overtime Level 2</td>
<td>Up to three levels of overtime may be defined in TA100 Pro. One overtime level (OT1) is always available. To use a second overtime level (OT2), click the Overtime Level 2 check box.</td>
<td></td>
</tr>
<tr>
<td>Overtime Level 3</td>
<td>To use a third overtime level (OT3) in the system, click the Overtime Level 3 check box. This level is not available unless Overtime Level 2 is selected.</td>
<td></td>
</tr>
<tr>
<td>Use Swipe and Go</td>
<td>Check this option to allow employees to swipe the clock without punching any keys. The system then determines whether the individual punch was an In, Out, Out for Lunch, In from Lunch, etc., based on the employee's last punch and the employee's schedule.</td>
<td></td>
</tr>
<tr>
<td>Use (am-pm) Format</td>
<td>Check this option to have reports and the online timecard use an AM/PM format instead of 24-hour format (military time.)</td>
<td></td>
</tr>
<tr>
<td>Do not use Floater for shift selection</td>
<td>Check this option to suppress all floaters from each shift group.</td>
<td></td>
</tr>
<tr>
<td>Editable Pay Periods, plus days</td>
<td>This option controls the number of pay periods and days in which it is possible to edit transactions in the TA100 Pro system. For instance, Figure 26 specifies that two pay periods of transactions can be modified.</td>
<td></td>
</tr>
</tbody>
</table>
Setting Definition

Auto logout-minutes This option will define the number of minutes a user can be idle in TA100 Pro before it automatically logs them out.

Auto logout-time This option will define a specific time all users will automatically be logged out of TA100 Pro.

Currency Name Enter the type of currency TA100 Pro should use. The default is "Dollars."

Date Format Select the manner in which dates should be displayed. The options are American (MM/DD/YYYY) and European (DD/MM/YYYY).

Date Delimiter Enter the character with which to delimit dates. The default is a slash (/).

5. When all settings are complete, click the Defaults tab to select it. The Defaults screen will appear.

6. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Enter the term you would like to use to refer to employees. (i.e., Employees, Associates, Members, etc.) The default is &quot;Employees.&quot;</td>
</tr>
<tr>
<td>Length</td>
<td>Enter the maximum number of digits for the Employee ID.</td>
</tr>
<tr>
<td>Type</td>
<td>Choose the data type for the Employee ID. The options are Numeric and Alphanumeric.</td>
</tr>
</tbody>
</table>
**Department**
Enter the term you would like to use to refer to the business units within your organization. (i.e., Departments, Business Unit, Cost Center, etc.) The default is "Department."

**Length**
Enter the maximum number of digits for the Department ID.

**Type**
Choose the data type for the Department ID. The options are Numeric and Alphanumeric.

**Job**
Enter the term you would like to use to refer to the second level of job costing in your organization. (i.e., Job, Project, Client, etc.) The default is "Job."

**Length**
Enter the maximum number of digits for the Job ID.

**Type**
Choose the data type for the Job ID. The options are Numeric and Alphanumeric.

**User Defined Fields**
TA100 Pro allows you to define up to six user-defined fields. Enter the names of the fields you would like to define (if any). If you do not need any custom fields, you may leave these blank. The default values are License, Spouse, and License 2, but you may modify or delete these as desired.

**Badges Length**
Enter the number of characters (from 2 to 10) that will be read from the employee badge. For example, if the badge number is 10 characters long but you want to read only the last five characters, enter a 5 in this field. The number of digits here must match the actual number of digits on the physical badges given to employees, and must also match the settings programmed into the badge reader clocks.

**Maximum**
Type the maximum number of characters (from 2 to 64) on an employee’s badge. Any badge longer than this number will be rejected by the time clock.

**Type**
Choose the data type for the Badge number. The options are Numeric and Alphanumeric. Most – though not all – badges will be Numeric.
**Automatic Badge Assignment**

TA100 Pro can assign badge numbers automatically when adding a new employee. You can manually change automatic assignments later if necessary.

Choose *No Automatic Assignment* to bypass the automatic assignment and be allowed to enter the badge number manually.

Choose *Next Numeric Available* to have TA100 Pro assign the next sequential available badge number.

Choose *Same as Employee Number* to have TA100 Pro assign a badge number that is identical to the employee's ID number.

7. When all settings are complete, click the *Exports* tab to select it. The *Exports* screen will appear.

8. Select the payroll provider to which you wish to export data. You may be prompted for additional information specific to the payroll application selected. For example, when ADP is selected, you are asked for the *Company Code* of your main company. Click *Display only this export* to have this payroll company listed as the only export available via reports.

   **NOTE:** If the payroll provider you will be using does not appear in the list, simply choose either “Generic Numeric” or “Generic Alpha” depending on the Pay Code type your provider requires (contact your payroll provider to obtain this information.)

9. When all settings are complete, click *OK* to save the changes and exit the *Main Company* configuration dialog box.
Divisions

Divisions are subsets of the main company. For example, a division can be a remote office or separate business unit. Divisions are not required and will only be available if the Divisions option is selected in Main Company Configure screen.

Configure Divisions

From the divisions dialog box, you may add, edit and delete Divisions.

1. Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will open.

![Figure 29: Divisions](image)

2. The Divisions window includes the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Number  | This is a required field. Enter a 4-digit number to identify the division.  
NOTE: Do not use 0000 since this number is assigned to the main company and cannot be used for divisions. |
| Name    | This is a required field. Type the division name (up to 30 characters) as you want it to appear in the system and on reports. |
| Active  | Click the Active check box to indicate that the division is currently in use. Uncheck this box if the division is not being used at this time. |
| Address | Enter the first line address of the division. Up to 30 characters may be entered in each line. |
| Address | Enter the second line address of the division (if applicable). Up to 30 characters may be entered in each line. |
| City    | Type the name of the city (up to 30 characters) for the division. |
State
Type the two-character state abbreviation.

Zip
Enter the five or nine-digit postal zip code of the division.

Phone Number
Enter the telephone number for this division.

Fax Number
Enter the fax number for this division.

Additional Information
You may be prompted for additional information based upon the payroll application selected in the Export screen of the Main Company configuration. For example, if ADP is selected in the Export screen, you will be prompted for the company number of this division.

Add a Division
1. Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will open.
2. Click the Add button. The General screen will become available for you to add the new Division.
3. Fill in the settings as described in the Configure Divisions section.
4. Click OK to commit the changes and return to the Configure Divisions screen.
5. Click Close to exit the Configure Divisions window.

Edit a Division
1. Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will open.
2. Highlight the Division you wish to edit from the list at the side of the screen.
3. Click the Edit button. The General screen will become available for you to edit the selected division.
4. Edit the settings as described in the Configure Divisions section.
   NOTE: The Division number cannot be changed.
5. Click OK to commit the changes and return to the Configure Divisions screen.
6. Click Close to exit the Configure Divisions window.

Delete a Division
Divisions that are in use cannot be deleted.
1. Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will open.
2. Highlight the division you wish to delete from the list at the side of the screen.
3. Click the **Delete** button.

   ![Confirmation Window]

   *Figure 30: Deletion Confirmation*

4. Click **OK** to confirm the deletion.

5. Click **Close** to exit the *Configure Divisions* window.
Categories

Categories are used to track and report types of time or money. The built-in categories are:

- Absent
- Adjustment
- Break
- Bereavement
- Holiday
- Jury Duty
- Lunch
- Military Leave
- Sick – NonPaid
- Other Paid Time
- Personal Day
- Per Diem #1
- Per Diem #2
- Sick – Paid
- Cash Tips
- Charge Tips
- Vacation
- Worked Time

You may edit and delete built-in categories (other than Work), as well as add custom categories specific to your organization, such as Floating Holidays, Family Leave, etc. Categories are used in entering time and monetary adjustments for employees.
Configure Categories

1. Click the System Setup menu, Categories. The Configure Categories dialog box will open.

2. The Configure Categories screen displays the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter a code (up to 4 alphanumeric characters) to identify the category. Once saved, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Equals category number from hand reader.</strong></td>
<td>When entering a Category into a Hand Reader, only a numerical value can be entered. Use this field to assign a number representing the Category Code.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This is a required field. Enter the category name, as it will appear in the system and on reports. The category name can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the category is currently in use. Clear this check box if the category is not being used at this time.</td>
</tr>
<tr>
<td><strong>Do you wish to export this category?</strong></td>
<td>This indicates whether this category will be included in the export information created for your payroll service. If this option is selected, the Export tab will become available. You must configure the Export tab settings to specify field mappings for your payroll export. (See Step 3.)</td>
</tr>
</tbody>
</table>
### Hours/Dollars

This is a required field. Select either **Hours** or **Dollars** to indicate the category type. For example, the category VACATION collects hour amounts, while the categories TIP1 and TIP2 collect dollar amounts.

*If Hours* is selected, complete the remaining fields that apply. *If Dollars* is selected, the remaining fields in this dialog box are unavailable.

### Miscellaneous entry overrides absence?

Select this option to allow a Miscellaneous entry of this category to override an absence. (Miscellaneous refers to an entry other than Work.)

### Miscellaneous entry overrides holiday minimum hours?

Allows time in this category to count toward the minimum hours worked requirement for allocating paid holiday time. (Miscellaneous refers to an entry other than Work.)

### Are miscellaneous entries paid?

Allows time in this category to be treated as "paid time." Select this option if employees will be paid when receiving a miscellaneous entry using this category. (Miscellaneous refers to an entry other than Work.)

### Can this category be overtime?

This option will only be available if miscellaneous entries are paid. Select this option to accrue time in this category towards overtime. Clearing this option causes the system to prohibit overtime calculation on this category. If the category can be overtime, it is also possible to default to a specific level as well as enable it to accumulate towards overtime.

### Post to benefit entitlement?

Select this option to post accrued time in this category to company benefits. Checking this option makes it possible to configure benefit entitlement and/or rules for this pay type. Also, any time posted to this category will be deducted from the available entitlement for this category.

3. The **Export Codes** tab will be available only if the **Do you wish you to export this category** option is checked.

**NOTE:** These settings will be used to map data collected by TA100 Pro to the appropriate fields in your payroll application, and it is critical that they be configured fully and accurately. The information in these fields must be obtained from the payroll service specified in **Company Setup.** Contact your payroll service representative or software manual for the information requested, if necessary.
4. The **Export Codes** tab includes the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Differential: None</strong></td>
<td>This line of information will specify the codes for hours that do not have differential adjustments.</td>
</tr>
<tr>
<td><strong>Differential: D1-D3</strong></td>
<td>These lines of information will specify the codes used by hours allocated to each Shift Differential.</td>
</tr>
<tr>
<td><strong>REG</strong></td>
<td>Regular Hours are hours paid at &quot;straight time.&quot; Enter the code your payroll application uses to refer to Regular hours.</td>
</tr>
<tr>
<td><strong>OT1</strong></td>
<td>OT1 hours are hours paid at the factor defined for OT1 in the Payroll Policy. Enter the code your payroll application uses to refer to hours paid at the OT1 factor.</td>
</tr>
<tr>
<td><strong>OT2</strong></td>
<td>OT2 hours are hours paid at the factor defined for OT2 in the Payroll Policy. Enter the code your payroll application uses to refer to hours paid at the OT2 factor.</td>
</tr>
<tr>
<td><strong>OTE</strong></td>
<td>OT3 hours are hours paid at the factor defined for OT3 in the Payroll Policy. Enter the code your payroll application uses to refer to hours paid at the OT3 factor.</td>
</tr>
</tbody>
</table>

**NOTE**: This option will only appear if OT2 has been selected on the **Configure** tab of the **Main Company** configuration dialog box.

**NOTE**: This option will only appear if OT3 has been selected on the **Configure** tab of the **Main Company** configuration dialog box.
**Field Code**

Enter the code that indicates which field of your payroll software this category will be mapped to.

This code differentiates between categories of time that use the same field number. For example, regular (REG) hours for VACATION and HOLIDAY may both use field number 16. By assigning a field code V to the VACATION category and H to the HOLIDAY category, vacation hours are reported in field 16V, while holiday hours are reported in 16H. If no field code was assigned, you could not differentiate between vacation and holiday hours.

**Add a Category**

1. Click the **System Setup** menu, **Categories**. The *Configure Categories* dialog box will open.

2. Click the **Add** button to add a new Category. The **General** tab will become available.

3. Fill in the settings as described in the *Configure Categories* section.

4. Click **OK** to commit the changes and close the **Categories** dialog box.

5. Click **Close** to exit the **Configure Categories** window.

**Edit a Category**

1. Click the **System Setup** menu, **Categories**. The *Configure Categories* dialog box will open.

2. Highlight the Category you wish to edit from the list at the side of the screen.

3. Click the **Edit** button. The **General** screen will become available for you to edit the selected category.

4. Edit the settings as described in the *Configure Categories* section.
5. Click OK to commit the changes and return to the Configure Categories screen.

6. Click Close to exit the Configure Categories window.

Delete a Category

*Categories that are in use cannot be deleted.*

1. Click the System Setup menu, Categories. The Configure Categories dialog box will open.

2. Highlight the category you wish to delete from the list at the side of the screen.

3. Click the Delete button. You will be prompted:

   ![Deletion Confirmation](image)

   *Figure 34: Deletion Confirmation*

4. Click OK to confirm the deletion.

5. Click Close to exit the Configure Categories window.
Policies

Policies are used to store and apply the business or payroll rules governing overtime, holidays, etc. It is possible to have more than one set of rules within an organization, so TA100 Pro makes it possible to create many Policies. Each employee is assigned to the Policy that applies for him or her.

Configure Policies

1. Click the **System Setup** menu, **Policies**. The **Configure Policies** dialog box will open.

![Figure 35: Configure Policies](image1)

2. There are several tabs in the **Configure Policies** dialog box, each with its own settings. The first tab, **General** tab defines general payroll policy parameters and contains the following information:

![Figure 36: Policies: General tab](image2)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This field is required. Enter a code (up to 3 alphanumeric characters) to identify the policy. Once saved, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This field is required. Type the company policy name, as it will appear in the system and on reports. The policy name can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the policy is currently in use. Clear this check box if the policy is not being used at this time.</td>
</tr>
<tr>
<td><strong>Pay Period</strong></td>
<td>Select the appropriate pay period information for your company.</td>
</tr>
<tr>
<td><strong>Weekly</strong></td>
<td>Check this option if wages are paid weekly.</td>
</tr>
<tr>
<td><strong>Bi-weekly</strong></td>
<td>Check this option if wages are paid every other week.</td>
</tr>
<tr>
<td><strong>Semimonthly</strong></td>
<td>Check this option if wages are paid twice a month.</td>
</tr>
<tr>
<td><strong>Monthly</strong></td>
<td>Check this option if wages are paid once a month.</td>
</tr>
<tr>
<td><strong>Start Date</strong></td>
<td>Enter the starting date of the pay period (using MM/DD/YYYY format). This is used for calculations and represents the starting date of an entire payroll period. The day of the week (Sunday, Monday, etc.) that corresponds to the starting date is used to determine when the cycle begins.</td>
</tr>
<tr>
<td><strong>Number of Days in semimonthly period</strong></td>
<td>If the pay period is semimonthly, specify the number of days in the first half of the policy’s semi-monthly period. Click the down arrow next to the entry field to select a number from 1 to 28.</td>
</tr>
<tr>
<td><strong>Punch Defaults</strong></td>
<td>The settings in this section define how punches are processed.</td>
</tr>
<tr>
<td><strong>Ignore use of duplicate function key punches within</strong></td>
<td>Enter the number of minutes (up to 59) during which duplicate punches on the time clock are ignored. When duplicate punches are made within this time frame, only the last punch is used for calculations.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ignore use of opposing function key punches within</td>
<td>Enter the number of minutes (up to 59) in which opposing (i.e. sequential In/Out) punches on the time clock are ignored. For example, if 3 minutes is entered here and an employee accidentally punches Out instead of In, the employee can enter the In punch within 3 minutes to correct the error and TA100 Pro will ignore the Out punch entirely.</td>
</tr>
<tr>
<td>Missing Out punch limit</td>
<td>Enter the number of hours (in HH.MM format) that can pass after the In punch before the system assumes the employee has forgotten to punch out and flags the time and attendance reports. For example, if 10.00 is entered in this field, the system expects an Out punch to be recorded no later than 10 hours after the shift’s In punch. The default for this field is 18.00 or 18 hours.</td>
</tr>
<tr>
<td>Will default the Work total to</td>
<td>Enter the time (in HH.MM format) to be recorded when the employee is flagged with a Missing Out Punch.</td>
</tr>
<tr>
<td></td>
<td>For example, assume an employee is scheduled to work 8 hours and forgets to punch Out. If 8.00 is entered in this field, the system recognizes the missing Out punch yet totals 8 hours for the employee. The default for this field is 00.00 (indicating that no time will be totaled for a Missing Out Punch).</td>
</tr>
<tr>
<td>Maximum Out punch link back to In punch</td>
<td>Enter the maximum time an employee who has punched Out can punch back In and still have the new time included in the previous total when calculating daily overtime.</td>
</tr>
<tr>
<td></td>
<td>For example, assume that the Maximum Out Punch Link-Back is defined as 2.00 and overtime is paid after working 8 hours in a single day. If an employee punches In at 8:00 A.M. and Out at 5:00 P.M. (with a one hour unpaid lunch) then punches back In at 6:30 P.M. (within the 2-hour link-back) and Out again at 9:30 P.M., the daily total shows 8 hours of regular time and 3 hours of overtime.</td>
</tr>
<tr>
<td>First Change Punch accrues to In punch</td>
<td>Check this option if the first department and/or job transfer after the In punch should be retroactive to the In punch.</td>
</tr>
</tbody>
</table>

3. The Holidays tab defines the rules for paying Holidays and contains the following information:
Figure 37: Policies: Holidays tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pay Holidays</strong></td>
<td>Check this option if you wish the program to pay holidays. You will specify the dates of the holidays in a separate dialog box. (See Holidays, page 66.)</td>
</tr>
<tr>
<td><strong>Holiday Eligibility</strong></td>
<td>These settings define the prerequisites for being paid for the holiday.</td>
</tr>
<tr>
<td>Minimum days of employment to qualify</td>
<td>Enter the minimum number of days (up to 3 digits) from the hire date for an employee to qualify for non-worked holiday pay. The default is 90 meaning 90 qualifying days are required.</td>
</tr>
<tr>
<td><strong>Required to work the scheduled day</strong></td>
<td>Select an option to indicate which days the employee must work to qualify for holiday pay.</td>
</tr>
<tr>
<td>Before and After.</td>
<td>Employee must work the scheduled day before and after the holiday to receive holiday pay.</td>
</tr>
<tr>
<td>Before or After.</td>
<td>Employee must work the scheduled day before or after the holiday to receive holiday pay.</td>
</tr>
<tr>
<td>None.</td>
<td>There are no requirements for the employee to qualify for holiday pay.</td>
</tr>
<tr>
<td><strong>Minimum before</strong></td>
<td>Enter the number of hours that must be worked on the day prior to the holiday in order for that day to qualify as having been worked.</td>
</tr>
<tr>
<td><strong>Minimum after</strong></td>
<td>Enter the number of hours that must be worked on the day after the holiday in order for that day to qualify as having been worked.</td>
</tr>
<tr>
<td><strong>Holiday Parameters</strong></td>
<td>These settings define how the Holiday pay will be allocated.</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Apply Holiday when not</strong></td>
<td>Check this option if the holiday hours can be given to an employee who is not scheduled to work on the holiday.</td>
</tr>
<tr>
<td><strong>scheduled to work</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Holiday hours can accrue</strong></td>
<td>Check this option if holiday hours and added holiday time count toward overtime. For example, assume an employee works 44 hours during a week and one 8-hour holiday occurs. If this option is checked, and overtime is paid after 40 hours, the employee receives 40 hours regular pay and 12 hours overtime. If this option is not checked, the employee receives 48 hours regular pay and 4 hours overtime.</td>
</tr>
<tr>
<td><strong>toward overtime</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Hours to add for each worked</strong></td>
<td>Enter the number of hours (in HH.MM format) to be added to the employee’s time for each <em>worked</em> holiday. These hours are in addition to actual time worked. For example, if 8.00 hours are entered in this field, and an employee works 8 holiday hours, 8 more hours are added to the employee’s time. The default is 8.00.</td>
</tr>
<tr>
<td><strong>holiday</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Multiply worked</strong></td>
<td>Click this check box to multiply any worked holiday hours by a specified rate.</td>
</tr>
<tr>
<td><strong>holiday hours to apply to HOL</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Hours to add for each unworked</strong></td>
<td>Enter the number of hours (in HH.MM format) added to the employee’s time for each <em>non-worked</em> holiday. This entry is usually equal to the number of regular hours worked. The default is 8.00.</td>
</tr>
<tr>
<td><strong>holiday</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Given Minimum</strong></td>
<td>Enter the minimum number of hours that an employee is guaranteed to receive for Holiday pay regardless of the number of hours worked.</td>
</tr>
<tr>
<td><strong>Given Maximum</strong></td>
<td>Enter the maximum number of hours that an employee is guaranteed to receive for Holiday pay regardless of the number of hours worked.</td>
</tr>
</tbody>
</table>
beginning pay rate if holiday is worked

Select a level to indicate the employee’s wage multiplier for a worked holiday.

**Reg.** Regular wages are paid for a worked holiday.

**OT1.** The overtime rate specified in OT1 on the Overtime dialog box is paid for a worked holiday.

**OT2.** The overtime rate specified in OT2 on the Overtime dialog box is paid for a worked holiday.

**OT3.** The overtime rate specified in OT3 on the Overtime dialog box is paid for a worked holiday.

reset at end of day

Check this option to disable the holiday pay rate at midnight. Clear this check box to continue using the holiday pay rate specified until the employee punches Out.

4. The Overtime tab defines the rules for calculating overtime and contains the following information:

![Figure 38: Policies: Overtime tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pay OT</strong></td>
<td>Check this option to pay overtime to employees using this Policy.</td>
</tr>
</tbody>
</table>
**Overtime Cycle**

This field is required. Enter the pay period that you use to calculate overtime. For example, if overtime is paid after 40 hours of work per week, select the Weekly option.

This Overtime Cycle is independent of the Pay Period specified in Policy Maintenance but must not be greater than the policy pay period. For example, if the policy Pay Period is Biweekly, you may select an Overtime Cycle of Weekly or Biweekly, but not Semimonthly or Monthly since these cycles are longer than the policy pay period.

- **Weekly**. Overtime is calculated weekly.
- **Biweekly**. Overtime is calculated every two weeks.
- **Semimonthly**. Overtime is calculated twice a month.
- **Monthly**. Overtime is calculated once a month.

**Overtime Definition**

These settings define when and how overtime is calculated.

**TIP:** Begin by entering your first level of overtime in OT1. If after 40 hours of work per week, you pay time-and-a-half, enter 40.00 in the Period Limit field and 1.5000 in the Multiplier field.

If double-time is paid after 60 hours, enter 60.00 in the Period Limit field and 2.0000 in the Multiplier field for OT2.

On Sundays and holidays, you may want to pay double-time and one-half regardless of hours worked. In this case, enter 99.99 in the Period Limit field and 2.5000 in the Multiplier field for OT3.

**OT Level**

Up to three levels of overtime (OT1, OT2 and OT3) may be defined per policy.

**Period Limit**

Enter the number of hours (in HH.MM format) that an employee must work to be eligible for overtime. For example, in a weekly pay period, the Period Limit is typically defined as 40.00; in a biweekly period, it is normally defined as 80.00.

**Multiplier**

Enter the multiplication factor used to compute overtime pay. The normal pay rate is multiplied by this number. For example, to pay time-and-a-half, enter 1.50; to pay double-time, enter 2.00.
**Daily Overtime**  These settings allow paying daily overtime. For example, many companies pay daily overtime over eight hours per day. Another example is paying double overtime on Sundays, regardless of how many hours are worked in the overtime cycle.

**Day of the Week**  Select the day(s) of the week that are paid daily overtime by checking the appropriate checkbox.

**Start at OT Level**  Select the applicable overtime level to be paid (if any) at the start of the day. Choose *Regular* if no overtime is paid (regular wages), or *OT1*, *OT2* or *OT3* to pay the overtime wages defined above.

**Daily Qualifier**  Under *OT1*, *OT2* and *OT3*, enter the number of daily hours (in HH.MM format) that must be worked before that overtime level will be acknowledged by the system. For example, if Sunday hours start at OT1, and OT2 begins after 8 hours, enter 8.00 in Sunday’s OT2 Daily Qualifier. Only overtime levels above the entry in *Start at OT Level* are available.

**Reset at Day End**  Check this box to force any overtime hours that roll into the next day (after midnight) to be processed using the next day’s rules. Clear the check box to process hours accumulated past midnight using the OT rate from the previous day.

**Consecutive Days**  Check this box if overtime is paid automatically after working a certain number of consecutive days.

*NOTE:* Additional options appear when this box is checked.

**Num of Days**  Enter the number of consecutive days that must be worked before overtime starts.

**Minimum Daily**  Enter the minimum number of daily hours that must be worked on each consecutive day to qualify for overtime.

**Hours Total**  Enter the minimum number of total hours that must be worked for all of the consecutive days to qualify for overtime.

**OT Level**  Select the overtime level that applies when the consecutive days criteria is met.

**On Days that Qualify**  Check this box to pay a second Overtime Level if an employee works more than the specified amount in the *After* field. TA100 Pro will apply the settings in the *After* and *Overtime Level* fields once the employee qualifies for consecutive day overtime.
After (hrs) Enter the number of hours after which the second OT level will apply on days qualifying for consecutive day overtime.

For example, if the employee gets OT1 for the first eight hours, and OT2 after eight hours worked on the seventh consecutive day, you would enter 8 in this field, and OT2 in the next field.

OT Level Select the second OT level TA100 Pro will pay when an employee meets the qualification for the After field under "On days that qualify". This setting works in conjunction with the After column and indicates what overtime level will be paid when the number of hours in the After field has been met.

Reset Overtime at Cycle End If checked, this option tells TA100 Pro to reset the Consecutive Days count after the Overtime Cycle ends. This is used for Pay Periods with more days than the Overtime Cycle.

5. The Differential tab defines the codes and rates for up to three levels of Shift Differentials. A Shift Differential is a premium amount or factor paid in addition to the employee's regular wage for certain hours worked during the day. Shift Differentials work in conjunction with Shifts. The Differential tab contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Differential</td>
<td>Check this option to enable the shift differentials.</td>
</tr>
<tr>
<td>Differential</td>
<td>There are nine differential codes available.</td>
</tr>
</tbody>
</table>
Type

Select the type of differential.

Addition. Select this option to add a specific dollar amount to the employee’s regular wage.

Multiplier. Select this option to multiply the employee’s regular wage by a multiplication factor.

Amount

Enter the amount of the differential. If the type is Addition, enter the amount in dollars and cents that should be paid above the employee’s regular wage for differential hours (i.e. .30 for 30 cents per hour). If the type is Multiplier, enter the percentage or factor to multiply the employee’s regular wage for differential hours (i.e. 1.5 for time and a half).

Differential fixed to In

Check this option to pay an employee a differential premium only when he/she punches In within the time frame(s) specified in Shift Maintenance. Clear this check box to pay an employee a differential premium if any part of the hours falls within the time frame(s) in Shift Maintenance.

6. The Exceptions tab defines rules for flagging hours worked exceptions and contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Exceptions</td>
<td>Check this box for TA100 Pro to report employees that work above or below the specified parameters.</td>
</tr>
</tbody>
</table>
Consecutive hours worked

Enter the number of consecutive hours worked (HH.MM) that, if exceeded by an employee, will be reported on the Consecutive Hours Exception report. For example, if 14.00 is entered, employees working over 14 consecutive hours are flagged for the report.

Overtime hours worked

Enter the number of overtime hours (HH.MM) that, if exceeded by an employee, will be reported on the Overtime Hours Exception report. For example, if 20.00 is entered, any employees working over 20 hours of overtime are flagged for the report.

Daily hours worked

An employee who works under or over this number of hours (HH.MM) per day is reported on the Daily Hours Exception report. For example, if 6.00 is entered in the Under or Over fields, an employee working under or over 12 hours a day is flagged for the report.

Period hours worked

An employee who works under or over this number of hours (HH.MM) per day is reported on the Period Hours Exception report. For example, if 30.00 is entered in the Under or Over fields, an employee working under or over 60.00 hours in a pay period is flagged for the report.

Add a Policy

1. Click the System Setup menu, Policies. The Configure Policies dialog box will open.

2. Click the Add button to add a new Policy. The Default Policy Add dialog box will become available.

3. Enter a unique code for this policy.
4. Enter a unique name for this policy.
5. Click Yes to copy the existing policy, or click No to start from scratch.
6. Fill in the settings as described in the Configure Policies section.
7. Click OK to commit the changes and close the General dialog box.
8. Click Close to exit the Configure Policies dialog box.

Edit a Policy
1. Click the System Setup menu, Policies. The Configure Policies dialog box will open.
2. Highlight the Policy you wish to edit from the list at the side of the screen.
3. Click the Edit button. The General screen will become available for you to edit the selected Policy.
4. Edit the settings as described in the Configure Policies section.
5. Click OK to commit the changes and return to the Configure Policies screen.
6. Click Close to exit the Configure Policies dialog box.

Delete a Policy
1. Click the System Setup menu, Policy. The Configure Policies dialog box will open.
2. Highlight the Policy you wish to delete from the list at the side of the screen.
3. Click the Delete button. You will be prompted:
   
   ![Figure 42: Deletion Confirmation](image)
   
   4. Click OK to confirm the deletion.
5. Click Close to exit the Configure Policies dialog box.
Shifts

Shifts define the work schedule for your employees. Shifts are created in Shift Groups, which can include multiple Shifts. For example, you may have a Shift Group for the Day-Shift workers, in which unique Shifts may start at 7am, 8am, and 9am. Rounding rules are applied to the Shift Group to determine employee tardiness and rounding.

An employee assigned to a Shift Group can be assigned to any of the individual shifts within it. The employee may also "float" between Shifts, which causes TA100 Pro to determine tardiness and rounding according to the Shift the employee punched in closest to. For example, an employee that clocks in at 7:45am would be considered to be on the 8am Shift that day, simply because he/she clocked in closer to 8am than to 7am. The parameters for this "cut off" are defined as part of the Shift.

You will first create the Shift Group (Days, Swing, Graveyard, etc.) and then will create the unique Shifts within it.

Configure a Shift Group

A Shift Group is made up of individual Shifts that are unique but are related in some way. For example, the Day Shift Group has Shifts that all take place during daylight hours, but has unique starting & stopping times (7am-4pm, 8am-5pm, 9am-6pm, etc.)

1. Click the System Setup menu, Shifts. The Configure Shifts dialog box will open. The Configure Shifts dialog box contains three tabs, which are described below.

![Figure 43: Shifts](image)

2. The Shift Groups tab defines the settings that apply to the Shift Group as a whole and contains the following information:
### Setting Definition

**Code**
This field is required. Enter a unique shift code up to 3 characters in length. Once saved, this code cannot be changed.

**Name**
This field is required. Type the shift group name, as you want it to appear in the system and on reports. The shift group name can be up to 30 characters long.

**Active**
Click the Active check box to indicate an active shift group. Clear this check box if the group is inactive. Rather than deleting a shift group from the system, simply mark it inactive in the event you wish to use it again at a later date.

**Flex/Open**
Click the Flex/Open check box if the shift group consists of flexible shifts. A flexible shift does not have a designated start and stop time. It only specifies the number of hours that an employee must work to complete the shift.

When **Flex/Open** is selected, you cannot set the start and stop times for any individual shift created in this group. You can only specify the total duration of the shift. Also, the **Forecasted hours for floaters** is unavailable.

**Forecasted hours for floaters**
Enter the number of hours that a floating employee must work within a pay period. This allows the system to forecast a number of hours for floating employees when doing forecast reporting. Unlike an employee assigned to a fixed shift, a floating employee may work varied shifts as long as he/she works the total number of hours required for the pay period.
**Shift Details**
Displays the individual shifts that comprise the shift group. Each row in the box is an individual shift. If the *Shift Details* box is blank, no individual shifts have been created for this group.

**Add/Edit/Delete buttons**
These buttons allow you to maintain the Shifts within this Shift Group.

**Rounding**
These settings determine which Rounding Rules will apply to all the Shifts within this Shift Group.

**In/Out Rounding**
Click the arrow to select time rounding rules for In and Out punches used by the shift group.

*NOTE:* These rules apply to the entire group and not to the individual shifts.

**Add/Edit In/Out Rounding**
Click this button to Add or Edit the In/Out Rounding Rules.

**Lunch Rounding**
Click the arrow to select time rounding rules for Lunch punches used by the shift group.

*NOTE:* These rules apply to the entire group and not to the individual shifts.

**Add/Edit Lunch Rounding**
Click this button to Add or Edit the Lunch Rounding Rules.

**Break Rounding**
Click the arrow to select time rounding rules for Break punches used by the shift group.

*NOTE:* These rules apply to the entire group and not to the individual shifts.

**Add/Edit Break Rounding**
Click this button to Add or Edit the Break Rounding Rules.
3. The **Add/Edit Rounding** buttons are only available when you are adding or editing a Shift Group. When you click on the **Rounding** buttons the **Rounding Details** dialog boxes contain the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This field is required. Enter a unique rounding code up to 5 characters in length. Once saved, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This field is required. Type the time rounding code name as you want it to appear in the system and on reports. The rounding code name can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>These settings define the rounding rules for the period's start time. Depending upon the type of transaction selected, this may be the In, Start Lunch or Start Break punch.</td>
</tr>
<tr>
<td><strong>Round In</strong></td>
<td>Identifies the number of minutes before the scheduled <strong>Start</strong> time that will round forward to the scheduled In time.</td>
</tr>
<tr>
<td><strong>Grace In</strong></td>
<td>Identifies the number of minutes that are rounded back after the scheduled start time.</td>
</tr>
<tr>
<td><strong>Dock In</strong></td>
<td>Identifies the number of minutes after the scheduled <strong>Start</strong> time that will be rounded forward before TA100 Pro will use the <strong>Outside Round</strong>.</td>
</tr>
<tr>
<td><strong>Outside Round</strong></td>
<td>The <strong>Outside Round</strong> box is for additional rounding rules not covered in the ranges above. Both the <strong>Start</strong> and <strong>Stop</strong> category has its own set of outside rounding parameters.</td>
</tr>
</tbody>
</table>
Every XX mins  Rounding may be minute to minute (0) or in set increments of 3, 6, 15, 30 or 60 minutes. Click the arrow to display valid entries then select the increment desired. For example, entering 15 in this field means that for punches occurring outside the Scheduled Start time, round to the nearest 15 minutes using the Round Back and Round Forward rules specified below.

With A XX Minute Split  Punches occurring through the minute specified will round back to the last defined rounding increment.

Stop  Fields in the Stop column allow the rounding of Out punches, based on the scheduled stop times. These settings define rounding rules to round the duration of the work period (as opposed to the start time.)

Dock Out  Identifies the number of minutes before the scheduled Stop time that will round back prior to the scheduled Stop time.

Grace Out  Identifies the number of minutes that are rounded forward to the scheduled Stop time.

Round Out  Identifies the number of minutes after the scheduled Stop time that will round back to the scheduled Stop time.

Outside Round  The Outside Round box is for additional rounding rules not covered in the ranges above. Both the Start and Stop category has its own set of outside rounding parameters.

Every XX mins  Rounding may be minute to minute (0) or in set increments of 3, 6, 15, 30 or 60 minutes. Click the arrow to display valid entries then select the increment desired. For example, entering 15 in this field means that for punches occurring outside the Scheduled Start time, round to the nearest 15 minutes using the Round Back and Round Forward rules specified below.

With A XX Minute Split  Punches occurring through the minute specified will round back to the last defined rounding increment.

Punches occurring from the minute indicated will round forward to the next defined rounding increment.
4. The Details tab is only available when you are adding or editing a Shift (as opposed to the Shift Group). It defines the settings for a selected Shift within the Shift Group, and contains the following information:

![Figure 46: Shifts: Shift Details tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic</td>
<td>Use the graphic timeline to define the individual start and stop time of a shift.</td>
</tr>
<tr>
<td>Shift Number</td>
<td>Enter a unique number (up to 3 digits) to identify the individual shift.</td>
</tr>
<tr>
<td>Start</td>
<td>Type the individual shift’s starting time in HH:MM. Times must be entered in military format.</td>
</tr>
<tr>
<td>Cutoff</td>
<td>Type the individual shift’s latest starting time (cutoff) in HH:MM, before the individual would “float” into the next schedule. Times must be entered in military format.</td>
</tr>
<tr>
<td>Stop</td>
<td>Type the individual shift’s ending time in HH:MM. Times must be entered in military format.</td>
</tr>
<tr>
<td>Process On</td>
<td>If the shift’s stop time rolls over to a new day, do you want to process the hours on the day the employee punched In or punched Out? Select the In or Out option by clicking the desired field.</td>
</tr>
<tr>
<td>Gross</td>
<td>This field automatically displays the total duration of the shift from clock in to clock out.</td>
</tr>
<tr>
<td>Lunch/Breaks</td>
<td>This field automatically displays the total number duration of lunches and breaks (combined).</td>
</tr>
<tr>
<td>Totals</td>
<td>This field automatically displays the total paid hours for the day. It takes into account whether or not breaks and lunches are paid.</td>
</tr>
</tbody>
</table>
Lunches

These settings define how lunches are treated during this shift.

Punched

Check this box to indicate that employees should clock out for and in from lunch.

Elapsed

Select this option if the shift’s lunch period is automatically deducted after a number of elapsed hours. If the Punched check box is also selected, the punched time overrides the elapsed time. In other words, if the employee does not punch Out for and In from lunch, the shift’s lunch period is automatically deducted after the elapsed time. Define the elapsed time in the Elapsed Deduct box below.

None

If no restrictions apply to the shifts lunch period, select this option. Typically, if the employee has a paid lunch, clear the Punched check box and select None. This prohibits the employee’s lunch period from being deducted from the shift’s total hours.

SG Max

If Swipe and Go is in use, this tells TA100 Pro what the maximum amount of time a lunch or break can be. Enter time in military format. TA100 Pro will then take all the punches and measure the duration between transactions. If the duration is longer than the SG Max, it will move to the next option.

Breaks

These settings define how breaks are treated during this shift.

Punched

Check this box to indicate that employees should clock to and from break.

Elapsed

Select this option if the shift’s break period is automatically deducted after a number of elapsed hours. If the Punched check box is also selected, the punched time overrides the elapsed time. In other words, if the employee does not punch Out for and In from break, the shift’s break period is automatically deducted after the elapsed time. Define the elapsed time in the Elapsed Deduct box below.

None

If no restrictions apply to the shift’s break, select this option. Typically, if the employee has a paid break, clear the Punched check box and select None. This prohibits the employee’s break from being deducted from the shift’s total hours.
**SG Max**

If Swipe and Go is in use, this tells TA100 Pro what the maximum amount of time a lunch or break can be. Enter time in military format. TA100 Pro will then take all the punches and measure the duration between transactions. If the duration is longer than the SG Max, it will move to the next option.

**Exceptions**

Enter the time frames for exception transactions in this box. These are the time frames in which employees are not supposed to be punching. If a punch falls within these time frames, it is reported on the Punch Interval Exceptions report and to the Approval Editor as an exception or violation that needs supervisor approval.

**Start**

Type the starting time of the exception in HH:MM. Time must be entered in military format.

**Stop**

Type the ending time of the exception in HH:MM. Time must be entered in military format.

**Punch Type**

Select In or Out to indicate that the exception applies to an In or Out punch.

**Type**

Click the down arrow to the right of the Type field and select the type of period (Lunch, Break or None) to be defined in this row. For example, to define a windowed lunch period, select Lunch as the Type.

**Paid**

For windowed lunches or breaks, if the lunch or break is paid, select the Paid check box. Otherwise, clear this box to indicate an unpaid lunch or break.

**Elapsed Deduct**

These settings define the parameters for Elapsed Lunches and Breaks. If Elapsed is selected in either the Lunch or Breaks sections, you must configure this section.

**Elapsed**

Enter the number of hours that need to elapse before a Lunch or Break is automatically deducted. For example, if three hours must elapse, enter 03:00 in this field.

**From**

Click the button to the left of the From field and select whether the elapsed time starts from the Actual In Punch or Shift Start Time. The word Punch or Shift displays in this field to indicate your selection.

**Deduct**

Enter the time to be automatically deducted for the Lunch or Break. For example, to deduct one hour, enter 01:00.
Punched

These settings define how long the employee is allowed for lunch, and how payment should be handled if the employee takes more time than is allowed.

Duration

If the employee punches Out for and In from lunches or breaks, enter the duration of the lunch or break in this field. For example, to specify a one-hour lunch period, enter 01:00.

Pay Outside

If the employee punches Out for and In from lunch, select the Pay Outside check box to authorize payment for any time taken outside the specified window of time.

5. The Differential tab defines a Shift Differential for this Shift Group (not for the individual Shift) and contains the following information:

![Figure 47:Shifts: Differential tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Differential List</td>
<td>Displays the Start, Stop, and daily status of an existing differential.</td>
</tr>
<tr>
<td>From</td>
<td>Select the starting time for the pay differential.</td>
</tr>
<tr>
<td>To</td>
<td>Select the ending time for the pay differential.</td>
</tr>
<tr>
<td>Day of the Week</td>
<td>Select the differential premium code (D1-D3) assigned to the shift each day of the week. For example, a 10:00 P.M. to 6:00 A.M. shift may receive a $5.00 per hour premium on weekends, but only $2.50 per hour premium Monday through Friday. If no differential premium code applies to a particular day, select &quot;No Differential&quot;.</td>
</tr>
</tbody>
</table>
Add a Shift Group

1. Click the System Setup menu, Shift. The Configure Shift dialog box will open.
2. Click the Add button to add a new Shift Group. The Groups tab will become available.
3. Fill in the Code, Name, Flex/Open, Forecasted hours for Floaters and select the Rounding as describe in the Configure Shift Group section. **NOTE:** If the Rounding Rules are not defined see Add/Edit Rounding for more information.
4. Click OK to commit the changes and close the Configure Shift Group dialog box.
5. Click the Add button next to the Shift Details window to add a new Shift. The Details tab will become available.
6. Fill in the settings as described in the Configure Shift section.
7. Click OK to commit the changes and close the Shift dialog box.
8. Click on the Differential tab to add a shift differential.
9. Click the Add button.
10. Enter the From and To in HH:MM.
11. Select the Day and Differential number that will apply to this shift.
12. Click Close to exit the Configure Shift Group dialog box. **NOTE:** See Add A Shift to enter the specific shifts within this shift group.

Edit a Shift Group

1. Click the System Setup menu, Shift. The Configure Shift Group dialog box will open.
2. Highlight the Shift Group you wish to edit from the list at the side of the screen.
3. Click the Edit button. The Groups screen will become available for you to edit the selected Shift Group.
4. Edit the Name, Flex/Open, Forecasted hours for Floaters and select the Rounding as describe in the Configure Shift Group section.

5. Click OK to commit the changes and return to the Configure Shift Group screen.

6. Click Close to exit the Configure Shift Group dialog box.

   NOTE: See Edit a Shift to edit shift within this shift group.

Delete a Shift Group

1. Click the System Setup menu, Shift. The Configure Shift Group dialog box will open.

2. Highlight the Shift Group you wish to delete from the list at the side of the screen.

3. Click the Delete button. You will be prompted:

   Figure 49: Deletion Confirmation

4. Click OK to confirm the deletion.

5. Click Close to exit the Configure Shift Group dialog box.

Add a Shift

1. Click the System Setup menu, Shift. The Configure Shift dialog box will open.

2. Click the Add button next to the Shift Details window to add a new Shift. The Details tab will become available.

3. Fill in the settings as described in the Configure Shift section.

4. Click OK to commit the changes and close the Shift dialog box.

5. Click on the Differential tab to add a shift differential.

6. Click the Add button.

7. Enter the From and To in HH:MM.

8. Select the Day and Differential number that will apply to this shift.

9. Click Close to exit the Configure Shift dialog box.

Edit a Shift

1. Click the System Setup menu, Shift. The Configure Shift dialog box will open.
2. Highlight the Shift you wish to edit from the list in the center of the Groups screen.

3. Click the Edit button next to the Shift Details window. The Details screen will become available for you to edit the selected Shift.

4. Edit the settings as described in the Configure Shift section.

5. Click OK to commit the changes and return to the Configure Shift screen.

6. Click on the Differential tab to edit a shift differential.

7. Click the Edit button.

8. Edit the From, To, Day and Differential number.

9. Click OK to commit the changes and close the Shift Differential dialog box.

10. Click Close to exit the Configure Shift dialog box.

Delete a Shift

1. Click the System Setup menu, Shift. The Configure Shift dialog box will open.

2. Highlight the Shift you wish to from the list in the Center of the Groups screen.

3. Click the Delete button next to the Shift Details window. You will be prompted:

   ![Confirmation Window](Figure 50: Deletion Confirmation)

4. Click OK to confirm the deletion.

5. Click Close to exit the Configure Shift dialog box.

Add a Rounding Rule

1. Click the System Setup menu, Shift. The Configure Shift Group dialog box will open.

2. Click the Edit button to edit the Shift Group.

3. Click the Add In/Out Rounding, Lunch Rounding, or Break Rounding button. The Rounding Details dialog box will open.

4. Fill in the settings as described in the Configure Shift Group section.

5. Click OK to commit the changes and close the Rounding dialog box.

6. Click Close to exit the Configure Rounding dialog box.
Edit a Rounding Rule

1. Click the **System Setup** menu, **Shifts**. The **Configure Shift Group** dialog box will open.
2. Click the **Edit** button to edit the Shift Group.
3. Using the drop down arrow select the Rounding Rule you wish to edit.
4. Click the **Edit In/Out Rounding**, **Edit Lunch Rounding**, or **Edit Break Rounding** button. The **Rounding Details** dialog box will open for you to edit the selected Rounding Rule.
5. Edit the settings as described in the **Configure Shift Group** section.
6. Click **OK** to commit the changes and return to the **Rounding Details** dialog box.
7. Click **Close** to exit the **Configure Shift Group** dialog box.
Holidays

The Holiday feature specifies which dates are considered company holidays. \( \textit{How employees are paid for the holidays is defined within Policies section.} \) Holidays must be defined in order to post employee time toward a paid holiday rather than time worked, as well as to generate time and attendance reports that reflect holidays.

It is necessary to define the holidays each year, as certain holidays fall on or are observed on different dates each year.

**Holiday Tips:**

- It is not necessary to define all annual holidays: only enter those holidays that your company recognizes.
- If a holiday falls on a Sunday, but your employees get Monday off, enter the holiday using Monday’s date.
- If a holiday falls on a weekend, and your employees do not receive holiday hours for that day, then don’t enter the holiday in the system.
- If your employees get two consecutive days off for a holiday, you must enter both dates. For example, if Tuesday is the holiday and you wish to give both Monday and Tuesday off with pay; enter the date for both days.

**NOTE:** No more than two \textit{consecutive} holidays may be entered if employees must work the day before \textit{and} the day after the holiday.

Configure Holidays

1. Click the \textit{System Setup} menu, \textit{Holidays}. The \textit{Configure Holidays} window will open.

   ![Configure Holidays](image)

   \textit{Figure 51: Configure Holidays}

2. The \textit{Configure Holidays} dialog box contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textit{Date}</td>
<td>Enter the date on which the holiday will be observed. This is the date on which the Holiday Policies (set in Policies) will apply.</td>
</tr>
</tbody>
</table>
**Name** Enter the name of the holiday.

**Active** Check the Active box to indicate that this holiday will be observed.

**Override Absent Allowed** Check this box if paid time for this Holiday should supersede a system-generated absence.

**Holiday Groups** Click the Include box for each group the Holiday will be observed.

---

**Add a Holiday**

1. Click the **System Setup** menu, **Holiday**. The *Configure Holiday* dialog box will open.

2. Click the **Add** button to add a new Holiday. The **General** tab will become available.

   ![Configure Holiday Dialog Box]

   **Figure 52: Adding a new Holiday**

3. Fill in the settings as described in the *Configure Holidays* section.

4. Click **OK** to commit the changes and close the **Holiday** dialog box.

5. Click **Close** to exit the **Configure Holiday** dialog box.

---

**Edit a Holiday**

1. Click the **System Setup** menu, **Holidays**. The *Configure Holidays* dialog box will open.

2. Highlight the Holiday you wish to edit from the list at the side of the screen.

3. Click the **Edit** button. The **General** screen will become available for you to edit the selected Holiday.

4. Edit the settings as described in the *Configure Holiday* section.

   **NOTE:** The date cannot be modified.

5. Click **OK** to commit the changes and return to the **Configure Holiday** screen.

6. Click **Close** to exit the **Configure Holiday** dialog box.
Delete a Holiday

1. Click the **System Setup** menu, **Holidays**. The **Configure Holidays** dialog box will open.
2. Highlight the Holiday you wish to delete from the list at the side of the screen.
3. Click the **Delete** button. You will be prompted:

![Figure 53: Deletion Confirmation]

4. Click **OK** to confirm the deletion.
5. Click **Close** to exit the **Configure Holidays** dialog box.

Groups

User-defined groups are optional but very useful. Groups are used to organize and sort employees throughout TA100 Pro. They may be used to sort employees when generating reports, and are also used with Security to control which employees managers are allowed to edit. Some examples of employee groups are:

- Managers
- Union Employees
- Part-time Employees

Employees are assigned to a group in the Employee Maintenance dialog box.

Configure Groups

1. Click the **System Setup** menu, **Groups**. The **Configure Groups** window will open.

![Figure 54: Configure Groups]
2. The *Configure Groups* dialog box contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter a unique code (up to 10 characters) to identify the employee group. Once saved, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This is a required field. Enter the group name, as you want it to appear in the system and on reports. The group name can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the employee group is currently in use. Clear this check box if the group is not being used at this time.</td>
</tr>
</tbody>
</table>

**Add a Group**

1. Click the **System Setup** menu, **Groups**. The *Configure Groups* dialog box will open.
2. Click the **Add** button to add a new Group. The **General** tab will become available.

3. Fill in the settings as described in the *Configure Groups* section.
4. Click **OK** to commit the changes and close the **Group** dialog box.
5. Click **Close** to exit the *Configure Groups* dialog box.

**Edit a Group**

1. Click the **System Setup** menu, **Groups**. The *Configure Groups* dialog box will open.
2. Highlight the Group you wish to edit from the list at the side of the screen.
3. Click the **Edit** button. The **General** screen will become available for you to edit the selected Group.
4. Edit the settings as described in the *Configure Groups* section.  
   **NOTE:** The *Group Code* cannot be changed.

5. Click **OK** to commit the changes and return to the *Configure Groups* screen.

6. Click **Close** to exit the *Configure Groups* dialog box.

**Delete a Group**

1. Click the **System Setup** menu, **Groups**. The *Configure Groups* dialog box will open.

2. Highlight the Group you wish to delete from the list at the side of the screen.

3. Click the **Delete** button. You will be prompted:

   ![Confirmation](image)

   *Figure 56: Deletion Confirmation*

4. Click **OK** to confirm the deletion.

5. Click **Close** to exit the *Configure Groups* dialog box.
Departments

Departments are the top level in Job Costing. Departments indicate the business unit or section of the company that employees work for, and are used to track where employees spend their time. Departments serve many purposes in TA100 Pro. Employees can track their time to a department by clocking into and/or transferring to the department. Wages can be associated with the department and employee, enabling accurate department costing. Hours and wage budgets can be set for the department, enabling accurate budget vs. actual reporting. Reports can be filtered and grouped by department.

Departments are optional and only available when the Department Use Flag is checked on the Configure tab of the Main Company dialog box. Also, if you changed the name used to refer to Departments (on the Defaults tab of the Main Company dialog box), that name will be used in lieu of "Department". For more information, see Main Company, page 28.

Some examples of departments are:

- Accounting
- Administration
- Customer Service
- Research and Development
- Sales and Marketing
- Shipping

Configure Departments

1. Click the System Setup menu, Department. The Configure Department window will open.

![Figure 57: Configure Departments](image)

2. The Configure Department dialog box contains the following information:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter a code to identify the department. The code’s length and type (numeric or alphanumeric) is determined in the Defaults dialog box in the Main Company dialog box (see Main Company, page 28.). Once saved, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This is a required field. Enter the department name, as it will appear in the system and on reports. The department name can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Check this box to indicate that the department is currently in use. Clear this check box if the department is not being used at this time.</td>
</tr>
<tr>
<td><strong>Use Hourly Wage</strong></td>
<td>Check this box to pay all employees assigned to this department a standard hourly wage whenever they work in this department. Checking this box will enable the Hourly Wage field, in which you define the amount of the wage. <strong>NOTE:</strong> This Hourly Wage is also known as the <em>Level Wage</em>. If this wage is different than the employee's individual wage, the employee's individual wage takes precedence. To cause the Hourly Wage (Level Wage) to take precedence, check the <em>Use Level Wage before default assignment wage</em> option on the Configure tab of the Configure Main Company dialog box.</td>
</tr>
</tbody>
</table>
**Budgeted Total Hours**

Enter the maximum number of hours (HH.MM) that are budgeted for this entire department per day in the pay period. This information is used for Actual vs. Budgeted reports only: it does not impact the employee’s ability to clock in. This field is optional.

This number indicates the amount budgeted per day in the pay period. Calculate this number by multiplying the number of employees working in the department by the number of hours each employee is expected to accumulate in the pay period. This number is then divided by the total number of days in the pay period.

**Example**

10 employees X 40 hours per pay period = 400 total hours

400 total hours / 7 days in the pay period = **57.14** budgeted total hours

**Budgeted Total Dollars**

Enter the maximum number of dollars that are budgeted for this entire department per day in the pay period. This information is used for Actual vs. Budgeted reports only: it does not impact the employee's ability to clock in. This field is optional.

This number indicates the dollars budgeted per day in the pay period. Calculate this number by multiplying the number of employees working in the department by the dollar amount each employee is expected to accumulate in the pay period. This number is then divided by the total number of days in the pay period.

**Example**

10 employees X 600 dollars per pay period = 6000 total dollars

6000 total dollars / 7 days in the pay period = **857.14** budgeted total dollars.

**Hourly Wage**

Enter the hourly wage paid to employees working in this department.

The *Use Hourly Wage* check box must be selected for this field to be available.
Add a Department

1. Click the **System Setup** menu, **Department**. The **Configure Department** dialog box will open.

2. Click the **Add** button to add a new Department. The **General** tab will become available.

3. Fill in the settings as described in the **Configure Departments** section.

4. Click **OK** to commit the changes and close the **Department** dialog box.

5. Click **Close** to exit the **Configure Department** dialog box.

Edit a Department

1. Click the **System Setup** menu, **Department**. The **Configure Department** dialog box will open.

2. Highlight the Department you wish to edit from the list at the side of the screen.

3. Click the **Edit** button. The **General** screen will become available for you to edit the selected Department.

   **NOTE**: The **Code** field cannot be edited.

4. Edit the settings as described in the **Configure Departments** section.

5. Click **OK** to commit the changes and return to the **Configure Department** screen.

6. Click **Close** to exit the **Configure Department** dialog box.

Delete a Department

*Departments that are in use cannot be deleted.*

1. Click the **System Setup** menu, **Department**. The **Configure Department** dialog box will open.

2. Highlight the Department you wish to delete from the list at the side of the screen.
3. Click the **Delete** button. You will be prompted:

![Confirmation](image)

*Figure 59: Deletion Confirmation*

4. Click **OK** to confirm the deletion.

5. Click **Close** to exit the *Configure Department* dialog box.

**Jobs**

Jobs are the second level in Job Costing. Jobs are used to track employee's time and labor cost in terms of hours and dollars. Jobs serve many purposes in TA100 Pro. Wages can be associated with the job and employee. Hours and wage budgets can be set for the job, enabling accurate budget vs. actual reporting.

Jobs are optional and only available when the *Department* and *Job* Use Flags are checked on the *Configure* tab of the *Main Company* dialog box. Also, if you changed the name used to refer to Jobs (on the *Defaults* tab of the *Main Company* dialog box), that name will be used in lieu of "Jobs". For more information, see *Main Company*, page 28.

Some examples of Jobs might be:

- Welding
- Shipping
- Product Development
- Work Orders

**Configure Jobs**

Jobs are the second level of the Job Costing feature (Departments are the top level.)

1. Click the **System Setup** menu, then **Job**. The *Configure Job* window will open.

![Configure Job](image)

*Figure 60: Configure Job*
2. The **Configure Job** dialog box contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter a code to identify the Job. The code's length and type (numeric or alphanumeric) is determined in the <em>Defaults</em> dialog box in the <em>Main Company</em> dialog box (see page 28). Once saved, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This is a required field. Enter the Job name, as it will appear in the system and on reports. The Job name can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Check this box to indicate that the Job is currently in use. Clear this check box if the Job is not being used at this time.</td>
</tr>
<tr>
<td><strong>Use Hourly Wage</strong></td>
<td>Check this box to pay all employees assigned to this Job a standard hourly wage whenever they work in this Job. Checking this box will enable the <em>Hourly Wage</em> field, in which you define the amount of the wage.</td>
</tr>
<tr>
<td><strong>Budgeted Total Hours</strong></td>
<td>Enter the maximum number of hours (HH.MM) that are budgeted for this entire Job per day in the pay period. This information is used for Actual vs. Budgeted reports only: it does not impact the employee's ability to clock in. This field is optional.</td>
</tr>
</tbody>
</table>

**NOTE:** This Hourly Wage is also known as the *Level Wage*. If this wage is different than the employee's individual wage, the employee's individual wage takes precedence. To cause the Hourly Wage (Level Wage) to take precedence, check the *Use Level Wage before default assignment wage* option on the *Configure* tab of the *Configure Main Company* dialog box.

**Example**

10 employees X 40 hours per pay period = 400 total hours

400 total hours / 7 days in the pay period = 57.14 budgeted total hours
**Budgeted Total Dollars**

Enter the maximum number of dollars that are budgeted for this entire Job per day in the pay period. This information is used for Actual vs. Budgeted reports only: it does not impact the employee’s ability to clock in. This field is optional.

This number indicates the dollars budgeted per day in the pay period. Calculate this number by multiplying the number of employees working in the Job by the dollar amount each employee is expected to accumulate in the pay period. This number is then divided by the total number of days in the pay period.

**Example**

10 employees X 600 dollars per pay period = 6000 total dollars

6000 total dollars / 7 days in the pay period = **857.14** budgeted total dollars.

**Hourly Wage**

Enter the hourly wage paid to employees working in this Job.

The **Use Hourly Wage** check box must be selected for this field to be available.

---

**Add a Job**

1. Click the **System Setup** menu, then **Job**. The **Configure Job** dialog box will open.
2. Click the **Add** button to add a new Job. The **General** tab will become available.

![Configure Job dialog box]

**Figure 61: Adding a new Job**

3. Fill in the settings as described in the **Configure Jobs** section.
4. Click **OK** to commit the changes and close the **Job** dialog box.
5. Click **Close** to exit the **Configure Job** dialog box.
Edit a Job

1. Click the System Setup menu, then Job. The Configure Job dialog box will open.
2. Highlight the Job you wish to edit from the list at the side of the screen.
3. Click the Edit button. The General screen will become available for you to edit the selected Job.
   **NOTE:** The Code field cannot be edited.
4. Edit the settings as described in the Configure Jobs section.
5. Click OK to commit the changes and return to the Configure Job screen.
6. Click Close to exit the Configure Job dialog box.

Delete a Job

*Jobs that are in use cannot be deleted.*

1. Click the System Setup menu, then Job. The Configure Job dialog box will open.
2. Highlight the Job you wish to delete from the list at the side of the screen.
3. Click the Delete button. You will be prompted:

   ![Confirmation Dialogue Box]

   **Figure 62: Deletion Confirmation**

4. Click OK to confirm the deletion.
5. Click Close to exit the Configure Job dialog box.
Bell Schedules

The Bell Schedules is an optional module that allows your Time clock to activate a bell at specified times of day. For example, you might have a bell ring to announce the start of a shift, break or lunch, and the end of the day. The bell schedule is defined by the day of the week, the time of day, and the duration of the bell. The Bell Schedules module can ring up to 336 bells per Time clock per week.

Each Bell Schedule template can contain multiple bell details. Once the Bell Schedule has been created, you will add the individual dates and times the bells will ring. The Bell Schedule is then downloaded to the appropriate Time clocks.

Configure Bell Schedules

1. Click the System Setup menu, Bell Schedules. The Configure Bells window will open.

![Figure 63: Configure Bells](image)

2. The Configure Bells dialog box contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number</strong></td>
<td>This is a required field. Enter a 4-digit number to identify the bell schedule. Once saved, this number cannot be changed.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This is a required field. The bell schedule name can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the Bell Schedule is currently in use. Uncheck this box if the Schedule is not being used at this time.</td>
</tr>
<tr>
<td><strong>Schedules</strong></td>
<td>Lists the individual bell days and times entered.</td>
</tr>
<tr>
<td><strong>Number</strong></td>
<td>Indicates the order the bells will ring.</td>
</tr>
<tr>
<td><strong>SMTWTFS</strong></td>
<td>Indicates the day(s) of the week the bell will ring.</td>
</tr>
</tbody>
</table>
**Time**
Indicates the time at which the bell will ring.

**Duration**
Indicates how long the bell will ring.

**Day of Week**
Indicates the day(s) of the week the bell selected in the Schedules list will ring.

**Time**
Indicates the time at which the bell selected in the Schedules list will ring.

**Duration**
Indicates how long the bell selected in the Schedules list will ring.

---

**Add a Bell Schedule**

1. Click the **System Setup** menu, **Bell Schedules**. The *Configure Bell Schedule* dialog box will open.

2. Click the **Add** button to add a new Bell Schedule. The **General** tab will become available.

3. Enter in the Number, Name and Active status. **NOTE**: As soon as the Number is entered, the **Add** button in the center of the screen will become available.

4. Click the **Add** button in the center of the screen to add the individual bell details. The **Bell Details** window will open.
5. Select the days of the week you want the bell to ring.

6. Enter the time (HH:MM) at which you want the bell to ring. This must be entered in military time.

7. Enter the duration for the bell (how long the bell should ring). The default value is 2.0 seconds.

8. Click **OK** to commit the changes and close the *Bell Details* dialog box.

9. Repeat Steps 4 through 8 to add all the Bell Details for this schedule.

10. Click **OK** to commit the changes and return to the *Configure Bells* screen.

11. Click **Close** to exit the *Configure Bells* dialog box.

**Edit a Bell Schedule**

1. Click the **System Setup** menu, **Bell Schedules**. The *Configure Bells* dialog box will open.

2. Highlight the Bell Schedule you wish to edit from the list at the side of the screen.

3. Click the **Edit** button. The *General* screen will become available for you to edit the selected Bell Schedule.

4. Edit the settings as described in the *Configure Bell Schedule* section.

5. Click **OK** to commit the changes and return to the *Configure Bells* screen.

6. Click **Close** to exit the *Configure Bells* dialog box.

**Delete a Bell Schedule**

*Bell Schedules that are in use cannot be deleted.*

1. Click the **System Setup** menu, **Bell Schedules**. The *Configure Bells* dialog box will open.

2. Highlight the Bell Schedule you wish to delete using the list at the side of the screen.
3. Click the **Delete** button. You will be prompted:

![Confirmation](image)

**Figure 66: Deletion Confirmation**

4. Click **OK** to confirm the deletion.

5. Click **Close** to exit the *Configure Bell Schedules* dialog box.

**Security**

Security access determines who can log in to the TA100 Pro, which employees they are allowed to manage and which areas of the program they are permitted to access.

Security is established in two steps.

1. Create the Security Levels that specify which program features are accessible.

2. Add User accounts.

Users are given a login id and password, are assigned to a Security Level, and are granted access to select groups of employees.

You may define an unlimited number of Security Levels and Users. The number of users logged in at one time is limited by the number of User Licenses installed.

There are four commands within the Security menu, all of which are described in the following sections.

![Security Menu](image)

**Figure 67: Security Menu**
Configure Security Levels

Security Levels define which areas of the program are accessible and what can be done in them. Security Levels should be configured prior to adding Users. Examples of Security Levels are:

- Branch Managers
- Line Supervisors
- Payroll/HR

Up to four options are available for each feature. As the function of these options is the same for each feature, they are described once here for ease of use:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Grants read-only access to items.</td>
</tr>
<tr>
<td>Add</td>
<td>Allows the user to add new items.</td>
</tr>
<tr>
<td>Edit</td>
<td>Allows the user to edit existing items.</td>
</tr>
<tr>
<td>Delete</td>
<td>Allows the user to delete existing items.</td>
</tr>
</tbody>
</table>

1. Click the File menu, Security, Define Levels. The Configure Security Levels window will open.

![Figure 68: Configure Security Levels](image)

2. The Configure Security Levels dialog box contains some general settings and several tabs, all of which are described below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>This field is required. Enter a unique code (up to 10 characters) to identify the security level. Once saved, this Code cannot be changed.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a description of the security level in this field. The description can be up to 30 characters long.</td>
</tr>
</tbody>
</table>
**Active**
Click the Active check box to indicate that the level is currently in use. Uncheck this box if the level is not being used at this time.

**Set Date and Time**
Check this box to allow the user to update the date and time of the PC.

**Print Lists**
Click the Print Lists check box to allow the user to print all available listings reports.

**Check All**
This option will activate all available features in the File window.

**Uncheck All**
This option will inactivate all available features in the File window.

3. The *File* tab grants access to features under the *File* menu and contains the following information:

![Security Levels: File tab](image)

**Setting** | **Definition**
---|---
**Security** | This section defines the user’s access rights to the *File, Security* menu’s features.

**Users** | Defines the user’s access rights to User Maintenance settings. The options are *View*, *Add*, *Edit* and/or *Delete*.

For more information on User Maintenance, see page 95.

**Define Levels** | Defines the user’s access rights to Security Levels settings. The option is *View*.

**Who is in** | Defines the user’s access rights to the Who’s In screen. The option is *View*.

**Utilities** | This section defines the user’s access rights to the *File, Utilities* menu’s features.

**NOTE:** Typically these are reserved for the system administrator.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reindex, Repair, Update</strong></td>
<td>Allows the user to Repair, Reindex and Update the TA100 Pro databases. For more information on these features, see <strong>Repairing</strong> (page 251), <strong>Reindexing</strong> (page 251) and <strong>Updating</strong> (page 251).</td>
</tr>
<tr>
<td><strong>Set Reprocess Date</strong></td>
<td>Allows the user to Set employees' Reprocess Date. For more information on this feature, see <strong>Set Reprocess Date</strong>, page 254.</td>
</tr>
<tr>
<td><strong>Fix Unassigned Badges</strong></td>
<td>Allows the user to use the Fix Unassigned Badges utility. For more information on this feature, see <strong>Fix Unassigned Badges</strong>, page 255.</td>
</tr>
<tr>
<td><strong>Backup and Restore</strong></td>
<td>Allows the employee to Backup the TA100 Pro database and restore databases from backup. For more information on these features, see <strong>System Backup</strong>, page 261.</td>
</tr>
<tr>
<td><strong>Repost from R-files</strong></td>
<td>Allows the employee to repost R-files (polled clock data) to the TA100 Pro database. For more information on this feature, see <strong>Repost R-Files</strong>, page 256.</td>
</tr>
<tr>
<td><strong>Purge R-files</strong></td>
<td>Allows the employee to delete old R-files (polled clock data) from the TA100 Pro directory. For more information on this feature, see <strong>Purge R-Files</strong>, page 256.</td>
</tr>
<tr>
<td><strong>Archive and Restore</strong></td>
<td>Allows the employee to Archive the TA100 Pro database and restore a previously archived database. For more information on these features, see <strong>Archive</strong>, page 258.</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td>This section defines the user's access rights to the other items in the File menu'.</td>
</tr>
<tr>
<td><strong>Import</strong></td>
<td>Allows the employee to import data from external files. For more information on this feature, see <strong>Importing</strong>, page 245.</td>
</tr>
<tr>
<td><strong>Export</strong></td>
<td>Allows the employee to export data from TA100 Pro to an external file. For more information on this feature, see <strong>Exporting</strong>, page 247.</td>
</tr>
</tbody>
</table>
Print Setup  Allows the employee access to the print setup information from the File menu. See page 180.

4. The Daily Operations tab grants access to features under the Daily Operations menu and contains the following information:

![Figure 70: Security Levels: Daily Operations tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Editor</td>
<td>Defines the user's access rights to the Approval Editor. The options are View and Edit.</td>
</tr>
<tr>
<td></td>
<td>For more information on this feature, see Approval Editor, page 170.</td>
</tr>
<tr>
<td>Employee</td>
<td>Defines the user's access rights to the Configure Employee section. The options are View, Add, Edit and/or Delete and will allow the user access to employee records. If Add, Edit and Delete are turned off the Detail Tab is also off.</td>
</tr>
<tr>
<td></td>
<td>For more information on this feature, see Employee Maintenance, page 112.</td>
</tr>
<tr>
<td>Details (w/o Add, Edit, Delete)</td>
<td>Defines the user's access to the Details tab of the Configure Employee section. This is a view only feature, unless Add, Edit and Delete have been activated in the above (Employee) section.</td>
</tr>
<tr>
<td>Timecard</td>
<td>Defines the user's access rights to the Timecard tab of the Configure Employee section. The options are View, Add, Edit and/or Delete and will allow the user access to employee time sheet data.</td>
</tr>
<tr>
<td></td>
<td>For more information on this feature, see Employee Timecard, page 118.</td>
</tr>
</tbody>
</table>
Approve Timecard  Defines the user’s access to approve timecards in the Timecard tab of the Configure Employee section.

Schedule  Defines the user's access rights to the Schedule tab of the Configure Employee section. The options are View, Edit, and Delete and will allow the user access to the employee's schedule.

For more information on this feature, see Employee Schedule, page 123.

Allow Schedule Override  Defines the user’s access to create new shifts as a shift override on the Schedule tab of the Configure Employee section.

Transactions  Defines the user's access rights to the Transactions tab of the Configure Employee section. The options are View, Add, Edit and/or Delete and will allow the user access to employee transaction (punch) data.

For more information on this feature, see Employee Transactions, page 131.

Status  Defines the user's access rights to the Status tab of the Configure Employee section. The options are View, Add, Edit and/or Delete.

For more information on this feature, see Employee Status, page 132.

Benefits  Defines the user's access rights to the Benefits tab of the Configure Employee section. The options are View and Edit and allow the user access to the employee’s benefits entitlement information.

For more information on this feature, see Employee Benefits, page 135.

Messages  Defines the user's access rights to the Messages tab of the Configure Employee section. The options are View, Add, Edit and/or Delete.

For more information on this feature, see Employee Messages, page 142.

Wages  Defines the user's access rights to the Wages tab of the Configure Employee section. The options are View and Edit and will allow the user access to employee pay rate information.

For more information on this feature, see Employee Wages, page 144.
**Badges**

Defines the user’s access rights to the Badges tab of the Configure Employee section. The options are View, Add, Edit and/or Delete.

For more information on this feature, see Employee Badges, page 148.

**Clocks**

Defines the user’s access rights to the Clocks tab of the Configure Employee section. The options are View, Add, Edit and/or Delete.

For more information on this feature, see Employee Clocks, page 150.

**Status Board**

Allows the user to view the Status Board screen.

For more information on this feature, see Status Board, page 172.

**Task Organizer**

Allows the user to view the Task Organizer screen.

For more information on this feature, see Task Organizer, page 172.

**Global**

Allows the user access to the File, Global menu, from which he/she can perform global functions.

For more information on this feature, see Global Commands, page 176.

**Benefits Accruals**

Allows the user to access the File, Benefits Accruals menu. (Benefits Accruals are an optional feature and therefore may not be available here.) The options are View, Add, Edit and/or Delete.

For more information on this feature, see Benefits Accruals, page 112.

5. The Reports tab grants access to features under the Reports menu and contains the following information:
Figure 71: Security Levels: Reports tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period Reports</td>
<td>Grants access to the reports such as Timecards, Who’s Scheduled, Coverage, etc.</td>
</tr>
<tr>
<td>Weekly Reports</td>
<td>Grants access to the reports such as Weekly Hours, Attendance, Approaching Overtime, etc.</td>
</tr>
<tr>
<td>Daily Reports</td>
<td>Grants access to the reports such as Who’s in, Who’s not in, Daily Hours, etc.</td>
</tr>
<tr>
<td>Payroll Export</td>
<td>Grants access to run the Payroll Export.</td>
</tr>
<tr>
<td>Listings</td>
<td>Grants access to the reports in the Listings category.</td>
</tr>
</tbody>
</table>

For more information see Listings, page

6. The System Setup tab grants access to features under the System Setup menu and contains the following information:

Figure 72: Security Levels: System Setup tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Main Company** | Defines the user's access rights to the *Main Company* settings. The only option is *Edit*.  
For more information on this feature, see *Main Company*, page 28. |
| **Divisions**   | Defines the user's access rights to *Divisions* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Divisions*, page 34. |
| **Categories**  | Defines the user's access rights to *Categories* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Categories*, page 37. |
| **Policies**    | Defines the user's access rights to *Policies* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Policies*, page 43. |
| **Shifts**      | Defines the user's access rights to *Shifts* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Shifts*, page 55. |
| **Holidays**    | Defines the user's access rights to *Holidays* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Holidays*, page 66. |
| **Groups**      | Defines the user's access rights to *Groups* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Groups*, page 70. |
| **Department**  | Defines the user's access rights to *Department* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Departments*, page 73. |
| **Job**         | Defines the user's access rights to *Job* settings. The options are *View, Add, Edit* and *Delete*.  
For more information on this feature, see *Configure Jobs*, page 77. |
Bell Schedules  Defines the user's access rights to Bell Schedule settings. The options are View, Add, Edit and Delete.

For more information on this feature, see Bell Schedules, page 112.

7. The Communication tab grants access to features under the Communications menu and contains the following information:

![Figure 73: Security Levels: Communication tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poll</td>
<td>This section defines the user's access rights to Poll hardware clocks.</td>
</tr>
<tr>
<td>Start</td>
<td>Allows the user to start the process of polling clocks.</td>
</tr>
<tr>
<td></td>
<td>For more information on this feature, see Polling, page 236.</td>
</tr>
<tr>
<td>Change Selections</td>
<td>Allows the user to manually change the times at which the clocks poll.</td>
</tr>
<tr>
<td></td>
<td>For more information on this feature, see Polling, page 236.</td>
</tr>
<tr>
<td>Options</td>
<td>Allows the user to change the settings in the Poll Clock Selection dialog box.</td>
</tr>
<tr>
<td></td>
<td>For more information on this feature, see Polling, page 236.</td>
</tr>
<tr>
<td>AutoProcess</td>
<td>This section defines the user's access rights to configure Auto Processes.</td>
</tr>
<tr>
<td></td>
<td>For more information on this feature, see Configure an AutoProcess, page 238.</td>
</tr>
</tbody>
</table>

© July 2007 Time America, Inc. 93
**Schedule**

Defines the user's access rights to Schedule AutoProcess settings. The options are **View**, **Add**, **Edit** and **Delete**.

For more information on this feature, see **Configure an AutoProcess**, page 238.

**Start**

Allows the user to start a pre-defined AutoProcess.

For more information on this feature, see **Configure an AutoProcess**, page 238.

**Configure**

Defines the user's access rights to clock configuration settings. The options are **View**, **Add**, **Edit** and **Delete**.

For more information on this feature, see **Terminal Configuration**, page 195.

**Set Date and Time**

Allows the user to set the date and time of the clocks.

### Add a Security Level

1. Click the **File** menu, **Security, Define Levels**. The **Configure Security Level** dialog box will open.

2. Click the **Add** button to add a new Security Level. The tabs will become available.

   ![Figure 74: Adding a new Security Level](image)

   **Figure 74: Adding a new Security Level**

3. Fill in the settings as described in the **Configuring Security Levels** section.

4. Click **OK** to commit the changes and close the **Security Level** dialog box.

5. Click **Close** to exit the **Configure Security Level** dialog box.

### Edit a Security Level

1. Click the **File** menu, **Security, Define Levels**. The **Configure Security Levels** dialog box will open.
2. Highlight the Security Level you wish to edit from the list at the side of the screen.
3. Click the Edit button. The tabs will become available for you to edit the selected Security Level.
   **NOTE:** You cannot edit the Code field.
4. Edit the settings as described in the Configure Security Level section.
5. Click OK to commit the changes and return to the Configure Security Level screen.
6. Click Close to exit the Configure Security Level dialog box.

### Delete a Security Level

1. Click the File menu, Security, Define Levels. The Configure Security Levels dialog box will open.
2. Highlight the Security Level you wish to delete from the list at the side of the screen.
3. Click the Delete button. You will be prompted:

   ![Figure 75: Deletion Confirmation](image)

4. Click OK to confirm the deletion.
5. Click Close to exit the Configure Security Levels dialog box.

### User Maintenance

User Maintenance defines the users that can log in to TA100 Pro, which employees they can manage, and which areas of the program they can use. The user is given a login Id and password, is assigned a Security Level, and granted permission to select groups of employees.

**NOTE:** Define Levels must be completed before adding any users.

### Configure Users

1. Click the File menu, Security, User Maintenance. The Configure Users window will open.
2. The Configure Users dialog box contains several tabs, each of which is described below.

3. The Users tab contains the following information:

   ![Figure 77: Configure Users: User tab]

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Login</strong></td>
<td>This field is required. Enter a unique Login ID for this user, up to 9 alphanumeric characters. This code will be entered into the User ID field in the login window when this user logs in. Once saved, the Login name cannot be changed. When you press Tab or Enter after entering this field, the <strong>Password</strong> entry dialog box will appear automatically.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>This field is required. Enter a password, up to 9 alphanumeric characters, to be used with the User ID above. Type the password again to confirm it.</td>
</tr>
</tbody>
</table>
**Supervisor Badge** Enter the badge number assigned to this user. For audit purposes, this badge number is recorded when this user adds or edits transactions.

**Active** Click the Active check box to indicate that the Login ID is active. Uncheck this box if the Login is not being used at this time.

**Last** Enter the last name of this User.

**First** Enter the first name of this User.

**Security Level** Select the pre-defined Security Level for this user.

For more information on setting up Security Levels, see *Configure Security Levels*, page 85.

**Startup** This section determines the settings that apply when TA100 Pro starts up.

**Start In** Select the screen that should open automatically when TA100 Pro starts. The options are *Main Menu*, *Approval Editor*, *Employee* (*Configure Employee*) and *Task Organizer*.

**Color Quality** Select the set of icons you want displayed in Genesis Pro. The options are *High Quality* and *Low Quality*. High Quality displays the newest icons and Low Quality keeps the old icons.

**Email** Enter this user's email address. This can be used to send Auto Processed reports to the user whenever they're ready.

**NOTE:** This option will only be available if you have activated the SMTP feature.

**SMTP server** Enter the SMTP server name.

**Display Name** Enter the display name.

**E-mail Address** Enter the e-mail address.

**Outgoing Security** Enter this information for email authentication.

**User Name** Enter the user name.

**Password** Enter the password.

4. The *Divisions* tab specifies the Divisions to which this user can view and contains the following information:
Figure 78: Configure Users: Divisions tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Determines what options are available in the bottom part of the screen. The options are <strong>All</strong>, <strong>Range</strong>, and <strong>List</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>All</strong> automatically grants access to all Divisions.</td>
</tr>
<tr>
<td></td>
<td><strong>Range</strong> allows you to choose a range of Divisions for access.</td>
</tr>
<tr>
<td></td>
<td><strong>List</strong> allows you to choose individual Divisions for access.</td>
</tr>
<tr>
<td>List</td>
<td>When <strong>List</strong> is selected, a list of all the Divisions in your company will appear based on what was selected above.</td>
</tr>
<tr>
<td>Add/Add All</td>
<td><strong>Add</strong> adds the currently selected Division to the <strong>Selected</strong> list. <strong>Add All</strong> adds all of the Divisions to the <strong>Selected</strong> list.</td>
</tr>
<tr>
<td>Remove/Remove</td>
<td><strong>Remove</strong> removes the currently selected Division from the <strong>Selected</strong> list. <strong>Remove All</strong> removes all of the Divisions from the <strong>Selected</strong> list.</td>
</tr>
</tbody>
</table>

5. The **Groups** tab specifies the Groups which this user can view and contains the following information:
**Figure 79: Configure Users: Groups tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
</table>
| **Select** | Determines what options are available in the bottom part of the screen. The options are **All**, **Range**, and **List**.  
  - **All** automatically grants access to all Groups.  
  - **Range** allows you to choose a range of Groups for access.  
  - List allows you to choose individual Groups for access. |
| **List** | When List is selected, a list of all the Groups in your company will appear based on what was selected above. |
| **Add/Add All** | Add adds the currently selected Group to the Selected list. Add All adds all of the Groups to the Selected list. |
| **Remove/Remove All** | Remove removes the currently selected Group from the Selected list. Remove All removes all of the Groups from the Selected list. |

**Add a User**

1. Click the File menu, Security, User Maintenance. The Configure Users dialog box will open.

2. Click the Add button to add a new User. The User tab will become available.
Figure 80: Adding a new User

3. Fill in the settings as described in the Configure Users section.
4. Click **Apply** to commit the changes.
5. Click on the **Divisions** tab.
6. Click **Apply** to commit the changes.
7. Click on the **Groups** tab.
8. Click **OK**.
9. Click **Close** to exit the **Configure Users** dialog box.

**Edit a User**

1. Click the **File** menu, **Security, User Maintenance**. The **Configure Users** dialog box will open.
2. Highlight the User you wish to edit from the list.
3. Click the **Edit** button. The tabs will become available for you to edit. **NOTE**: The **Login** field cannot be edited.
4. Edit the settings as described in the **Configure User** section.
5. Click **OK** to commit the changes and return to the **Configure User** screen.
6. Click **Close** to exit the **Configure User** dialog box.

**Delete a User**

1. Click the **File** menu, **Security, User Maintenance**. The **Configure Users** dialog box will open.
2. Highlight the User you wish to delete from the list.
3. Click the **Delete** button. You will be prompted:
4. Click **OK** to confirm the deletion.

5. Click **Close** to exit the *Configure Users* dialog box.
Who's Logged In

The Who's Logged In screen displays the Login and name of all the users currently logged in to Genesis Pro.

1. Click the File menu, Security, Who's Logged In. The Who's Logged In screen will open. You may also print login activity by clicking Print.

Change Password

The Change Password function changes the password of the user currently logged in.

1. Click the File menu, Security, Change Password. The Change Password input box will open.

2. Enter your old password.

3. Enter your new password. Type the password again to confirm it.

4. Click OK to confirm the changes and exit the dialog box.
Benefit Accruals

Using Benefit Accruals, TA100 Pro can automatically calculate the available benefit time for your employees. These calculations are based upon rules that can account for different benefit types (vacation, sick, personal, etc.), different accrual methods, seniority rules and other factors. Benefit time taken is automatically subtracted from the available benefits so that balances are always accurate.

TA100 Pro allows for an unlimited number of policies so that you can accommodate different situations within your company. Each policy contains accumulators that specify the category amounts and rules for earning benefits.

After the policies are created, they are assigned to the appropriate employees within the company.

**NOTE:** Benefit Accruals is an additional module added into TA100 Pro. If you did not purchase Benefit Accruals, you will have Benefit Entitlement instead. See *Benefit Entitlement: Configure*, page 135.

There are two commands within the **Benefit Accruals** menu. Both are described below.

**Configure Benefit Accruals**

1. Click the **Daily Operations** menu, **Benefit Accruals, Configure**. The **Configure Benefit Accrual** window will open.

2. The **Configure Benefit Accrual** dialog box contains the following information:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter the code or number you wish to use to refer to this Benefit Accrual policy. You may enter up to 3 characters.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This is a required field. Enter the name you wish to use to refer to this Benefit Accrual policy. You may enter up to 30 characters.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the policy is currently in use. Uncheck this box if the policy is not being used at this time.</td>
</tr>
<tr>
<td><strong>Accumulators</strong></td>
<td>Lists the accumulators that make up this Benefit Accrual policy. For more information on this feature see <a href="#">Benefit Accruals</a>, page 103.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Indicates the unique number assigned to the selected accumulator.</td>
</tr>
<tr>
<td><strong>Posting Basis</strong></td>
<td>Indicates the frequency with which benefits are posted in this accumulator.</td>
</tr>
<tr>
<td><strong>Start Date</strong></td>
<td>Indicates the date on which this policy became effective.</td>
</tr>
<tr>
<td><strong>Reference Date</strong></td>
<td>Indicates the date on which the yearly benefits reset (previous balance zero out or roll forward, and the employee starts earning a new year's benefits.)</td>
</tr>
<tr>
<td><strong>Categories to Sum</strong></td>
<td>Indicates the categories that will be considered when calculating benefits based on hours worked and/or paid. Click the category to select it. A checkmark displays next to categories when they are selected.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Displays the code for the Category.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Displays the name of the Category.</td>
</tr>
<tr>
<td><strong>Regular</strong></td>
<td>Check this box to indicate that regular hours of the selected category(s) should be considered when calculating benefits.</td>
</tr>
<tr>
<td><strong>Overtime 1</strong></td>
<td>Check this box to indicate that overtime hours of the selected category(s) should be considered when calculating benefits.</td>
</tr>
<tr>
<td><strong>Overtime 2</strong></td>
<td>Check this box to indicate that overtime 2 hours of the selected category(s) should be considered when calculating benefits.</td>
</tr>
</tbody>
</table>
Overtime 3

Check this box to indicate that overtime 3 hours of the selected category(s) should be considered when calculating benefits.

Configure Benefit Accumulators

Accumulators specify the categories that will be granted by the policy, as well as the amounts granted and method of accrual. You can have multiple accumulators within one policy.

1. While adding or editing a Benefit Accrual, click the Add or Edit button in the center of the screen to display the Accumulators dialog box.

![Figure 85: Adding a Benefit Accumulator](image)

2. The Accumulators dialog box contains the following information:
### Setting | Definition
--- | ---
**Accumulator** | Select the category for this rule. Only the categories that have been selected for benefit entitlement will display in this drop-down box. To select a category for benefit entitlement, edit the Category in Configure, Categories and check the *Post to benefit entitlement* box. For more information, see *Categories*, page 37.

**Posting Basis** | Select how often you want benefits to be posted. The options are:
- Weekly
- Biweekly
- Semimonthly
- Monthly
- Annually
- Daily
The benefits are posted at the end of the posting period.

**Start Date** | Pick the date for the policy to take effect. Pick a date in the past so that the defined rules can be met for all current employees.

**Reference Date** | This date indicates the rollover or reset date for employee benefits. The options are:
- **Hire**: this benefit resets on the employee's individual hire date (set in Employee Maintenance).
- **Fiscal**: this benefit resets on the employee's individual fiscal date (set in Employee Maintenance).
- **Other**: this benefit resets on this date for all employees. For example, January 1.

**Give XX after X months from hire** | This setting enables you to grant a lump sum benefit a certain number of months from the employees hire date. For example, "Give 40 hours after 6 months from hire date" to automatically give an employee a week's vacation on his/her six-month anniversary.

**Do not give hours if Employee status is inactive** | This setting will not grant employee hours if the employee status is inactive.
**Accumulator Details**

This section displays the details for accumulating or accruing the category selected. There can be multiple accumulator details for one category.

The Accumulator section displays the rules for details already added. To display the entry screen for an Accumulator, click the **Add** button.

**Year**

This is a required field. Enter the number of years of service after which this rule takes effect. To have the rule start immediately, select 0. Works in conjunction with the months.

**Month**

This is a required field. Enter the number of months of service after which this rule takes effect. To have the rule start immediately, select 0. Works in conjunction with the years.

**One Time**

This setting allows you to grant a one-time benefit of this category. This field is optional.

For example, you might want to give a "length of service" bonus of 40 hours on the employee's anniversary, in addition to their regular accruals. This benefit occurs only once: it does not recur each year.

**Straight Given Hours (at end)**

This setting allows you to enter a set number of hours granted at the end of the Posting Basis period (weekly, biweekly, etc.) This field is optional

For example, to grant 8 hours of time per month, you would choose Monthly for the Posting Basis and enter 8 in this box.

**Hours from Categories to sum X**

This setting allows you to enter the fraction of benefits earned for hours worked and/or paid. TA100 Pro will calculate the number of hours paid of the categories selected in the Categories to Sum section of the Benefit Accrual dialog box. It will multiply the number of hours paid by the number entered here to calculate the available benefits, as follows:

\[
\text{Category Hours \times Factor} = \text{Accrued Benefit}
\]

**Minimum Hours Needed**

Enter the minimum hours required to be worked in the Posting Basis period for the employee to be eligible for any benefits accrual.

For example, this could be used to pay benefits only if the employee works more than 30 hours per week.
**Maximum Hours Allowed**
Enter the maximum hours that can be accumulated for this category during the Posting Basis period.

This is used to keep employees who work lots of hours from accruing more benefits than they are entitled to.

**Maximum Annual Carry Over**
Enter the number of hours the employee can carry forward into the next benefit year (on the Reference Date). For no carry over ("use it or lose it"), enter 0.

**Maximum Total Benefit Hours**
Enter the maximum number of hours the employee is allowed to accrue during the benefit year.

For example, this could be used to "cap" accruals at a maximum amount.

---

### Add a Benefit Accruals Policy

1. Click the **Daily Operations** menu, **Benefit Accruals, Configure**. The **Configure Benefit Accrual** dialog box will open.

2. Click the **Add** button to add a new Benefit Accruals policy. The **General** tab will become available.

3. Fill in the **Code** and **Name** fields as described in the **Configuring Benefit Accruals** section.

4. Click the **Add** button to display the **Accumulator** dialog box.
5. Fill in the settings as described in the *Configure Benefit Accumulators* section.

6. Click the **Add** button to display the *Accumulator Details* dialog box.

7. Fill in the **Accumulator Detail** settings as described in the *Configure Benefit Accumulators* section.

8. Click **OK** to accept the details and return to the *Accumulator* screen.

9. Repeat steps 6 through 8 for each unique accumulator details needed.

10. Click **OK** to accept the Accumulator and return to the *Benefit Accruals* screen.

11. Repeat steps 4 through 10 for each unique Accumulator (Category) needed.

12. Click **OK** to commit the changes and close the *Configure Benefit Accruals* dialog box.

13. Click **Close** to exit the *Configure Benefit Accruals* dialog box.
Edit a Benefit Accruals Policy

1. Click the Daily Operations menu, Benefit Accruals, Configure. The Configure Benefit Accrual dialog box will open.

2. Highlight the Benefit Accrual policy you wish to edit from the list at the side of the screen.

3. Click the Edit button. The General screen will become available for you to edit the selected Benefit Accrual policy.

4. Edit the settings as described in the Configure Benefit Accruals section.

5. Once you are editing the Benefit Accrual, you can further edit the Accumulator and Accumulator Details.

   To edit the Accumulator, click the Edit button in the Accumulator section in the center of the screen.

   To edit the Accumulator Details, first click the Edit button on the Benefit Accrual screen, then click the Edit button in the Accumulator screen.

6. Click OK as many times as necessary to commit the changes and return to the Configure Benefit Accrual screen.

7. Click Close to exit the Configure Benefit Accrual dialog box.

Delete a Benefit Accruals policy

Benefit Accruals that are in use cannot be deleted.


2. Highlight the Benefit Accruals policy you wish to delete from the list at the side of the screen.

3. Click the Delete button. You will be prompted:

   ![Figure 90: Deletion Confirmation](image)

4. Click OK to confirm the deletion.

5. Click Close to exit the Configure Benefit Accruals dialog box.
**Update to Current**

This command causes TA100 Pro to calculate all employees' benefit accruals up to the current date.

1. Click the *Daily Operations* menu, *Benefit Accruals, Update to Current*. TA100 Pro will automatically update employee benefits.

*Figure 91: Benefit Accruals: Update to Current*
Chapter V  Optional Modules

This section reviews the optional modules that are available with TA100 Pro. This section includes the following:

- Bell Schedules
- Benefits Accruals
- PC Clock
- Third Party Terminals

Bell Schedules

The Bell Schedules module allows your time clock to activate a bell at specified times of day. For example, you might have a bell ring to announce the start of a shift, break or lunch, and the end of the day. The bell schedule is defined by the day of the week, the time of day, and the duration of the bell. The bell schedules module can ring up to 336 bells per Time clock per week.

Each bell schedule template can contain multiple bell details. Once the Bell Schedule has been created, you will add the individual dates and times the bells will ring. The Bell Schedule is then downloaded to the appropriate time clocks. For more information, see Bell Schedules, page 81.

Benefit Accruals

Using Benefit Accruals, TA100 Pro can automatically calculate the available benefit time for your employees. These calculations are based upon rules that can account for different benefit types (vacation, sick, personal, etc.), different accrual methods, seniority rules and other factors. Benefit time taken is automatically subtracted from the available benefits so that balances are always accurate.

TA100 Pro allows for an unlimited number of policies so that you can accommodate different situations within your company. Each policy contains Accumulators, which specify the Categories, amounts and rules for earning benefits.

After the policies are created, they are assigned to appropriate employees within the company. For more information, see Benefit Accruals, page 103.

NOTE: Benefit Accruals is an additional module added into TA100 Pro. If you did not purchase Benefit Accruals, you will have Benefit Entitlement instead. See Benefit Entitlement: Configure, page 135.

PC Clock

PC Clock is an optional module that may be installed on anyone’s workstation and allows employees to clock in and out for the day, to and from lunch, and to and from breaks from their workstation. Employees may also use PC Clock to transfer departments and change their own passwords. PC Clock makes it easy to gather time from thousands of users in every corner of your enterprise, either across the building or across the country. PC Time Clock is perfect in situations where hardware data collection systems can't be cost-justified, or where hardware time clocks don't match into your organization's environment. For more information, see PC Clock, page 205.
Third Party Terminals

Third Party Terminals is an optional module that allows the use of Biometric Hand Readers, ATS series clocks, and biometric fingerprint readers. For more information see, Hand Readers, page 227, and see ATS, page 224.
Chapter VI  Additional Employee Features

This section reviews how to use the additional Employee Feature of the PC Clock, which is available with the TA100 Pro.

PC Clock

PC Clock is an application that allows employees to punch In and Out, punch for Lunches and Breaks, and Transfer Departments from their PC. PC Clock offers employees access to several useful tools in an easy to use environment. Each task employees can perform with PC Clock is one or two mouse clicks away.

NOTE: It is recommended that a facilitator go over the information available in this chapter with employees.

Accessing PC Clock

- Click the Start menu, Programs, TA100 Pro, and PC Clock

Default Settings to Use PC Clock

![Figure 92: PC Clock](image)

1. The PC Clock window contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC Clock Screen</td>
<td>Displays the date and time, and what information PC Clock is prompting you for.</td>
</tr>
</tbody>
</table>
**Function Keys**

Displays the number keys and the prompts that they will ask for.

**“1” Key**
This key is undefined.

**“2” Key**
This key is undefined.

**“3” Key**
This key is undefined.

**“4” Key**
Click this key to punch Out for Lunch.

**“5” Key**
Click this key to report Cash Tips.

**“6” Key**
Click this key to punch In from Lunch.

**“7” Key**
Click this key to punch Out for Break.

**“8” Key**
This key is undefined.

**“9” Key**
Click this key to punch In from Break.

**In Key**
Click this key to punch In.

**“0” Key**
Click this key to enter the Department transfer.

**Out Key**
Click this key to punch Out.

**Clear Key**
Click this key to Clear the transaction.

**Back Key**
Click this key to backspace one character.

**Enter Key**
Confirms an entry.

**Close Button**
Click this button Close PC Clock.

---

**Default Clock In**

1. Navigate to PC Clock.
2. Enter Badge number.
3. Click the Enter key.
4. Click the In key.
5. Click OK to confirm transaction.

**Default Clock Out**

1. Navigate to PC Clock.
2. Enter Badge number.
3. Click the Enter key.
4. Click the Out key.
5. Click **OK** to confirm transaction.

**Default Clock Out for Lunch**
1. Navigate to *PC Clock*.
2. Enter Badge number.
3. Click the **Enter** key.
4. Click the “4” key.
5. Click the **Enter** key.
6. Click **OK** to confirm transaction.

**Default Clock In from Lunch**
1. Navigate to *PC Clock*.
2. Enter Badge number.
3. Click the **Enter** key.
4. Click the “6” key.
5. Click **OK** to confirm transaction.

**Default Transfer Department**
1. Navigate to *PC Clock*.
2. Enter Badge number.
3. Click the **Enter** key.
4. Click the “0” key.
5. Enter the Department number
6. Click the **Enter** key.
7. Click **OK** to confirm transaction.
Chapter VII Employee Maintenance

This section covers the concepts and tasks for managing employee information. It includes information on adding employees, editing employee information, and managing employee schedules and assignments. It also contains links to the Timecard editing sections of this manual.

Configure Employee

The Configure Employee window contains all information relating to your employees, including contact, schedule, and time sheet data. All of the tabs in the window are described in this chapter, however, some of the tabs (such as the Timecard and Transactions) have additional tasks associated with them and have been given their own sections in this manual.

There are two ways to access the Configure Employee window: by menu or by tool button. Both methods are described below.

1. Click the Daily Operations menu, Employee or click the Maintenance button on the toolbar. The Configure Employee window will open.
Employee List

The **Employee List** window contains a list of the employees in the database. Sorting options are also available as described below:

![Employee List section](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Selected Employee</strong></td>
<td>Displays the employee name and number of the selected employee.</td>
</tr>
<tr>
<td><strong>Filters</strong></td>
<td></td>
</tr>
<tr>
<td>Show Division Selection</td>
<td>Select a Division to only view employees assigned to that Division.</td>
</tr>
<tr>
<td>Show Group Selection</td>
<td>Select a Group to only view employees assigned to that Group.</td>
</tr>
<tr>
<td>Show Salary Selection</td>
<td>Select ALL, YES or NO to view employees assigned to that option.</td>
</tr>
<tr>
<td>Show Fulltime Selection</td>
<td>Select ALL, YES or NO to view employees assigned to that option.</td>
</tr>
<tr>
<td>Show Permanent Selection</td>
<td>Select ALL, YES or NO to view employees assigned to that option.</td>
</tr>
<tr>
<td><strong>Previous button</strong></td>
<td>Press this button to go to an individual who is previous on the list.</td>
</tr>
<tr>
<td><strong>Find button</strong></td>
<td>Press this button to search for a name by code, last name or badge number.</td>
</tr>
<tr>
<td></td>
<td>Enter in the appropriate name, code or badge number when the dialog box appears.</td>
</tr>
<tr>
<td><strong>Next button</strong></td>
<td>Press this button to go to an individual who is next on the list.</td>
</tr>
<tr>
<td><strong>Number</strong></td>
<td>Select this option to have the employees sort by employee number.</td>
</tr>
</tbody>
</table>
Setting | Definition
--- | ---
Name | Select this option to have the employees sort by employee name.
Show Inactives | Select this option to have inactive employees viewable in the Employee List

Employee Timecard (Description) Tab

The Timecard tab displays the employee's timesheet information.

**NOTE:** Tasks associated with the Timecard, such as editing and adding punches, are covered in their own chapter. See *Timecard and Transaction Maintenance*, page 158.

1. Navigate to the Configure Employee window.
2. When you first enter the Configure Employee window, the Timecard tab is selected automatically and contains the following information:

![Configure Employee: Timecard tab](image)

**Figure 95: Configure Employee: Timecard tab**
### Setting Definition

#### Attendance Code
This field is **not** labeled. It displays a code to indicate an exception regarding the entry. The options are:

- **A**: Indicates a system-generated absence. This entry will display in red.
- **M**: Indicates a missing punch. This entry will display in purple.
- **I**: Indicates a work period In Progress. This entry will display in green.
- **D**: Indicates a default work entry was added when the employee missed a punch (as defined in the Policy associated with this employee.)
- **F**: Indicates that the entry was created when TA100 Pro forecasted the employee's hours. Time forecasting will display future time transactions (based on the employee’s current schedule) on screen and in reports.
- **S**: Indicates TA100 Pro has automatically created a Holiday entry. This entry will display in black.

#### Date
Displays the date of the entry.

#### Day
Displays a three-character code for the day of the week of the entry.

#### Cat
Displays the category associated with the entry (i.e., Work, Lunch, Break, Vacation, Sick, Absent, etc.)

#### Start
Displays the start time of the entry (i.e., the time at which the employee clocked in for the day, started lunch, etc.).

#### Stop
Displays the stop time of the entry (i.e., the time at which the employee clocked out for the day, ended lunch, etc.).

#### Department
By default, this field displays the Department the employee worked in. By clicking the **Department** button in the field header, you can choose to display the Job (if applicable). Each time you click the button; it will toggle back and forth between the Department and Job.

#### Reg.
Displays the number of hours at straight time the employee will be paid for this entry. This number is calculated using the **Start** and **Stop** times, adjusted according to the Rounding, Lunch and Break policies defined in the Shift Group assigned to this employee.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OT1</strong></td>
<td>Displays the number of hours at OT1 the employee will be paid for this entry, if any. This number is calculated using the <em>Start</em> and <em>Stop</em> times, adjusted according to the Rounding, Lunch and Break rules defined in the Shift Group assigned to this employee, as well as the Overtime rules defined in the Policy assigned to this employee.</td>
</tr>
<tr>
<td><strong>OT2</strong></td>
<td>Displays the number of hours at OT2 the employee will be paid for this entry, if any. This number is calculated using the <em>Start</em> and <em>Stop</em> times, adjusted according to the Rounding, Lunch and Break rules defined in the Shift Group assigned to this employee, as well as the Overtime rules defined in the Policy assigned to this employee.</td>
</tr>
<tr>
<td><strong>OT3</strong></td>
<td>Displays the number of hours at OT3 the employee will be paid for this entry, if any. This number is calculated using the <em>Start</em> and <em>Stop</em> times, adjusted according to the Rounding, Lunch and Break rules defined in the Shift Group assigned to this employee, as well as the Overtime rules defined in the Policy assigned to this employee.</td>
</tr>
<tr>
<td><strong>Unpaid</strong></td>
<td>Displays the number of unpaid hours for this entry, if any. Unpaid lunches and breaks will be reflected in this column, if appropriate.</td>
</tr>
<tr>
<td><strong>Dollars</strong></td>
<td>Displays the amount earned for this entry.</td>
</tr>
<tr>
<td><strong>S</strong></td>
<td>Displays a dot if a Supervisor has gone in to edit the punch.</td>
</tr>
<tr>
<td><strong>Auto Processing</strong></td>
<td>Check this box to <em>automatically</em> process time transactions whenever they are added or edited. Processing posts new and changed transactions to the database and allows them to be displayed on all reports. If this box is clear, you must click the <strong>Reprocess</strong> button each time you want to update employee transactions.</td>
</tr>
<tr>
<td><strong>Approve / Unapprove button</strong></td>
<td>Depress this button to approve or unapprove the selected pay period for the selected employee.</td>
</tr>
<tr>
<td><strong>Show Schedule</strong></td>
<td>Check this box to display the employee's scheduled start and stop times on screen. This can be used to help with editing when there is an absence or missing punch.</td>
</tr>
<tr>
<td><strong>Forecasting</strong></td>
<td>Check this box to generate projected time transactions. Time forecasting will display future time transactions (based on the employee's current schedule) on screen and in reports.</td>
</tr>
</tbody>
</table>
### Setting Definition

**Pay Periods back**
- Click the scroll arrow and choose the number of pay periods prior to the current one you wish to view.

**NOTE:** Although you may view prior pay periods, only editable pay periods may be changed. This is determined by the *Number of Editable Pay Periods* in *Configure Main Company* dialog box, and the *Block Prior Pay Periods* setting for the current user.

**Pay Period**
- Displays the starting date and the ending date of the currently selected pay period.

**Key**
- Displays the attendance codes which show in the first column.

**Date Column**
- Displays totals for each day in the pay period.

**Totals**
- The Totals column displays the totals for the currently selected pay period.

**Reprocess**
- Click this button to update employee transactions. Processing posts new and changed transactions to the database and allows them to be displayed on all reports.

**NOTE:** If *Auto Processing* is checked, you will not need to use this button each time a transaction is changed.

**Add Trans**
- Click this button to add a transaction (punch) for the employee. For more information on this feature, see *Adding and Editing Transactions*, page 160.

**Edit/Add Start**
- Click this button to add or edit a Starting transaction (such as a Clock In for day or Start Lunch) for the employee. For more information on this feature, see *Edit/Add Start*, page 164.

**Edit/Add Stop**
- Click this button to add or edit an Ending transaction (such as a Clock Out for day or End Lunch) for the employee. For more information on this feature, see *Edit/Add Stop*, page 165.

**Multiple Misc.**
- Click this button to add multiple or duplicated Miscellaneous transactions. This can be used to enter a vacation that lasts several days, etc. For more information on this feature, see *Multiple Miscellaneous*, page 165.

**From Schedule**
- Click this button to auto-fill a work day based on the employee's schedule. For more information on this feature, see *From Schedule*, page 167.

**Delete**
- Click this button to delete a transaction. For more information on this feature, see *Delete a Transaction*, page 167.
Employee Schedule Tab

The Schedule tab displays and allows you to edit the employee's schedule.

**NOTE:** Employees are not required to have a specific schedule, but without a schedule the following items will not work in the system:

- Rounding Rules
- Automatic Lunch and Break Deductions
- Exceptions

Configure Employee Schedules

1. Navigate to the Configure Employee window. See Configure Employee, page 117.

2. Click the Schedule tab to select. The tab contains the following information:

![Figure 96: Configure Employee: Schedule tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calendar</strong></td>
<td>The calendar will display three weeks at a time. The currently selected week will display in white, the previous and following week display in yellow. The current week will also have a field where you can edit the entire week. For more information on this feature, see the <em>Edit Entire Week</em> section. The Schedule calendar can display either work Shift information, or Job Costing information (which Job, Step, Operation, and Task the employee is scheduled to work). You can switch back and forth easily. For more information on this feature, see the <em>Schedule Details</em> section.</td>
</tr>
<tr>
<td>Setting</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date.</td>
</tr>
<tr>
<td>Shift</td>
<td>Displays the Shift selected for that particular day.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>Before a shift is assigned the system will default the shift assignment to a floater shift.</td>
</tr>
<tr>
<td>Department</td>
<td>Displays the Department number for that particular day.</td>
</tr>
<tr>
<td>Job</td>
<td>Displays the Job number for that particular day.</td>
</tr>
<tr>
<td>Work</td>
<td>Check this box to indicates whether or not the employee is scheduled to work that day, and how many paid hours are forecasted.</td>
</tr>
<tr>
<td>Override</td>
<td>Enter the start and stop schedule change time for rounding rule purposes only.</td>
</tr>
<tr>
<td>Template</td>
<td>Check this box to make this employee's schedule a template. This will enable you to copy this employee's schedule for other employees. For more information on this feature, see <em>Create an Employee Schedule Template</em>, page 124.</td>
</tr>
<tr>
<td>Update Back</td>
<td>Check this box to update previous weeks' schedule data. Also enter the date to which you wish to update. For more information on this feature, see <em>Assign or Edit an Employee Schedule</em>, page 124.</td>
</tr>
<tr>
<td>Update Forward</td>
<td>Check this box to update following weeks' schedule data. Also enter the date to which you wish to update. For more information on this feature, see <em>Assign or Edit an Employee Schedule</em>, page 124.</td>
</tr>
<tr>
<td>Copy Button</td>
<td>Click this button to copy a previously defined schedule template to this employee. For more information on this feature, see <em>Copy an Employee Schedule Template</em>, page 129.</td>
</tr>
<tr>
<td>Rotate Button</td>
<td>Click this button define a rotating schedule for this employee. For more information on this feature, see <em>Create a Rotating Schedule</em>, page 127.</td>
</tr>
<tr>
<td>Multiple Misc. Button</td>
<td>Click this button to add multiple or duplicated Miscellaneous transactions. This can be used to enter a vacation that lasts several days, see <em>Multiple Miscellaneous</em>, page 165.</td>
</tr>
<tr>
<td>Delete</td>
<td>This option opens the Delete Assignments screen. Here you can remove assignments, All Before a Date or All After a Date.</td>
</tr>
</tbody>
</table>

**Assign or Edit an Employee Schedule**

The processes for assigning a schedule for the first time and for editing the schedule assignment are the same. As part of this process, you will select a Shift, Department, Job, Step, Operation, and Task (as appropriate) for the employee.
1. Navigate to the Schedule tab of the Configure Employee window. See Configure Employee Schedules, page 123.

2. Navigate to the week you wish the schedule to start by using the scroll bar on the right side of the screen.

3. Click **Edit Entire Week** and/or **Shift** area on Sunday of the selected week.

4. If you clicked **Edit Entire Week**, the Schedules Detail for the Week dialog box will open.

5. If you clicked in the Shift area, the Schedule Details dialog box will open.

6. Highlight from the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Select a pre-defined Shift for this employee.</td>
</tr>
<tr>
<td>Start/Stop</td>
<td>Enter the start and stop schedule change time for rounding rule purposes only.</td>
</tr>
<tr>
<td>Graphic</td>
<td>Use the graphic timeline to define the start and stop schedule change time for rounding rule purposes only.</td>
</tr>
</tbody>
</table>
### Setting Definition

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Work</strong></td>
<td>Check this box to indicate whether or not the employee is scheduled to work that day, and how many paid hours are forecasted.</td>
</tr>
<tr>
<td><strong>Department</strong></td>
<td>Select a pre-defined Department for this employee. (Optional)</td>
</tr>
<tr>
<td><strong>Job</strong></td>
<td>Select a pre-defined Job for this employee. (Optional)</td>
</tr>
<tr>
<td><strong>Update Rest of Week</strong></td>
<td>Check this box to update the rest of the current week with these settings. (Recommended)</td>
</tr>
</tbody>
</table>

7. Click **OK** to commit the changes and return to the *Schedule* screen. The Shift and Department information selected will display.

   **NOTE:** TA100 Pro automatically keeps the schedule current for three months into the future, so you needn't update manually unless you are making a change that should apply to dates that have already been updated.

8. Check the **Work** box of each day of the week the employee is scheduled to work.

9. If you are editing the schedule and wish these changes to apply into the future, click the **Update Forward** box or **Update Back** box.

10. Click **Apply** to save the changes and update Forward (if selected for editing).

---

### Delete a Schedule

1. Navigate to the *Schedule* tab of the *Configure Employee* window. See *Configure Employee Schedules*, page 123.

2. Click the **Delete** button. You will be prompted:

   ![Delete Assignments](image)

   **Figure 99: Deletion Confirmation**

3. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Before Date</strong></td>
<td>Select this option to delete schedules leading up to a certain date.</td>
</tr>
<tr>
<td><strong>All After Date</strong></td>
<td>Select this option to delete schedules occurring after a certain date.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Enter the date to consider when deleting the schedules.</td>
</tr>
</tbody>
</table>

4. Click **OK**. You will be prompted again:
5. Click **OK** to confirm the deletion.

**Create a Rotating Schedule**

Rotating schedules allow you to accommodate employees who work schedules that have a pattern other than a weekly cycle. You can specify the number of days in the rotation and what time period the rotation begins.

**Rotating Schedule Example**

Jane Doe works every other Saturday. She happens to work this coming Saturday, and will be off the next Saturday.

To configure this you would modify her schedule so that Work is checked for this Saturday, but not the next Saturday. The Start Date for the Rotation would be the beginning of the current week, and the number of days in the cycle would be 14.

1. Navigate to the *Schedule* tab of the *Configure Employee* window. See *Configure Employee Schedules*, page 123.

2. Click the **Rotate** button. The *Apply Rotating Schedule* dialog box will open.

3. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
</table>

*Figure 100: Apply Rotating Schedule*
### Setting Definition

**Activate a rotating schedule for this Employee**
- Check this box to enable a rotating schedule for the selected employee.
- TIP: You can "remove" a rotating schedule that has already been set simply by un-checking this box.

**Define Rotation**
- These settings define the pattern for rotation.

**Start Date**
- Enter the date TA100 Pro should start with to determine the rotation pattern.

**Days in Rotation**
- Enter the number of days in the rotation pattern.

**Apply Rotation**
- These settings determine when the rotating schedule will take effect.

**Start Date**
- Enter the date on which the rotating schedule should take effect.

4. Click **OK** to commit the changes and return to the *Schedule* screen.

### Create an Employee Schedule Template

An employee's schedule can be saved as template so that it can be copied to other employees. This is a convenient way of duplicating an unusual work pattern or rotation so that you don't have to reinvent the wheel each time.

**NOTE:** However, any changes that are made to the schedule that was copied will apply to all schedules that are base on that template.

The Copy Schedule feature allows you to copy a previously defined Template. This step is the first step in copying a schedule.

1. Navigate to the *Schedule* tab of the *Configure Employee* window. See *Configure Employee Schedules*, page 123.

2. Check the **Template** box. The *Define Template* dialog box will open.

![Define Template](Figure 101: Employee Schedule Template)

3. Check the **Use Employee as template** box.

4. Enter a name for this template. Try to make it as descriptive as possible and avoid using employee names, as it may be difficult to remember what type of schedule the employee has.

5. Click **OK** to commit the changes and return to the *Schedule* screen.
Copy an Employee Schedule Template

The Copy Schedule feature allows you to copy a previously defined Employee Schedule Template. See Create an Employee Schedule Template.

1. Navigate to the Schedule tab of the Configure Employee window. See Configure Employee Schedules, page 123.

2. Click the Copy button. The Schedule Copy Details dialog box will open.

3. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>Displays the code of the available Template.</td>
</tr>
<tr>
<td><strong>Template Name</strong></td>
<td>Displays the name of the available Template.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Click this button to display the details of the selected Template.</td>
</tr>
<tr>
<td><strong>What to Copy</strong></td>
<td>These settings define what will be copied.</td>
</tr>
<tr>
<td><strong>Shift Info</strong></td>
<td>Check this box to copy scheduled starting and stopping times.</td>
</tr>
<tr>
<td><strong>Work</strong></td>
<td>Check this box to copy which days are selected for Work.</td>
</tr>
<tr>
<td><strong>Department</strong></td>
<td>Check this box to copy the Department assignments.</td>
</tr>
<tr>
<td><strong>Job</strong></td>
<td>Check this box to copy the Job assignments.</td>
</tr>
<tr>
<td><strong>Define Copy</strong></td>
<td>These settings define when the template will be copied.</td>
</tr>
<tr>
<td>Setting</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy From</td>
<td>These settings define the date range that will be copied from.</td>
</tr>
<tr>
<td>Starting On</td>
<td>Enter the date from which you wish to copy forward.</td>
</tr>
<tr>
<td>Copy forever</td>
<td>Select this option to copy the selected template from the Starting on point forward forever.</td>
</tr>
<tr>
<td>Stop On</td>
<td>Select the option to copy only up to a certain date. Enter the date in the space provided.</td>
</tr>
<tr>
<td>Copy to</td>
<td>These settings define the date range that will be copied to.</td>
</tr>
<tr>
<td>Starting on hire date</td>
<td>Select this option to &quot;paste&quot; the copied schedule starting from the employee's hire date forward.</td>
</tr>
<tr>
<td>Starting on date</td>
<td>Select this option to &quot;paste&quot; the copied schedule from a user-defined date forward. Enter the date in the space provided.</td>
</tr>
</tbody>
</table>

4. Click **OK** to commit the changes and return to the *Schedule* screen.
Employee Transactions Tab

The Transaction tab displays the individual punches for the employee

NOTE: Tasks associated with the Transactions tab, such as editing and adding punches, are covered in their own section. See Timecard and Transaction Maintenance, page 158.

Description

1. Navigate to the Configure Employee window. See Configure Employee, page 117.

2. Click the Transactions tab to display the following information:

![Figure 103: Configure Employee: Transaction tab]

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Displays the day of the transaction.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date of the transaction.</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the actual time of the transaction.</td>
</tr>
<tr>
<td>Key</td>
<td>Displays the time clock function key pressed to generate the transaction. (i.e., * for Clock In for day, etc.)</td>
</tr>
<tr>
<td>Prompt</td>
<td>Displays the function prompt for the transaction.</td>
</tr>
<tr>
<td>Clock</td>
<td>Displays the number of the clock at which the transaction was recorded.</td>
</tr>
<tr>
<td>NOTE: No clock number will display if the transaction was entered by a supervisor through the TA100 Pro software.</td>
<td></td>
</tr>
<tr>
<td>Badge</td>
<td>Displays the employee’s badge number used for this transaction.</td>
</tr>
</tbody>
</table>
Setting | Definition
---|---
**Supervisor** | This field shows audit trail information, and displays the name and number of the supervisor who edited this transaction, if any.

**Prompt** | Displays the function prompt for the transaction.

**Input** | Displays any additional data entered with the transaction, such as a Department number, the number of pieces produced, etc.

**Add/Edit/Delete** | For more information on adding, editing and deleting transactions, see *Adding and Editing Transactions*, page 160, and *Deleting Transactions*, page 167.

Employee Status Tab

The Status tab displays the employee's current work status with the company

Configure Employee Status

1. Navigate to the *Configure Employee* window. See *Configure Employee*, page 117.

2. Click the *Status* tab to display the following information:

![Figure 104: Configure Employee: Status tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date</strong></td>
<td>Enter the effective date of the status.</td>
</tr>
<tr>
<td><strong>Policies</strong></td>
<td>Select the Policy to be assigned to this employee.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Select whether the employee is <em>Active</em> or <em>Inactive</em> as of the effective date.</td>
</tr>
</tbody>
</table>
Setting Definition

**Fulltime** Select whether the employee is **Full Time** or **Part Time** as of the effective date.

**Permanent** Select whether the employee is a **Permanent** or **Temporary** employee as of the effective date.

Add Employee Status

When an employee changes Status, it is recommended that you add a new Status entry rather than editing the existing Status. This enables you to keep a history of Status changes throughout the employee’s work history.

1. Navigate to the Status tab of the Configure Employee window.
2. Click the Add button to add a new Status. The Status Maintenance dialog box will open:

```
Figure 105: Adding a new Status
```

3. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date</strong></td>
<td>Enter the date that this Status change becomes effective.</td>
</tr>
<tr>
<td><strong>Active/Inactive</strong></td>
<td>Choose whether the employee is Active or Inactive as of the selected date.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Indicates that the employee is currently working for the company.</td>
</tr>
<tr>
<td><strong>Inactive</strong></td>
<td>Indicates that the employee is not currently working for the company, perhaps because of a leave of absence or termination.</td>
</tr>
<tr>
<td><strong>Full Time/Part Time</strong></td>
<td>Choose whether the employee is <strong>Full Time</strong> or <strong>Part Time</strong> as of the selected date.</td>
</tr>
<tr>
<td><strong>Permanent/Temporary</strong></td>
<td>Choose whether the employee is <strong>Permanent</strong> or <strong>Temporary</strong> as of the selected date.</td>
</tr>
<tr>
<td><strong>Policies</strong></td>
<td>Select the Policy that will apply to this employee as of the effective date.</td>
</tr>
</tbody>
</table>

4. Click **OK** to commit the changes and return to the Status screen. The new Status will be added to the list.
Edit Employee Status

If you choose to edit the Employee's Status, the changes will be retroactive to the effective date of the original status entry. Because of this, when an employee changes Status, it is recommended that you add a new Status entry rather than editing the existing Status. This enables you to keep a history of Status changes throughout the employee's work history.

2. Highlight the Status entry you wish to edit.
3. Click the Edit button. The Status Maintenance screen will become available for you to edit.
4. Edit the settings as described in the Add Employee Status section.
5. Click OK to commit the changes and return to the Status screen.

Delete Employee Status

You may wish to delete a Status entry that has been added in error. One Status entry must always exist, thus you will not be able to delete if there is only one Status entry.

2. Highlight the Status you wish to delete.
3. Click the Delete button. You will be prompted:
   
   ![Confirmation dialog box]

   *Figure 106: Deletion Confirmation*

4. Click OK to confirm the deletion and return to the Status screen.
Employee Benefits Tab

The Benefits tab reflects the selected employee's current benefit balances. The information and options on this tab will be slightly different if you have purchased Benefit Accruals than with Benefit Entitlement. Both options are described below: Benefit Entitlement is first, followed by Benefit Accruals.

Benefit Entitlement: Configure

1. Navigate to the Configure Employee window. See Configure Employee, page 117.

2. Click the Benefits tab to display the following information:

![Figure 107: Configure Employee: Benefits tab]

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Date</td>
<td>Displays the employee's Fiscal Date (set on the Detail tab), for information purposes.</td>
</tr>
<tr>
<td>Hire Date</td>
<td>Displays the employee's Hire Date (set on the Detail tab), for information purposes.</td>
</tr>
<tr>
<td>Days of Service</td>
<td>Displays the number of Days of Service the employee has, for information purposes.</td>
</tr>
<tr>
<td>Code</td>
<td>Displays the category code of the benefit (i.e., VAC, SICK, etc.).</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the category name of the benefit (i.e., Vacation, Sick, etc.)</td>
</tr>
<tr>
<td>Given</td>
<td>Displays the number of hours the employee has been granted through Benefit Entitlement.</td>
</tr>
<tr>
<td>Taken</td>
<td>Displays the number of hours of the benefit the employee has already taken. This number is calculated from the Miscellaneous entries on the employee's time card.</td>
</tr>
</tbody>
</table>
**Setting** | **Definition**  
--- | ---  
*Pending* | Displays the number of hours of the benefit the employee will take in the future (within the current pay period).  
*Left* | Displays the number of hours left. This is calculated by subtracting the *Taken* and *Pending* amounts from the *Allowed*, as follows:  
\[ \text{Left} = \text{Given} - (\text{Taken} + \text{Pending}) \]  
*Count* | Displays the number of individual days on which the benefit time was taken or is pending.  
*Details* | Click this button to display the individual entitlement transactions for this employee.

**Benefit Entitlement: Employee Benefit Details**

1. Navigate to the *Benefits* tab of the *Configure Employee* window.  
2. Highlight the benefit Category you wish to view.  
3. Click the *Details* button. The *Benefit Details* screen for the selected Category will open.

4. The *Benefit Details* dialog box contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Day</em></td>
<td>Displays the day on which the time was taken.</td>
</tr>
<tr>
<td><em>Date</em></td>
<td>Displays the date on which the time was taken.</td>
</tr>
<tr>
<td><em>Time</em></td>
<td>Displays the time at which the time was taken.</td>
</tr>
<tr>
<td><em>Amount</em></td>
<td>Displays the number of hours taken.</td>
</tr>
<tr>
<td><em>Archived</em></td>
<td>Indicates whether these transactions are in a data set that has already been archived. (For more information on Archiving, see <em>Archive</em>, page 258).</td>
</tr>
<tr>
<td><em>Category</em></td>
<td>Displays the category of time taken.</td>
</tr>
</tbody>
</table>
Benefit Entitlement: Grant Benefit Time

With Benefit Entitlement, you manually enter the amount of hours given for each Benefit Category. This is a one-time entry.

1. Navigate to the Benefits tab of the Configure Employee window.
2. Highlight the benefit Category you wish to grant.
3. Click the Details button. The Benefit Details screen for the selected Category will open.

4. Enter the amount of time you wish to grant in the Amount Allowed box.
5. Click OK to commit the change and return to the Benefits screen.

Benefit Entitlement: Delete a Detail

1. Navigate to the Benefits tab of the Configure Employee window.
2. Click the Details button. The Benefit Details screen will display.
3. Highlight the item you wish to delete.
4. Click the Delete button. You will be prompted:

5. Click OK to confirm the deletion.
6. Click OK to confirm the Archive message.
7. Click Close to return to the Benefits screen.
Benefit Accruals: Configure

1. Navigate to the Configure Employee window. See Configure Employee, page 117.

2. Click the Benefits tab to display the following information:

![Configure Employee: Benefits tab](image)

**Figure 111: Configure Employee: Benefits tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Date</td>
<td>Displays the employee’s Fiscal Date (set on the Detail tab), for information purposes.</td>
</tr>
<tr>
<td>Hire Date</td>
<td>Displays the employee’s Hire Date (set on the Detail tab), for information purposes.</td>
</tr>
<tr>
<td>Days of Service</td>
<td>Displays the number of Days of Service the employee has, for information purposes.</td>
</tr>
<tr>
<td>Code</td>
<td>Displays the category code of the benefit (i.e., VAC, SICK, etc.).</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the category name of the benefit (i.e., Vacation, Sick, etc.).</td>
</tr>
<tr>
<td>Allowed</td>
<td>Displays the number of hours the employee has either been granted or earned. This number is based on the Benefit Accrual settings (if applicable) or can be manually edited to grant Benefit Entitlement.</td>
</tr>
<tr>
<td>Taken</td>
<td>Displays the number of hours of the benefit the employee has already taken. This number is calculated from the Miscellaneous entries on the employee’s time card.</td>
</tr>
<tr>
<td>Pending</td>
<td>Displays the number of hours of the benefit the employee will take in the future (within the current pay period).</td>
</tr>
<tr>
<td>Left</td>
<td>Displays the number of hours left. This is calculated by subtracting the Taken and Pending amounts from the Allowed, as follows: Left = Allowed - (Taken + Pending)</td>
</tr>
</tbody>
</table>
Setting | Definition
---|---
Count | Displays the number of individual days on which the benefit time was taken or is pending.
Carry Date | Displays the date on which the benefits will roll over, also known as the *Reference Date* or *Reset Date*.
Update | Click this button to update the benefit calculations to the current day for this employee.
Details | Click this button to display the individual accrual or entitlement transactions for this employee. For more information, see *Benefit Accruals*, page 103.

**Benefit Accruals: Update Employee Benefits**

TA100 Pro will automatically update employee benefit accruals to the current day. However, if you make a change to the Benefit Accrual rule assigned to the employee, or change the settings of the rule, you may wish to “force” TA100 Pro to update.

2. Click the Update button. This employee's benefits will update and the screen will refresh.

**Benefit Accruals: Employee Benefit Details**

It is possible to view a detailed schedule of how much benefit time the employee has earned and when it was posted.

2. Click the Details button. The Benefit Details screen will display.

*Figure 112: Benefit Details*

3. The Benefit Details dialog box contains the following information:
### Setting Definition

- **Day** Displays the day on which the time was posted or taken.
- **Date** Displays the date on which the time was posted or taken.
- **Time** Displays the time at which the time was posted or taken.
- **Amount** Displays the number of hours posted or taken.
- **Balance** Displays the running balance after the transaction.
- **Category** Displays the Category of the benefit time.
- **Type** Displays what type of benefit transaction it was.
  - **Bonus Hours** indicates time earned or accrued.
  - **Misc. Entry** Indicates time taken.
  - **Hours Adj.** Indicates a manual adjustment.
  - **Balance Adj.** Indicates a Balance Adjustment
- ** Archived** Indicates whether these transactions are in a data set that has already been archived. (For more information on Archiving, see *Archive*, page 258).
  - **Show Accrued Adjustments** Check this box to display the adjustments that have been made to accrued Benefits.
- **Manual Adj. Button** Click this button to make a manual adjustment. For more information see *Manual Benefit Adjustment*, page 140.

4. Click **OK** to close the *Benefit Details* screen.

### Benefit Accruals: Manual Benefit Adjustment

It is possible to make manual adjustments to an employee’s Benefit Entitlement. These adjustments can be additions or deductions to the employee’s available benefits. You can also use this feature to zero out the employee’s balance, called a balance adjustment.

1. Navigate to the *Benefits* tab of the *Configure Employee* window. See *Benefit Accruals: Configure*, page 138.

2. Click the **Details** button. The *Benefit Details* screen will display.

4. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Enter the Date on which the adjustment should be posted.</td>
</tr>
<tr>
<td>Time</td>
<td>Enter the time at which the adjustment should be posted.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of adjustment to be made.</td>
</tr>
<tr>
<td></td>
<td><strong>Given</strong>: Grants the employee the number of hours entered in the Amount field.</td>
</tr>
<tr>
<td></td>
<td><strong>Balance</strong>: Adjusts the employee’s Allowed field value to cause the current Left balance to reflect the number of hours entered in the Amount field. For example, if the Employee had taken 40 hours already and you wanted their balance to reflect 40 hours left, TA100 Pro would adjust the Allowed to 80 (80 Allowed – 40 Taken = 40 Left).</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount of the adjustment. This number can be positive (for an addition) or negative (for a deduction).</td>
</tr>
</tbody>
</table>

5. Click **OK** to commit the changes and return to the *Benefit Details* screen.

6. Click **Close** to return to the *Benefits* screen.

**Benefits Accrual: Delete a Manual Adjustment**

1. Navigate to the *Benefits* tab of the *Configure Employee* window. See *Benefit Accruals: Configure*, page 138.

2. Click the **Details** button. The *Benefit Details* screen will display.

3. Highlight the Adjustment you wish to delete.

4. Click the **Delete** button. You will be prompted:
5. Click **OK** to confirm the deletion.

6. Click **Close** to return to the *Benefits* screen.

**Employee Messages Tab**

The *Messages* tab allows you to create a customized message that will display when this employee punches at the clock.

**Configure**

1. Navigate to the *Configure Employee* window. See *Configure Employee*, page 117.

2. Click the *Messages* tab to display the following information:

![Configure Employee: Messages tab](image)

**Setting** | **Definition**
--- | ---
*Clock Id* | Displays the number of the clock at which this message will display.

*Message* | Displays the message. The message can be up to 20 characters and the default is the employee's first initial and last name.

*All Clocks Button* | This opens the All Clocks dialog box. Here you can create a message, and assign it to all available clocks.
Add a Message

You can send a message to each clock individually, or to all clocks that the employee uses.

To a Single Clock

1. Navigate to the Configure Employee window. See Configure Employee, page 117.
2. Click the Add button to add a new message to send to an individual clock. The Message Assignment dialog box will open.

   ![Figure 116: Adding a new Message]

3. Select the clock to which this message should be sent.
4. Enter the message you wish to send. Up to 20 characters may be entered. Or check the Default message to Employee name to send the employee’s First Initial and Last Name.
5. Click OK to commit the changes and return to the Messages screen.

To All Clocks

1. Navigate to the Configure Employee window. See Configure Employee, page 117.
2. Click the All Clocks button to add a new message to all clocks this employee uses. The Message Assignment dialog box will open.

   ![Figure 117: Add a Message to All Clocks]

3. Enter the message you wish to send. Up to 20 characters may be entered. Or check the Default message to Employee name to send the employee’s First Initial and Last Name.
4. Click OK to commit the changes and return to the Messages screen.
**Edit a Message**

1. Navigate to the *Configure Employee* window. See *Configure Employee*, page 117.
2. Highlight the Message you wish to edit.
3. Click the *Edit* button.
4. Edit the settings as described in the *Add a Message* section.
5. Click *OK* to commit the changes and return to the *Messages* screen.

**Delete a Message**

1. Navigate to the *Configure Employee* window. See *Configure Employee*, page 117.
2. Highlight the Message you wish to delete.
3. Click the *Delete* button. You will be prompted:

   ![Confirmation dialog box](image)

   *Figure 118: Deletion Confirmation*

4. Click *OK* to confirm the deletion.

**Employee Wages**

The *Wages* tab specifies the FLSA status (exempt or non-exempt) and pay rate(s) for the employee. For non-exempt employees, wages can either be Global or associated with the Department or Job on which the employee works. All options are described in the following sections.

**Configure Employee Wages**

1. Navigate to the *Configure Employee* window. See *Configure Employee*, page 117.
2. Click the *Wages* tab to display the following information:
Figure 119: Configure Employee: Wages tab

### Setting Definition

#### Non-Exempt
Check this option to indicate that the employee is Non-Exempt.

#### Use Global Wage
Check this option to assign the employee a fixed standard wage regardless of which department or job he/she works for. If un-checked the employee will earn a different wage based on the department or job they work in.

For more information see the Department or Job buttons in this section.

#### Department
Click this button to set a wage that applies whenever the employee works for a particular Department. This can be used to pay different rates when the employee performs different functions.

#### Job
Click this button to set a wage that applies whenever the employee works for a particular Job. This can be used to pay different rates when the employee performs different functions.

#### Exempt
Check this option to indicate the employee is Exempt.

#### Report Hours From
TA100 Pro can report exempt employees' hours either from actual punches or from their schedule, regardless of their punches.

Check **Actual** to have TA100 Pro report the hours as they are punched at the clock.

Check **Schedule** to have TA100 Pro report hours from the employee's schedule. The Attendance Clocking settings will become available when this option is checked and need to be configured.
### Setting Definition

#### Attendance

These settings become available when the Report Hours From Schedule option is checked.

- **Check Paired Punching** to indicate that the employee should punch In and Out, but TA100 Pro will ignore the actual times of the punches and report the scheduled times and duration.
- **Check In Only** to indicate that the employee only needs to punch In each day and TA100 Pro will report the scheduled times and duration.
- **Check None** to indicate that TA100 Pro should automatically report the scheduled times and duration without the employee having to punch at all.

#### Pay Overtime

Check this option to make the employee eligible for overtime, based on the Policy to which the employee is assigned.

### Add a Global Wage

1. Navigate to the Wages tab of the Configure Employee window. See **Configure Employee Wages**, page 144.
2. Select the **Non-Exempt** option.
3. Check the **Use Global Wage** option.
4. Click the **Add** button to add a new Global Wage. The *Wage Details* dialog box will open.
5. Enter the date on which this wage takes effect.
6. Enter the amount of the hourly wage.
7. Click **OK** to commit the changes and return to the Wages screen.

### Edit a Global Wage

1. Navigate to the Wages tab of the Configure Employee window. See **Configure Employee Wages**, page 144.
2. Highlight the wage you wish to edit.
3. Click the **Edit** button. The *Wage Details* dialog box will open.
4. Enter the amount of the hourly wage.
5. Click OK to commit the changes and return to the Wages screen.

Delete a Global Wage

1. Navigate to the Wages tab of the Configure Employee window. See Configure Employee Wages, page 144.
2. Highlight the wage you wish to delete.
3. Click the Delete button. You will be prompted:

   ![Figure 121: Deletion Confirmation]

   Are you sure you want to delete?

   OK  Cancel

4. Click OK to confirm the deletion.

Add an Employee Level Wage

Employee Level Wages specify the wage the employee makes when working for a specific Department, Job, Step, Operation or Task. In this section, Level refers to the Department, Job, Step, Operation, or Task, as appropriate. The procedure is the same regardless of which level you are defining, thus they are all described together.

1. Navigate to the Wages tab of the Configure Employee window. See Configure Employee Wages, page 144.
2. Select the Non-Exempt option.
3. Click the Department or Job button, depending upon choice. The Level Wage Details dialog box will open.

   ![Figure 122: Adding a new Level Wage]

4. The Level Wage Details dialog box contains the following information:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item</strong></td>
<td>This field will be pre-populated with the Departments and Jobs defined in the system. Select the item you wish to configure.</td>
</tr>
<tr>
<td><strong>Use Hourly Wage</strong></td>
<td>The value for this option is defined in the Configure Department or Job dialog box. It will be checked and will reflect the pre-defined wage if the <strong>Use Hourly Wage</strong> setting is checked in the Department or Job dialog box for this item.</td>
</tr>
<tr>
<td><strong>Use Piece Rate</strong></td>
<td>The value for this option is defined in the Configure Department or Job dialog box. It will be checked and will reflect the pre-defined wage if the <strong>Use Piece Rate</strong> setting is checked in the Department or Job dialog box for this item.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>The calendar is used both to enter the wage amount and to indicate the effective date of the wage. Wages will auto fill from the date entered forward. Always enter the wage on the date, which you wish it to take effect.</td>
</tr>
<tr>
<td><strong>Hourly Wage</strong></td>
<td>The <strong>Hourly</strong> amount field is the top field in the calendar. Enter the wage on the date, which it becomes effective.</td>
</tr>
<tr>
<td><strong>Piece Rate Wage</strong></td>
<td>The <strong>Piece Rate</strong> amount field is the lower field in the calendar. Enter the wage on the date on which it becomes effective.</td>
</tr>
</tbody>
</table>

5. Click **Close** to commit the changes and return to the **Wages** screen.

**Edit an Employee Level Wage**

1. Navigate to the **Wages** tab of the **Configure Employee** window. See **Configure Employee Wages**, page 144.
2. Select the **Non-Exempt** option.
3. Click the **Department or Job** button, depending upon choice. The Level Wage Details dialog box will open.
4. Edit the settings as described in the **Add an Employee Level Wage** section.
5. Click **Close** to commit the changes and return to the **Wages** screen.

**Employee Badges Tab**

The **Badges** dialog box is used to assign the employee's badge number.

**Configure Employee Badges**

1. Navigate to the **Configure Employee** window. See **Configure Employee**, page 117.
2. Click the **Badges** tab to display the following information:
Figure 123: Employee Maintenance: Badges tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number</strong></td>
<td>Displays the badge number assigned to the employee.</td>
</tr>
<tr>
<td><strong>Valid</strong></td>
<td>Indicates whether or not the badge is valid and can be used by this employee. When an employee is assigned another badge, make the original badge invalid so that this employee cannot use it any longer.</td>
</tr>
</tbody>
</table>

**Add a Badge**


2. Click the Add button to add a new Badge. The Assign Badge dialog box will open.

![Assign Badge](image)

Figure 124: Adding a new Badge

3. Enter the Badge number you wish to assign to this employee and press **Tab**.

4. Check the **Valid** box to indicate this badge is in use.

5. Click **OK** to commit the changes and return to the Badges screen.
Edit a Badge

It is possible to edit a Badge in order to make it Invalid for this employee (cannot be used by this employee to punch). The badge number cannot be changed. If you need to change a badge number, it is best to make the old badge number inactive or delete it, and add a new one.

2. Click the Edit button. The Assign Badge dialog box will open.
3. Uncheck the Valid box to make the Badge invalid.
4. Click OK to commit the changes and return to the Badges screen.

Delete a Badge

2. Highlight the Badge you wish to delete.
3. Click the Delete button. You will be prompted:

   ![Confirmation Window]

   Are you sure you want to delete?

   OK  Cancel

   Figure 125: Deletion Confirmation

4. Click OK to confirm the deletion and return to the Badges screen.

Employee Clocks Tab

The Clocks tab is used to assign Hand Readers and TA7000 clocks to the employees. This is necessary because the Hand Reader clocks take measurements of an employee’s hand and the TA7000 clocks can be used as fingerprint clocks. Each time the employee punches, the clocks compare the employee’s hand and/or fingerprint to the existing template. Employee information, hand templates and fingerprints are stored in the clocks. For this reason, employees must be assigned to a clock so their name and template will be downloaded to the correct clock.

Configure Hand Readers

1. Navigate to the Configure Employee window. See Configure Employee, page 117.
2. Click the Clocks tab to display the following information:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clock ID</strong></td>
<td>Displays the Clock ID assigned to each reader.</td>
</tr>
<tr>
<td><strong>Badge</strong></td>
<td>Displays employee badge number.</td>
</tr>
<tr>
<td><strong>Time Zone</strong></td>
<td>Select the Time Zone (defined on the previous tab) that applies to this employee.</td>
</tr>
<tr>
<td><strong>Reject</strong></td>
<td>The reject threshold indicates how closely the hand has to match the original scanned hand template. The lower the number, the more exact the match needs to be.</td>
</tr>
<tr>
<td><strong>Authority</strong></td>
<td>The Authority Level defines which clock menus employee can view or use at the clock. 0 is the lowest (employee) and default, 5 is the highest and allows complete at-the-clock setup (supervisor).</td>
</tr>
<tr>
<td><strong>Templates on file for Badge Numbers</strong></td>
<td>Displays if the employee has a hand template saved.</td>
</tr>
<tr>
<td><strong>Retrieve Templates From</strong></td>
<td>Enter the specific hand reader for individual employee template retrieval.</td>
</tr>
<tr>
<td><strong>All Clocks</strong></td>
<td>This opens the All Clocks dialog box. Here you can assign an employee to all hand readers.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Click this button to select hand readers individually.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Edit the settings assigned to the employee.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Delete the employee hand reader assignment.</td>
</tr>
</tbody>
</table>
Configure TA7000

1. Navigate to the Configure Employee window. See Configure Employee, page 117.

2. Click the Clocks tab, then click the TA7000 tab to display the following information:

![Figure 127: Configure Employee: Clocks tab]

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clock ID</strong></td>
<td>Displays the Clock ID assigned to each clock.</td>
</tr>
<tr>
<td><strong>Badge</strong></td>
<td>Displays employee badge number.</td>
</tr>
<tr>
<td><strong>Verification</strong></td>
<td>Displays the verification level, which defines the false read threshold.</td>
</tr>
<tr>
<td><strong>Authority</strong></td>
<td>Displays the Authority Level, which defines the clock menus employees can view or use at the clock. The following options are available: Employee, Supervisor or Configuration.</td>
</tr>
<tr>
<td><strong>Templates on file for Badge Numbers</strong></td>
<td>Displays if the employee has a fingerprint template saved.</td>
</tr>
<tr>
<td><strong>Retrieve Templates From</strong></td>
<td>Enter the specific clock for individual employee fingerprint template retrieval.</td>
</tr>
<tr>
<td><strong>All Clocks</strong></td>
<td>This opens the All Clocks dialog box. Here you can assign an employee to all TA7000 clocks.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Click this button to select TA7000 clocks individually.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Edit the settings assigned to the employee.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Delete the employee hand reader assignment.</td>
</tr>
</tbody>
</table>
Employee Details Tab

The Details tab manages the employee's personnel settings. New employees are also added from this tab.

Configure Employee Details

1. Navigate to the Configure Employee window. See Configure Employee, page 117.

2. Click the Details tab to display the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
</table>
| **Number**    | This is a required field. Enter a code (from 2 to 10 characters in length) to identify the employee. The code's maximum length and type (numeric or alphanumeric) are defined in the System Defaults dialog box in Company Setup. Numeric fields are zero filled.  
  **NOTE:** Once saved, the employee code cannot be modified, except through Utilities. |
<p>| <strong>Social Security</strong> | Enter the employee's social security number.                                         |
| <strong>Birth date</strong> | Enter the employee's birth date (if desired).                                        |
| <strong>Last Name</strong>  | Enter the employee's last name.                                                    |
| <strong>First Name</strong> | Enter the employee's first name.                                                    |
| <strong>Middle Initial</strong> | Enter the employee's middle initial.                                            |
| <strong>Address</strong>    | Enter the employee's address. Two lines are available.                            |
| <strong>City</strong>       | Enter the employee's City.                                                        |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zip</td>
<td>Enter the employee's Zip code.</td>
</tr>
<tr>
<td>State</td>
<td>Enter the employee's State.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the employee's phone number.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Enter the employee's email address.</td>
</tr>
<tr>
<td>Hire Date</td>
<td>Enter the employee's hire date.</td>
</tr>
<tr>
<td>Accrue this month</td>
<td>Check this box if benefits should accrue during the first month of employment.</td>
</tr>
<tr>
<td>Fiscal Date</td>
<td>Enter the date on which this employee's or your company's fiscal year starts. This date can be used as the Reference Date on which benefits carry over.</td>
</tr>
<tr>
<td>Use Alternative Hire Date for benefits</td>
<td>Use this date to override the Hire Date field as the date an employee’s benefits should begin.</td>
</tr>
<tr>
<td>User-Defined fields</td>
<td>There are six user-defined fields. Enter information as desired. For more information see Configure Main Company, page 28.</td>
</tr>
<tr>
<td>Division</td>
<td>Select the pre-defined Division to which the employee belongs.</td>
</tr>
<tr>
<td>Group</td>
<td>Select the pre-defined Group to which the employee belongs.</td>
</tr>
<tr>
<td>Holiday group</td>
<td>Select the pre-defined Holiday Group to which the employee belongs. If Holiday Groups were not created you may leave at the default listing of All Holidays.</td>
</tr>
<tr>
<td>Accrual Rule</td>
<td>Select the pre-defined Benefits Accrual rule that applies to this employee.</td>
</tr>
<tr>
<td>Use PC Clock</td>
<td>Check this block to allow permissions for the PC Clock</td>
</tr>
</tbody>
</table>

**Add an Employee**

TA100 Pro uses an Add Employee wizard to walk you through the steps of adding a new employee. Once you have completed the Detail screen, additional screens will open, one after another, until all the settings for the employee are complete.

2. Click the Add button to add a new Employee. The Detail tab will become available.
3. Fill in the settings as described in the Configure Employees Details section.

4. Click OK to commit the changes and continue to the next screen.

5. The Status dialog box will open. See Employee Status, page 132.

6. When all settings are complete, click Close to continue to the next screen.

7. The Assignment Start Date dialog box will open. Choose the date on which you want the employee's schedule to start.

![Assignment Start Date](image)

Figure 129: Assignment Start Date

8. When all settings are complete, click the Continue button to advance to the next screen.

9. The Schedule dialog box will open. See Employee Schedule, page 123.

10. When all settings are complete, click the OK button to advance to the next screen.

11. The Message Assignment dialog box will open. See Employee Messages, page 142.

12. When all settings are complete, click the Close button to advance to the next screen.

13. The Wage Assignment dialog box will open. See Employee Wages, page 144.

14. When all settings are complete, click the OK button to advance to the next screen.

15. The Badge Assignment dialog box will open. See Employee Badges, page 148.

16. When all settings are complete, click the Close button to advance to the next screen.

17. The Clocks dialog box will open. See Employee Clocks, page 150.

18. When all settings are complete, click the OK button to advance to the next screen.

19. You will be returned to the Detail tab of the Configure Employee window.

20. Click Close to exit the Configure Employee dialog box.

**Edit an Employee**

1. Navigate to the Detail tab of the Configure Employee window.

2. Highlight the Employee you wish to edit from the list at the side of the screen.

3. Click the Edit button. The Detail screen will become available for you to edit the selected Employee.

4. Edit the settings as described in the Configure Employee section.
5. Click **OK** to commit the changes and return to the *Configure Employee* screen.

6. Click **Close** to exit the *Configure Employee* dialog box.
Delete an Employee

Deleting an employee deletes all of the data relating to that employee throughout the database, including time records.

**NOTE:** This can cause inaccurate reporting. You cannot undo a delete.

1. Navigate to the *Detail* tab of the *Configure Employee* window.
2. Highlight the Employee you wish to delete from the list at the side of the screen.
3. Click the **Delete** button. You will be prompted:

![Confirmation dialog box](image)

*Figure 130: Deletion Confirmation*

4. Click **OK** to confirm the deletion.
5. Click **Close** to exit the *Configure Employees* dialog box.
Chapter VIII Timecard and Transaction Maintenance

This section describes the concepts and tasks associated with managing employee time records, including editing and adding time entries.

Online Timecard

The Online Timecard allows you to view, add, edit and delete employee time entries. The Timecard can be accessed from two locations: the Configure Employee dialog box and the Approval Editor.

NOTE: There are slight differences between the Online Timecard tab of the Configure Employee screen and the Online Timecard screen accessed from the Approval Editor. The Online Timecard from the Approval Editor:

- Displays the Attendance Code flags next to the punches.
- Does not provide a way to switch to the Transactions screen.
- Does not offer a Multiple Miscellaneous button.
- Does not print exceptions in different colors.

Accessing the Online Timecard from the Configure Employee Screen

1. Click the Daily Operations menu, Employee. The Configure Employee dialog box will open.
2. The Timecard tab will be selected automatically.

Accessing the Online Timecard from the Approval Editor

1. Click the Daily Operations menu, Approval Editor or click on the . The Approval Editor dialog box will open.
2. Double-click an employee's name to open to the Online Timecard window.
Navigating in the Online Timecard Tab

By default, the Online Timecard screen displays the current pay period’s data. There are two easy techniques for navigating to other pay periods.

NOTE: It may not be possible to edit data in previous pay periods, depending upon your security permissions and the number of editable pay periods settings. For more information, see Main Company, page 28, and Configure Users, page 95.

- **Navigation buttons**: Click the Navigation buttons to scroll to previous and next pay periods. The navigation button at the top of the scroll bar takes you to the previous pay period; the button at the bottom takes you to the next pay period.

- **Pay Period selector**: Use the spin button in the Pay Periods Back box to scroll to a pay period a specified number of periods in the past.
Navigating in the Transactions tab

By default, the Transactions screen displays the current month’s data. There is an easy technique for navigating to other months.

NOTE: It may not be possible to edit data in previous months, depending upon your security permissions and the number of editable pay period settings. For more information, see Main Company, page 28, and Configure Users, page 95.

Figure 134: Transactions screen

- **Navigation buttons**: Click the Navigation buttons to scroll to previous and next months. The navigation button at the top of the scroll bar takes you to the previous month; the button at the bottom takes you to the next month.

Adding and Editing Transactions

Adding a transaction enables you to record a time entry on behalf of an employee. For example, you might need to add a missed Clock Out, add a lunch or break, or enter a vacation day.

Examples of transactions are:

- **Clocked In**: Punching In for the day.
- **Clocked Out**: Punching Out for the day.
- **Swipe and Go**: Swipe and go transaction.
- **Out For Lunch**: Punching Out for lunch.
- **In From Lunch**: Punching In from lunch.
- **Out On Break**: Punching Out for break.
- **In From Break**: Punching In from break.
- **Enter Department**: Transferring departments.
- **Enter Tips**: Entering tips.
- **Miscellaneous**: Miscellaneous transactions are used to add or subtract dollars or hours, including vacation and other categories of
time, as well as per diem, tips and other categories of dollars.

There are several ways to add transactions. All accomplish the same end, but some are easier to use in certain instances. All are described below.

**Add Transaction**

Transactions can be added from the *Online Timecard* or from the *Transactions* tab of the *Configure Employee* dialog box. The method is the same in both locations.

This option for adding a transaction works best when you are going to manually enter all elements of the transaction.

**NOTE:** A popup window is available to add/edit Start and Stop entries. The popup window can be accessed by double clicking or a right click in the Start and Stop fields.

1. Navigate to the *Online Timecard* for the employee you wish to edit. See *Online Timecard*, page 158.

   Or navigate to the *Transactions* tab of the *Configure Employee* dialog box and select the employee for whom you wish to add a transaction. See *Employee Transactions*, page 131.

2. Click the *Add Trans* (*Online Timecard*) or *Add* (*Transactions*) button. The *Transaction Detail* dialog box will open.

3. The *Transaction Detail* dialog box contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Enter the date for this transaction.</td>
</tr>
<tr>
<td>Time</td>
<td>Enter the time for the transaction. HH:MM:SS. Enter this in military time.</td>
</tr>
</tbody>
</table>
**Function**
Select the type for this transaction. The standard options are:
- Clocked In
- Clocked Out
- Out for Lunch
- In from Lunch
- Enter Department
- Swipe & Go
- Miscellaneous (used for entering absences, vacation, tips and other categories of time and dollars). See **Add Miscellaneous Transaction**.

Additional options may appear, depending upon your company and clock configuration.

**Clock**
Select the clock to which the transaction should be attributed.

4. Click **OK** to commit the changes and return to the *Online Timecard*.

**Add Miscellaneous Transaction**

Transactions can be added from the *Online Timecard* or from the *Transactions* tab of the *Configure Employee* dialog box. The method is the same in both locations.

This option for adding a transaction works best when you are going to manually enter all elements of the transaction.

1. Navigate to the *Online Timecard* for the employee you wish to edit. See *Online Timecard*, page 158.

Or navigate to the *Transactions* tab of the *Configure Employee* dialog box and select the employee for whom you wish to add a transaction. See *Employee Transactions*, page 131.

2. Click the **Add Trans** (*Online Timecard*) or **Add** (*Transactions*) button. The *Transaction Detail* dialog box will open.

3. Select Miscellaneous from the function drop down menu, additional information will open.

![Transaction Detail](image)

*Figure 136: Transaction Detail*
4. The Transaction Detail dialog box contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date</strong></td>
<td>Enter the date for this transaction.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Enter the time for the transaction. HH:MM:SS. Enter this in military time.</td>
</tr>
<tr>
<td><strong>Function</strong></td>
<td>Select Miscellaneous for this transaction. The Miscellaneous function is used for entering absences, vacation, tips and other categories of time and dollars.</td>
</tr>
<tr>
<td><strong>Clock</strong></td>
<td>Select the clock to which the transaction should be attributed.</td>
</tr>
<tr>
<td><strong>Override Round</strong></td>
<td>Check this option to have TA100 Pro ignore the rounding rules for this transaction.</td>
</tr>
<tr>
<td><strong>Override Automatic Lunches and Breaks</strong></td>
<td>Check this option to cancel all automatic lunches and breaks assigned to a specific day. The edit must be initiated from the start time.</td>
</tr>
<tr>
<td><strong>Miscellaneous Information</strong></td>
<td>This section will only become available when the Miscellaneous function is selected.</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>Select the category for this transaction.</td>
</tr>
<tr>
<td><strong>Add/Subtract</strong></td>
<td>Select <strong>Add</strong> to add the number of hours or dollars in the next field. Select <strong>Subtract</strong> to deduct the number of hours or dollars in the next field.</td>
</tr>
<tr>
<td><strong>HH:MM</strong></td>
<td>If an <strong>Hours</strong> category was selected, this field will become available. Enter the number of hours for this transaction in decimal format.</td>
</tr>
<tr>
<td><strong>Amount</strong></td>
<td>If a <strong>Dollars</strong> category was selected, this field will become available. Enter the amount of dollars for this transaction. If an <strong>Hours</strong> category was selected, this field will automatically fill in when enter the HH:MM in the previous field.</td>
</tr>
<tr>
<td><strong>REG/OT1/OT2/OT3</strong></td>
<td>Select the rate at which the Miscellaneous time should be paid.</td>
</tr>
<tr>
<td><strong>Accrue towards Overtime</strong></td>
<td>Check this box to cause the Miscellaneous entry to count toward overtime (daily and weekly).</td>
</tr>
<tr>
<td><strong>Differential</strong></td>
<td>Select the differential at which the Miscellaneous time should be paid.</td>
</tr>
<tr>
<td><strong>Level</strong></td>
<td>Check this option to have TA100 Pro override the Job Costing level(s).</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>This section will become available if a function requiring additional input is selected (for example, Enter a Department).</td>
</tr>
</tbody>
</table>
Input

Enter the additional input (for example, the Department number).

5. Click OK to commit the changes and return to the Online Timecard.

Edit a Transaction

This section describes how to use the Edit button in the Transaction tab. You can edit transactions from either the Online Timecard or the Transactions tab of the Configure Employee dialog box. The Online Timecard provides two buttons: Edit/Add Start and Edit/Add Stop, which are described in the next two sections.

1. Navigate to the Transactions tab of the Configure Employee dialog box and select the employee whose time you wish to edit. See Employee Transactions, page 131.
2. Navigate to and select the transaction you wish to edit.
3. Click the Edit button. The Transaction Detail dialog box will open.
4. Fill in the settings as described in the Add Transaction section.
5. Click OK to commit the changes and return to the Transactions screen.

Edit/Add Start

Edit/Add Start is available from the Online Timecard. The Edit/Add Start button opens the Transaction Detail dialog box and automatically fills in certain fields.

- The Date fills in with the date selected in the Timecard.
- The Time fills in with the employee’s scheduled Clock In time for the selected date.
- The Function fills in with Clocked In.

This option is easiest when you are adding a Clock In for the day that matches or is close to the employee’s scheduled In time.

1. Navigate to the Online Timecard for the employee you wish to edit. See Online Timecard, page 158.
2. Click the Edit/Add Start button. The Transaction Detail dialog box will open.
3. Fill in the settings as described in the Add Transaction section.
4. Click OK to commit the changes and return to the Online Timecard.
**Edit/Add Stop**

*Edit/Add Stop* is available from the *Online Timecard*. The *Edit/Add Stop* button opens the *Transaction Detail* dialog box and automatically fills in certain fields.

- The **Date** fills in with the date selected in the Timecard.
- The **Time** fills in with the employee’s scheduled Clock Out time for the selected date.
- The **Function** fills in with Clocked Out.
- The **Override Punch Link-Back Time** is now an override feature, this option will ignore all punch link-back time associated with a policy. This edit must be initiated from the stop time.

This option is easiest when you are adding a Clock Out for the day that matches or is close to the employee’s scheduled Out time.

![Transaction Detail for 00001 Anderson, Frank](image)

1. Navigate to the *Online Timecard* for the employee you wish to edit. See *Online Timecard*, page 158.
2. Click the *Edit/Add Stop* button. The *Transaction Detail* dialog box will open.
3. Fill in the settings as described in the *Add Transaction* section.
4. Click **OK** to commit the changes and return to the *Online Timecard*.

**Multiple Miscellaneous**

The Multiple Miscellaneous button appears in the Online Time Card and allows you to add Miscellaneous transactions on multiple days. This option is easiest when you are adding several days of the same category, for example, for a weeklong vacation or per-diems for a business trip.

1. Navigate to the *Online Timecard* for the employee you wish to edit. See *Online Timecard*, page 158.
2. Click the **Multiple Misc.** button. The *Multiple Miscellaneous Transaction* dialog box will open.
3. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time</strong></td>
<td>Enter the start time for this miscellaneous transaction.</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>Select the category for this transaction.</td>
</tr>
<tr>
<td><strong>Add/Subtract</strong></td>
<td>Select <strong>Add</strong> to add the number of hours or dollars in the next field. Select <strong>Subtract</strong> to deduct the number of hours or dollars in the next field.</td>
</tr>
<tr>
<td><strong>HH:MM</strong></td>
<td>If an <strong>Hours</strong> category was selected, this field will become available. Enter the number of hours for this transaction in decimal format.</td>
</tr>
<tr>
<td><strong>Amount</strong></td>
<td>If a <strong>Dollars</strong> category was selected, this field will become available. Enter the amount of dollars for this transaction.</td>
</tr>
<tr>
<td><strong>REG/OT1/OT2/OT3</strong></td>
<td>Select the rate at which the Miscellaneous time should be paid.</td>
</tr>
<tr>
<td><strong>Accrue towards Overtime</strong></td>
<td>Check this box to cause the Miscellaneous entry to count toward overtime (daily and weekly).</td>
</tr>
<tr>
<td><strong>Differential</strong></td>
<td>Select the differential at which the Miscellaneous time should be paid.</td>
</tr>
<tr>
<td><strong>Job Cost Level Override</strong></td>
<td>Check this option to have TA100 Pro override the Job Costing level(s).</td>
</tr>
</tbody>
</table>
Calendar

Using the drop-down boxes at the top of the dialog box, select the Month and Year that contains the days for which you wish to add the Miscellaneous transactions.

Click the dates on the calendar for which you wish to add the transactions. The dates selected will appear to be indented.

4. Click the Apply button. The Category code will appear on the days selected.

5. Click OK to commit the changes and return to the Online Timecard.

From Schedule

From Schedule adds a Clock In for the day and a Clock Out for the day punch, taking the times from the employee's schedule. This is useful when the employee did not punch in or out for the day, but worked the scheduled times.

TIP: You can check the Show Schedule option at the bottom of the Online Timecard in order to verify the scheduled Start and Stop times prior to using this feature.

1. Navigate to the Online Timecard for the employee you wish to edit. See Online Timecard, page 158.

2. Click the From Schedule button. TA100 Pro will automatically fill in the Start and Stop fields with the employee’s Scheduled Start and Stop times for the day.

Delete a Transaction

You may need to delete a transaction that has been made in error. Delete carefully, as there is no way to retrieve deleted data.

1. Navigate to the Online Timecard (see Online Timecard, page 158) or the Transactions tab of the Configure Employee dialog box (see Employee Transactions, page 131) and select the employee you wish to edit.
2. Navigate to the transaction you wish to delete.

3. Click the **Delete** button. You will be prompted with one of the following, depending upon what you are deleting:

   ![Confirm Delete]

   This dialog box will appear if you are deleting a line in the Timecard that has both a Start and a Stop.

   ![Confirmation]

   This dialog box will appear if you are deleting a single Start or Stop, from either the Timecard or the Transactions.

---

### Audit Trails

TA100 Pro keeps track of the changes that are made to time entries. This feature is known as an "Audit Trail." The Transactions tab of the Configure Employee dialog box displays the changes made to a transaction, the date the change was made, and the name and number of the person who made the change. This information can be printed for reporting purposes.

1. Navigate to the **Transactions** tab of the **Configure Employee** window and select the employee you wish to view.

2. Highlight the transaction for which you wish to see the Audit Trail.

3. The Audit Trail section of the screen contains the following:

   ![Figure 140: Audit Trail]

   **Figure 140: Audit Trail**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor</td>
<td>Displays the name and number of the supervisor who edited this transaction.</td>
</tr>
<tr>
<td>Supervisor Badge</td>
<td>Displays the badge number associated with the Supervisor who made the edit.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the Date on which the edit was made.</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the Time at which the edit was made.</td>
</tr>
</tbody>
</table>
Print the Audit Trails

TA100 Pro tracks all changes that are made to time entries. You may print this Audit Trail history.

1. Navigate to the Transactions tab of the Configure Employee window and select the employee you wish to view.

2. Highlight the transaction for which you wish to see the Audit Trail.

3. Click the Print button. A drop-down list of Reports associated with this screen will appear.

4. Select Transactions, By Employee or By Date. The Print Transaction Listing dialog box will open.

5. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Enter the starting date for the report.</td>
</tr>
<tr>
<td>At</td>
<td>Enter the starting time for the report.</td>
</tr>
<tr>
<td>Stop</td>
<td>Enter the ending date for the report.</td>
</tr>
</tbody>
</table>
At

Enter the ending time for the report

Output to

Select the type of report output you wish.

Screen: The report will preview on screen. You are then able to print from the preview.

Printer: The report will be sent directly to the printer.

File: The report will be sent to a FoxPro report file.

Email: The report will be sent via email. (See Emailing a Report, page 193).

Options

Select which Audit Trail items you wish to print along with the Transaction details.

Deleted: The report will display deleted entries.

Changed: The report will display the editing history of the transaction.

Supervisor: The report will display transactions edited by supervisors at the clock.

Employees

Select which employees for whom you wish to print Transactions.

Add: Adds the selected employee to the list of employees for the report.

Add All: Adds all employees to the list of employees for the report.

Remove: Removes the selected employee from the list of employees for the report.

Remove All: Removes all employees from the list of employees for the report.

6. Click OK to commit the changes and run the report.

7. After previewing and/or printing, close the report (if necessary).

   NOTE: The transaction report is color coded with red representing deleted items and blue representing changes.

8. Click the Close button to exit the Report Settings dialog box and return to the Transactions screen.

Approval Editor

The Approval Editor is an extremely useful tool that displays employee transactions that need approval or editing by a supervisor. These items display in the Approval Editor by default:

• System-Generated Absences
• Missing Punches

It is also possible to edit transactions directly from the Approval Editor. Double-clicking a transaction from the Approval Editor opens the Online Timecard, from which you can add, edit and delete transactions normally. (See Approval Editor, page 170).

1. Click the Daily Operations menu, Approval Editor, or by clicking on the . The Approval Editor screen will open.

![Approval Editor](image)

Figure 143: Approval Editor

2. The Approval Editor contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the employee's name.</td>
</tr>
<tr>
<td>Number</td>
<td>Displays the employee's number.</td>
</tr>
<tr>
<td>DOW</td>
<td>Displays the day of the week on which the item needing approval occurred.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date on which the item needing approval occurred.</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the time at which the item needing approval occurred.</td>
</tr>
<tr>
<td>Code</td>
<td>Displays the Attendance Code for any infractions. (i.e., IL for In Late, OG for Out Graced, etc.).</td>
</tr>
<tr>
<td>Reason</td>
<td>Displays the reason in color why the transaction is displayed in the Approval Editor</td>
</tr>
<tr>
<td>Absences</td>
<td>Select this option to show only Absent Exceptions needing approval.</td>
</tr>
<tr>
<td>Missing Punches</td>
<td>Select this option to show only Missing Punch Exceptions needing approval.</td>
</tr>
</tbody>
</table>
All
Select this option to show all Absent, Missing Punches, Attendance Infractions and all other Exceptions.

Active Employees
Select this option to show only Active employees.

Inactive Employees
Select this option to show only Inactive employees.

All Employees
Select this option to show both Active and Inactive employees.

Group
Select this option to display a specific Group.

Division
Select this option to display a specific Division.

3. To edit a transaction from the Approval Editor, double-click the transaction you wish to change.

The Online Timecard will open to display the pay period during which the transaction took place.

![Figure 144: Online Timecard (from Approval Editor)](image)

4. Add, edit or delete the transaction as needed. For more information on these tasks, see Adding and Editing Transactions, page 160, and Deleting a Transaction, page 167.

The Schedules Tab and Transaction tab will also be available to view and edit. See Employee Schedule Tab, page 123 and the Employee Transactions Tab, page 131.
Status Board

The *Status Board* screen is a useful tool that displays the last punch for recorded for each employee within a certain time range (for example, in the last 18 hours). This is an excellent way to find out the current whereabouts of your employees. The data displayed in the screen is for information purposes only and cannot be edited.

**NOTE**: If an employee has not punched within the time range specified no data will appear next to his or her name.

1. Click the **Daily Operations** menu, **Status Board**. The *Status Board* screen will open.

![Status Board](image)

*Figure 145: Status Board*

2. The *Status Board* screen contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Displays the number of the employee.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name of the employee.</td>
</tr>
<tr>
<td>Out, Working and Lunch</td>
<td>Explains the status of the employee. Shows by displaying a colored square in the appropriate status box.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Displays the date and time of the last punch recorded.</td>
</tr>
<tr>
<td>Clock</td>
<td>Displays the clock at which the punch occurred.</td>
</tr>
<tr>
<td>Key</td>
<td>Displays the function key on the clock pressed.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Displays the prompt associated with the function key pressed.</td>
</tr>
<tr>
<td>Data</td>
<td>Displays the code for any data that the employee was prompted to enter. For example, <strong>PRD1</strong> for per diem, <strong>TIP1</strong> for tips, etc.</td>
</tr>
</tbody>
</table>
Setting Definition

Hours Back Enter the number of hours in the past you wish TA100 Pro to look for the last punch. The default is 18 hours, indicating that the Status Board screen will show all transactions that have occurred in the last 18 hours.

All Select this option to display all employees, regardless of whether they have punched within the Hours Back time range.

Punches Select this option to display only employees who have punched within the Hours Back time range.

No Punches Select this option to display only employees who have not punched within the Hours Back time range.

Group Select a Group to only view employees assigned to that Group.

Division Select a Division to only view employees assigned to that Division.

Print Button Print the Status Board report.

3. Click Close to exit the Status Board window.

Task Organizer

The Task Organizer is an extremely useful tool that allows the user to walk through the necessary steps that should be performed for a specific period of time, such as Daily, Monthly, Annual, Payroll and System Setup.

1. Click the Edit menu, Task Organizer. The Task Organizer screen will open.

2. The Task Organizer screen contains the following links:
   - Daily
• Monthly
• Annual
• Payroll
• System Setup
Chapter IX  Global Commands

This section describes commands and tasks that can be performed for many employees at once. These tasks include Global Message Assignment and Transaction additions.

Selecting Employees in Global Operation Dialog Boxes

The method of selecting employees is the same in nearly all of the Global Operation (as well as the Report Parameter) dialog boxes. For ease of use, the technique is described here and referenced in the instructions below.

There are four ways to select employees: Individually, Globally, by Group, and by Division.

Select Employees Individually

1. Select the Employee you wish to choose.
2. Click the Add button. The employee will appear in the Selected list on the right.

Select Employees Globally

1. Click the Add All button. All employees will appear in the Selected list on the right.

Select Employees by Group

1. Click the Group button. The Group Selection dialog box will open.
2. Use the drop-down to select in the From box to select the first Group you wish to choose.

3. Use the drop-down to select in the To box to select the first Group you wish to choose. (TIP: To choose a single group, select the same Group in both boxes).

4. Click OK to accept the changes and return to the dialog box. All employees in the selected Groups will appear in the Selected list on the right.

Select Employees by Division

1. Click the Division button. The Division Selection dialog box will open.

2. Use the drop-down to select in the From box to select the first Division you wish to choose.

3. Use the drop-down to select in the To box to select the first Division you wish to choose. (TIP: To choose a single Division, select the same Division in both boxes).

4. Click OK to accept the changes and return to the dialog box. All employees in the selected Division will appear in the Selected list on the right.

Global Message Assignment

Global Message Assignment allows you to create a customized message that will display when employees punch at the clock. This is an easy way to send the same message to multiple employees at once. For example, you might send a message that says “Welcome” or display the employee’s name after punching.

2. Select the employee(s) to whom you wish to send the message using the techniques described above (see Selecting Employees in Global Operation Dialog Boxes, page 176).

3. Click the Details button. The Global Message Assignment Details dialog box will open.

4. Select the clock(s) to which the message should be sent by click Add to select a single clock, or Add All to select all clocks.

5. Check Default message to Employee name or enter the Message you wish to send. The Message can be up to 20 characters long (this is the maximum number of characters that can display on the LCD panel of the clock).

6. Click OK to commit the changes and return to the Global Message Assignment dialog box.

7. Click OK to send the message. The message will display to employees after it is uploaded to the clock.

8. Click Close to exit the dialog box.

Global Add Transaction

Global Add Transaction allows you to add a transaction of any type for multiple employees. This can be used to clock all employees out at a certain time, enter vacation or sick time for multiple employees, etc.

2. Select the employee(s) you wish to assign using the techniques described above (see *Selecting Employees in Global Operation Dialog Boxes*, page 176).

3. Click the **Punch** button. The *Global Add Transaction Details* dialog box will open.

4. Fill in the settings as described in the *Adding and Editing Transactions* section, page 160.

5. Click the **OK** button to commit the changes and return to the *Global Add Transaction* dialog box.

6. Click **OK** again to complete the entry.

7. Click **Close** to exit the dialog box.
Chapter X  Reports

TA100 Pro has more than 300 available reports. In the interest of brevity, this section will focus on the concepts and techniques associated with running reports and listings rather than on the specifics of running every one of the reports.

Listings are a type of report that “lists” the items and settings in your TA100 Pro database. Listings are good to print for reference information. Examples are listings of Departments, Policies, Rounding rules, Clocks, etc.

Important Information on Printing Reports

TA100 Pro prints reports to the printer that is currently defined for the program under File, Print. By default, this is the same as the Windows default printer. If you wish to choose a different printer, you must make the change prior to running the report, as the Report Print command sends the report directly to the printer without prompting you to choose a printer.

The following instructions describe how to change your TA100 Pro printer.

Configure Printer

1. Click the File menu, Print. The Print Setup dialog box will open.

2. Using the Name drop-down box, select the pre-defined printer to which you wish to print.
3. Click **OK** to commit the changes and exit the dialog box. The TA100 Pro printer will be changed and reports will now print to it.

**Running a Report**

The basics of running reports are the same from report to report. Some reports may prompt for additional information that is particular to that specific report, but most have standard settings.

The Reports are organized into categories to make them easier to find. The categories are:

- **Period**: Timecards, Who’s Scheduled, Coverage, and other Period oriented reports.
- **Weekly**: Weekly Hours, Attendance, Approaching Overtime, Weekly oriented reports.
- **Daily**: Who’s in, Who’s not in, Daily Hours, and other Daily oriented reports.
- **Payroll Exports**: Runs the Payroll Export.
- **Listings**: Lists and setup definitions for your TA100 Pro configuration.

Most reports can be run by Range (allowing you to select a range of items or employees) or Individual (allowing you to selecting individual employees or groups of employees). Both methods are described below.

**Running a Report by Range**

1. Click the **Reports** button to display the report categories.
2. Select the category in which you wish to search. The **Select Report** list for that category will appear.
3. Select the report you wish to run.
4. Select the **Ranges** option.
5. Click the **Run** button. The **Report Parameter Selection** dialog box will open.
6. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
</table>
| **Pay Period**   | Select this option to run the report for a pay period. You will need to fill in the rest of the pay period options that become available when the option is selected.  
Policy: Select the policy that contains the pay period definition you wish to use.  
Pay Periods Back: Enter the number of pay periods in the past for which to run the report. Verify the dates shown in the Start and Stop fields.  
TIP: Entering 0 will run the report for the current pay period. |
| **Pay Periods Back** | Enter the number of pay periods in the past for which to run the report. Verify the dates shown in the Start and Stop fields.  
TIP: Entering 0 will run the report for the current pay period. |
| **Select**       | Click this button to select the Policy that contains the pay period definition you wish to use.                                                                 |
| **Policy**       | Displays the number of the selected Policy                                                                                                  |
| **Period**       | Displays the pay period frequency (weekly, biweekly, etc.).                                                                                   |
| **Special**      | Select this option to enter the date range manually.                                                                                           |
**Start**  
The purpose of this field changes depending upon which Date Range option has been chosen.

- If **Special** is chosen, enter the first date you wish to display on the report.
- If **Pay Period** is chosen, this field will display the first date of the selected pay period.
- If **Yesterday** or **Today** are chosen, this field will display Yesterday or Today's date.

**Stop**  
The purpose of this field changes depending upon which **Date Range** option has been chosen.

- If **Special** is chosen, enter the last date you wish to display on the report.
- If **Pay Period** is chosen, this field will display the last date of the selected pay period.
- If **Yesterday** or **Today** are chosen, this field will display Yesterday or Today's date.

**Yesterday**  
Select this option to choose yesterday's date.

**Today**  
Select this option to choose today's date.

**Forecasting**  
Check this box to include hours forecasted from schedule (not worked yet) on the reports.

**Reprocess**  
Check this box to reprocess punch information prior to running the report.

**NOTE:** This significantly slows down the running of the report and is unnecessary if you already have AutoProcessing turned on.

**Employees**  
Select which type of employees you wish to be included on the report.

- **Active:** The report will print only Active employees.
- **Inactive:** The report will print only Inactive employees.
- **Both:** The report will print both Active and Inactive employees.

**All**  
Check **All** to indicate that you wish all items in a collection to be printed.

**Range**  
Check **Range** to indicate that you wish to choose a range of items.
**Employees**  Select the employees for whom you wish to print the report. If you have chosen Range, select the starting and ending employees. TA100 Pro will print all employees between the selected individuals (inclusive).

**Departments**  Select the Departments for which you wish to print the report. If you have chosen Range, select the starting and ending Departments. TA100 Pro will print employees in all Departments between the selected items (inclusive).

**Divisions**  Select the Divisions for which you wish to print the report. If you have chosen Range, select the starting and ending Division. TA100 Pro will print employees in all Divisions between the selected items (inclusive).

**Groups**  Select the Groups for which you wish to print the report. If you have chosen Range, select the starting and ending Groups. TA100 Pro will print employees in all Groups between the selected items (inclusive).

7. When all settings are complete, click OK to proceed to the Additional Reporting Parameters dialog box.

8. The Additional Parameters dialog allows you to further filter and group report data. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>These settings allow you filter which employees' data will be printed.</td>
</tr>
</tbody>
</table>
**Full Time/Part Time/Both**

Check **Full Time** to print only employees whose Status is **Full Time**.

Check **Part Time** to print only employees whose Status is **Part Time**.

Check **Both** to print both Full Time and Part Time employees.

**Permanent/Temporary/Both**

Check **Permanent** to print only employees whose Status is **Permanent**.

Check **Temporary** to print only employees whose Status is **Temporary**.

Check **Both** to print both Permanent and Temporary employees.

**Hourly/Salary**

Check **Hourly** to print only employees whose Status is **Hourly**.

Check **Salary** to print only employees whose Status is **Salary**.

Check **Both** to print both Hourly and Salary employees.

**Sort By**

Select the setting by which you want employee records to sort. The options are **Number** (Employee ID Number) or **Name**.

**Group By**

Select the setting by which you want employee records to group (organize). The options are **None**, **Department**, **Division** and **Group**.

**Output to**

Select the media to which you wish to output the report. The options are:

- **Screen**: The report will preview on screen. You are then able to print from the preview.
- **Printer**: The report will be sent directly to the printer.
- **File**: The report will be sent to a FoxPro report file.
- **Email**: The report will be sent via email. If you choose this option, you will be given an additional screen to enter the email recipients. (See **Emailing a Report**, page 193).

**NOTE**: Reports can only be Emailed via Microsoft Outlook.

9. When all settings are complete, click the **OK** button to run the report.

**NOTE**: Some reports may prompt for additional information particular to the specific report at this point. You may also be prompted for Email recipient information, if you choose to send the report via email.
10. The report will output to your choice (Screen, Printer, File or Email.)

11. After receiving the report, click the Close button until you have exited all the dialog boxes.

Running a Report by Individual

1. Click Reports to display the report categories.

2. Select the category in which you wish to search. The Select Report list for that category will appear.

3. Highlight the report you wish to run.

4. Select the Individuals option.

5. Click the Run button. The Report Parameter Selection dialog box will open.

6. Fill in the settings as appropriate:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Period</td>
<td>Select this option to run the report for a pay period. You will need to fill in the rest of the pay period options that become available when the option is selected.</td>
</tr>
<tr>
<td></td>
<td><strong>Policy</strong>: Select the policy that contains the pay period definition you wish to use.</td>
</tr>
<tr>
<td></td>
<td><strong>Pay Periods Back</strong>: Enter the number of pay periods in the past for which to run the report Verify the dates shown in the Start and Stop fields.</td>
</tr>
<tr>
<td></td>
<td><strong>TIP</strong>: Entering 0 will run the report for the current pay period.</td>
</tr>
<tr>
<td>Pay Periods Back</td>
<td>Enter the number of pay periods in the past for which to run the report Verify the dates shown in the Start and Stop fields.</td>
</tr>
<tr>
<td></td>
<td><strong>TIP</strong>: Entering 0 will run the report for the current pay period.</td>
</tr>
<tr>
<td>Select</td>
<td>Click this button to select the Policy that contains the pay period definition you wish to use.</td>
</tr>
<tr>
<td>Policy</td>
<td>Displays the number of the selected Policy</td>
</tr>
<tr>
<td>Period</td>
<td>Displays the pay period frequency (weekly, biweekly, etc.).</td>
</tr>
<tr>
<td>Special</td>
<td>Select this option to enter the date range manually.</td>
</tr>
<tr>
<td>Start</td>
<td>The purpose of this field changes depending upon which Date Range option has been chosen.</td>
</tr>
<tr>
<td></td>
<td>If <strong>Special</strong> is chosen, enter the first date you wish to display on the report.</td>
</tr>
<tr>
<td></td>
<td>If <strong>Pay Period</strong> is chosen, this field will display the first date of the selected pay period.</td>
</tr>
<tr>
<td></td>
<td>If <strong>Yesterday</strong> or <strong>Today</strong> are chosen, this field will display Yesterday or Today's date.</td>
</tr>
<tr>
<td>Stop</td>
<td>The purpose of this field changes depending upon which Date Range option has been chosen.</td>
</tr>
<tr>
<td></td>
<td>If <strong>Special</strong> is chosen, enter the last date you wish to display on the report.</td>
</tr>
<tr>
<td></td>
<td>If <strong>Pay Period</strong> is chosen, this field will display the last date of the selected pay period.</td>
</tr>
<tr>
<td></td>
<td>If <strong>Yesterday</strong> or <strong>Today</strong> are chosen, this field will display Yesterday or Today's date.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Yesterday</strong></td>
<td>Select this option to choose yesterday's date.</td>
</tr>
<tr>
<td><strong>Today</strong></td>
<td>Select this option to choose today's date.</td>
</tr>
<tr>
<td><strong>Forecasting</strong></td>
<td>Check this box to include hours forecasted from schedule (not worked yet) on the reports.</td>
</tr>
<tr>
<td><strong>Reprocess</strong></td>
<td>Check this box to reprocess punch information prior to running the report.</td>
</tr>
<tr>
<td><strong>Employees</strong></td>
<td>Select which type of employees you wish to be included on the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Active</strong>: The report will print only Active employees.</td>
</tr>
<tr>
<td></td>
<td><strong>Inactive</strong>: The report will print only Inactive employees.</td>
</tr>
<tr>
<td></td>
<td><strong>Both</strong>: The report will print both Active and Inactive employees.</td>
</tr>
</tbody>
</table>

**NOTE**: This significantly slows down the running of the report and is unnecessary if you already have AutoProcessing turned on.
7. Select the employee(s) for whom you wish to run the report.

There are four ways to select employees: Individually, Globally, by Group, and by Division.

Select Employees In Reports
Select Employees Individually

- Double-click the Employee you wish to choose. The Employee will be added to the Selected list on the right.

Select Employees Globally

- Click the Add All button. All employees will appear in the Selected list on the right.

Select Employees by Group

- Click the Group button. The Group Selection dialog box will open.

  ![Figure 161: Group Selection]

  - Use the drop-down to select in the From box to select the first Group you wish to choose.
  - Use the drop-down to select in the To box to select the first Group you wish to choose. (TIP: To choose a single group, select the same Group in both boxes).
  - Click OK to accept the changes and return to the dialog box. All employees in the selected Groups will appear in the Selected list on the right.

Select Employees by Division

- Click the Division button. The Division Selection dialog box will open.

  ![Figure 162: Division Selection]

  - Use the drop-down to select in the From box to select the first Division you wish to choose.
  - Use the drop-down to select in the To box to select the first Division you wish to choose. (TIP: To choose a single Division, select the same Division in both boxes).
  - Click OK to accept the changes and return to the dialog box. All employees in the selected Divisions will appear in the Selected list on the right.
8. When all settings are complete, click **OK** to proceed to the *Additional Reporting Parameters* dialog box.

![Additional Reporting Parameters](image)

*Figure 163: Additional Reporting Parameters*

9. The *Additional Parameters* dialog box allows you to further filter and group report data. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status</strong></td>
<td>These settings allow you filter which employees' data will be printed.</td>
</tr>
</tbody>
</table>
| **Full Time/Part Time/Both** | Check **Full Time** to print only employees whose Status is **Part Time**.  
Check **Part Time** to print only employees whose Status is **Full Time**.  
Check **Both** to print both Full Time and Part Time employees.  |
| **Permanent/Temporary/Both** | Check **Permanent** to print only employees whose Status is **Permanent**.  
Check **Temporary** to print only employees whose Status is **Temporary**.  
Check **Both** to print both Permanent and Temporary employees.  |
| **Hourly/Salary**        | Check **Hourly** to print only employees whose Status is **Hourly**.  
Check **Salary** to print only employees whose Status is **Salary**.  
Check **Both** to print both Hourly and Salary employees.  |
| **Sort By**              | Select the setting by which you want employee records to sort. The options are **Number** (Employee ID Number) or **Name**.  |
| **Group By**             | Select the setting by which you want employee records to group (organize). The options are **None**, **Department**, **Division** and **Group**.  |
**Output to**

Select the media to which you wish to output the report. The options are:

- **Screen**: The report will preview on screen. You are then able to print from the preview.
- **Printer**: The report will be sent directly to the printer.
- **File**: The report can be created in several file types including RTF, PDF and Excel.
- **Email**: The report will be sent via email. If you choose this option, you will be given an additional screen to enter the email recipients. (See *Emailing a Report*, page 193).

10. When all settings are complete, click the **OK** button to run the report.

**NOTE**: At this point some reports may prompt for additional information particular to that specific report. You may also be prompted for Email recipient information, if you choose to send a report via email.

11. The report will output to your choice (Screen, Printer, File or Email.)

12. After receiving the report, click the **Close** button until you have exited all the dialog boxes.

---

**On Screen Report Preview**

If you chose to output the report to Screen, a Report Preview window will open. This window will display the report as it will be printed and allows you to print directly from this window.

1. Run the report of your choice, selecting **Output to Screen**. See *Running a Report*, page 181.

2. The **Report Designer** window for the selected report will open to preview your report.
3. The Report Preview window contains several tool buttons. Reading from left to right, these are:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Page</td>
<td>Click this button to navigate to the first page of a multi-page report.</td>
</tr>
<tr>
<td>Previous Page</td>
<td>Click this button to navigate to the previous page in a multi-page report.</td>
</tr>
<tr>
<td>Go To Page</td>
<td>Click this button to enter the page to which you wish to go.</td>
</tr>
<tr>
<td>Next Page</td>
<td>Click this button to navigate to the next page in a multi-page report.</td>
</tr>
<tr>
<td>Last Page</td>
<td>Click this button to navigate to the last page of a multi-page report.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Use this box to change the zoom percentage of the report to show more or less of the report on screen.</td>
</tr>
<tr>
<td>Close Preview</td>
<td>Click this button to exit the Report Preview screen.</td>
</tr>
</tbody>
</table>
Print  
Click this button to print the report to the printer currently selected under File, Print. (See Important Information on Printing Reports, page 180).

4. Click the Close Preview button to exit the Report Preview screen.

5. Click the Close button until you have exited all the dialog boxes.

Emailing a Report

TA100 Pro allows you to email reports in Adobe Acrobat format using the email program currently configured on your computer. TA100 Pro will attach the report to an email and place it in the outgoing email queue of your email program. Your email program will then be responsible for sending the email. The title of the email will be the same as the report you have chosen, and the text of the message will include the date and time at which the report was run.

When you output a report to email, you will be asked to fill in the email addresses of the recipients.

1. Run the report of your choice, selecting Output to Email. (See Running a Report, page 181.) The Email Recipients dialog box will open.

2. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient List</td>
<td>Displays a list of the recipients to whom you've sent reports to in the past.</td>
</tr>
<tr>
<td>Add Button</td>
<td>Click this button to add a new recipient. You will be prompted to enter the person's name and email address.</td>
</tr>
<tr>
<td>Edit Button</td>
<td>Click this button to edit an existing recipient's information. You will be prompted to enter the person's name and email address.</td>
</tr>
<tr>
<td>Delete Button</td>
<td>Click this button to delete an existing recipient's information.</td>
</tr>
<tr>
<td>To Button</td>
<td>Click this button to add the selected recipient to the To: field of your email.</td>
</tr>
</tbody>
</table>
CC Button  Click this button to add the selected recipient to the CC: (Courtesy Copy) field of your email.

BCC Button  Click this button to add the selected recipient to the BCC: (Blind Courtesy Copy) field of your email.

Remove Button  Click this button to remove a recipient added in error.

3. When all recipients are added, click the OK button to send the email. You will see a “Processing email” message, but the email will not appear on screen.

4. After the email is processed, click the Close button until you have exited all the dialog boxes.

5. You can view the sent email from the sent mail folder of your email program (for example, MS Outlook's Sent Items folder). The email will appear something like this:

![Figure 167: Example: Emailed Report](image)

Figure 167: Example: Emailed Report
Chapter XI  Terminal Configuration

This section covers the concepts and tasks associated with setting up clocks.

TA100 Pro Supports the use of three types of clocks: TA520/530, TA620, PC Clock and TASC. Support for ATS and Hand Reader, Videx DuraTrax clocks is available in additional modules.

For each clock, the following parameters must be defined:

- Communication Type (RS232, RS485, Internal/External modem, or Ethernet)
- PC Comm Port used for communication
- Baud Rate
- Default Levels
- Bell Schedule (if applicable)

Types of Connections

Time America clocks are capable of communicating in one of four different ways:

- The Direct or RS-232 serial port solution is designed for a single, short-range terminal. The terminal should not be placed beyond 50 feet of shielded wire from a PC. Each terminal requires its own serial connection to a PC using an RS-232 serial port.

- The LAN or RS-485 solution is designed for a direct connection, long-range, single or multi-terminal system. RS-485 allows up to 32 terminals to be networked to one PC serial port, creating a Local Area Network (LAN). Each terminal is connected to a LAN distribution box. These boxes connect to the Polling PC with two conductor-shielded cable. The total length of the serial connection can be as much as 5000 feet (almost 1 mile). Each terminal is identified using a unique ID.

- The modem option is designed for a single- or multi-unit environment. The modem solution provides two additional options: internal modem or external modem. Generally, this option is utilized when the terminal is located out of cabling range or if the use of cabling is being avoided. When data needs to be downloaded, TA100 Pro can place a call (using a modem in the PC) to the terminal, download the information and disconnect.

NOTE: The computer that polls the clocks will need a modem in order to call the
clock. Time America recommends U.S. Robotics modems, as they are capable of communicating with the clock at the 1200 and 2400-baud rates required.

- The Ethernet connection is designed for Local or Wide Area Networks using the TCP/IP protocol. The terminal is connected to the network through a hub, just like any other computer on the network.

As part of the configuration of the clock, you will choose the type of connection for each clock. The configuration dialog box will prompt you for information specific to the type of connection you have chosen.

**Smart Converters**

Using a Smart Converter, TA100 Pro can transform a LAN clock into a Modem clock.

**TA500, TA600 and TA7000 Series (TA520/530, TA620, TA7000)**

Configuration of the TA500 Series, TA600 Series and TA7000 Series time clocks is virtually identical. For this reason, they are combined into one section.

Since multiple clocks can be defined in the TA100 Pro, a copy feature is available to copy an existing clock’s parameters when adding a new clock. This eliminates the need to re-enter an entirely new clock configuration.

**Configure a TA500/TA600/TA7000 Series Clock**

1. Click the **Communications** menu, **Configure, TA500** or **TA600** or **TA7000**. The **Configure Clock** dialog box will open. The dialog box contains several tabs, all of which are described below.

   ![Figure 169: Configure TA500/TA600/TA7000 Clocks: General Tab](image)

2. The General tab defines the communication and general operation settings and contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>This is a required field. Enter a unique code (up to 4 characters) to identify the clock. Once defined, this code cannot be changed.</td>
</tr>
</tbody>
</table>
**Description**

Enter a description of the clock. This description will be seen in the system and on reports. This field can be used to describe the clock type and its location in your facility (i.e. TA530 in BUILDING TWO). The clock description can be up to 30 characters long.

**Active**

Click the Active check box to indicate that the clock is currently in use. Uncheck this box if the clock is not being used at this time.

**Revision 5 or 6**

THIS WILL ONLY SHOW FOR THE TA600 SERIES

Select the appropriate revision – you can check the revision by powering up the clock.

**Path**

Select the type of connection this clock will use. The options are:

- Direct (RS232)
- LAN (RS485)
- Modem (Internal)
- Serial LAN (Smart Converter)
- Remote Direct (External Modem)
- Modem LAN (Smart Converter)
- Ethernet (External)

For more information on these connections, see *Types of Connections*, page 195.

**Port**

Select the communications port on your computer that will be used to communicate with the clock. The factory default is COM 1.

**Serial Baud**

This is the Direct connection (RS232) in the Communication Path field.

- RS232 Baud = 9600 for all clocks

**Lan**

These settings become available when LAN has been chosen as the communication type in the Communication Path field.

**Baud Rate**

The default is 9600 baud. Make sure the baud rate selected here matches the baud rate defined at the clock. All clocks use 9600 for LAN. The TA600 can go as high as 19200.

**TIP:** You can use the Configuration Badge (00000000) at the clock to view/modify the clock’s baud rate.
**LAN ID**
Enter the clock’s unique identification number in this field. This number provides a way for the system to distinguish between individual clocks. Any one-character (alphabetic or numeric) ID may be used. Make sure the LAN ID defined here matches the LAN ID defined at the clock.

**TIP:** You can use the Configuration Badge (000000000) at the clock to view/modify the clock’s LAN ID.

**Converter**
Select the type of converter used in the LAN setup.

The RTS converters have been phased out over the years and were mainly used with AT style computers that used a 25 pin serial port. Most new computers use 9 pin serial ports that connect to the newer SD style converters. If you are unsure which you have, contact your dealer.

**Ethernet**
These settings define how an Ethernet clock will communicate with TA100 Pro.

**IP Address**
Enter the IP address assigned to the Etherlink converter.

**IP Port**
Displays the port used on the Etherlink Converter. The default is 3000 and should not be changed. Altering this number will result in communication failure, and the possibility of only being able to connect to the Etherlink Converter serially.

**Modem**
These settings define how a modem clock will communicate with TA100 Pro.

**Baud Rate**
Select the modem’s communication speed. Make sure the baud rate selected here matches the baud rate defined at the clock.

**NOTE:** The maximum baud rate for the TA500 internal modem is **1200** and the maximum baud rate for the TA600 internal modem is **2400**. The maximum baud rate for the TA7000 internal modem is TBD.
**Phone Number**

Enter the phone number the PC modem must dial to communicate with this clock. The number must be entered in the following format:

**Outside Line Access Code, Wait Symbol, Area Code, Phone Number**

If no outside line is required (such as 9), simply enter the phone number. Omit the area code if not applicable. On most modems, the wait symbol is a comma (,) typically representing a one second pause. Multiple wait symbols can be used if necessary.

**Start/Stop Answer**

These fields control the time of day the clock’s internal modem will answer an incoming call. Enter the modem’s start and stop answer time in military format (HH:MM).

For example, to set the modem to answer only between 7:00 A.M. and 6:00 P.M., enter **07:00** and **18:00** in the fields provided. The default is **00:00** (midnight) and **23:59** (one minute before midnight). In other words, the modem will answer any time it is called during the day.

**Ring Delay**

Enter the number of rings that the clock should wait before picking up the line.

For example, setting the **Ring Delay** to 4 means that after the clock detects a ringing phone, it will wait 4 rings before answering. 0 means DO NOT ANSWER.

**Number of Retries**

Enter the number of times the computer should attempt to connect to the clock if communication either fails or is interrupted during polling.

**Time Difference Between Computer and Clock**

Enter the time difference (in hours) between the computer and time clock. Since the computer can set the clock’s time, this field compensates for time zone differences between the computer’s location and the clock’s location. When the clock’s time is set, the system either adds or subtracts this time difference from the computer’s clock.

A setting of 0 indicates that the clock and computer are in the same time zone.

**Division**

Select the company division where the clock is located. Every transaction entered on this clock is tagged with this division code.

**Supervisor**

These options define supervisor settings for the clock.
**Prefix for Entry** Enter the prefix code used by the terminal to identify a supervisor’s badge. Any badge starting with this prefix can access the clock’s Supervisor Mode. Using this mode, a supervisor can add, view, or delete transactions in the time clock.

The default prefix is 11. For example, badge number 112345 can access Supervisor Mode.

**Prefix for Recall** Enter the prefix code used by the terminal to identify a recall badge. Any badge starting with this prefix can access the clock’s Recall Mode. In Recall Mode, a person can view previous time transactions but not add, edit, or delete transactions.

**Default Date** Check this box to automatically use the clock’s current date for transactions added using a supervisor’s badge. When this check box is clear, the clock prompts the supervisor for the date of any new transactions.

**Default Time** Check this box to automatically use the clock’s current time for transactions added using a supervisor’s badge. When this check box is clear, the clock prompts the supervisor for the time of any new transactions.

**Input** These settings determine how data can be put into the clock.

**Initial Source** Check the applicable check box(es) to indicate the method by which an employee badge number is entered into the clock.

**Swipe** The employee’s badge number can be entered by swiping a badge.

**Key** The employee’s badge number can be entered by pressing keys on the clock keypad.

**Bar Code** The employee’s badge number can be entered by scanning a bar code.

**Employee Badge Source By Supervisor** Check the applicable check box(es) to indicate the method by which a supervisor (in supervisor mode) can enter employee badge number into the clock.

**Swipe** The employee’s badge number can be entered by swiping a badge.

**Key** The employee’s badge number can be entered by pressing keys on the clock keypad.

**Bar Code** The employee’s badge number can be entered by scanning a bar code.
3. The *Configure* tab defines the message and timeout settings and contains the following information:

![Figure 170: Configure TA500/TA600/TA7000 Clocks: Configure Tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time-Outs</strong></td>
<td>These settings determine how long prompts and messages will appear on the clock's screen.</td>
</tr>
<tr>
<td><strong>For data input</strong></td>
<td>Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to a prompt before returning to an idle state.</td>
</tr>
<tr>
<td></td>
<td>Time is entered in seconds and tenths of a second. For example, <strong>10.0</strong> means that the clock will wait 10 seconds for a response after prompting for input. The default is <strong>60.0</strong> seconds.</td>
</tr>
<tr>
<td><strong>To Enter function</strong></td>
<td>Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to enter a function before returning to an idle state.</td>
</tr>
<tr>
<td></td>
<td>Time is entered in seconds and tenths of a second. For example, <strong>5.5</strong> means that the clock will wait 5½ seconds for a response after prompting for input. The default is <strong>20.0</strong> seconds.</td>
</tr>
<tr>
<td><strong>Displayed messages</strong></td>
<td>Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any message before returning to an idle state.</td>
</tr>
<tr>
<td></td>
<td>Time is entered in seconds and tenths of a second. For example, <strong>1.5</strong> means that the clock will display messages for 1½ seconds. The default is <strong>2.0</strong> seconds.</td>
</tr>
</tbody>
</table>
| **Supervisor questions** | Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to a supervisor question before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, 30.0 means that the clock will wait 30 seconds for a supervisor’s response to a question such as “Employee Badge #”. The default is 90.0 seconds. |
| **Error messages** | Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any error message before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, 1.0 means that the clock will display error messages for one second. The default is 1.5 seconds. |
| **Messages** | These settings define the text prompts for certain operations at the clock. |
| **Enter Function** | This field allows you to replace the default ENTER FUNCTION message with a custom message (up to 16 characters in length).

This message is displayed after swiping a badge or entering a badge number at the clock. |
| **Invalid Source** | This field allows you to replace the standard INVALID SOURCE message with a custom message (up to 16 characters in length).

This message will display when an input source is used that the terminal has been programmed to ignore. For example, the employee uses a magnetic strip badge to punch In when only keypad entry is recognized. |
| **Invalid Badge** | This field allows you to replace the standard INVALID BADGE message with a custom message (up to 16 characters in length).

An INVALID BADGE message displays when a badge or card other than the specified badge length is used. |
| **Invalid Level** | This field allows you to replace the default INVALID LEVEL message with a custom message.

This message is displayed when Validation is used, and an invalid level number is entered. It cannot be more than 16 characters. |
Idle Message
Enter the message text that displays on the
time clock when in an idle state. If this field is
left blank, no message will be displayed.

It can accept a one-line message that is up
to 16 characters.

Idle Display (sec)
Enter the length of time (from 1 to 60
seconds) that the idle message displays
before switching to the date and time. The
default is 2. 0 indicates the idle message
should not display.

Date/Time display
( sec)
Enter the length of time (from 1 to 60
seconds) that the Date and time display
before switching back to the idle message.
The default is 2. 0 indicates the date and
time should not display.

Swipe & Go Badges
If the Swipe & Go feature is used enter the
highest badge number that the terminal will
recognize as a Swipe & Go badge.

For example, if 2000 is entered here, only
badge numbers 0001 through 2000 are
considered Swipe & Go badges. All badge
numbers above 2000 are treated as “normal”
badges requiring the employee to enter a
function key to complete the transaction
(Clock In or Out, Out to Lunch, In from
Lunch, etc.).

NOTE: The Swipe & Go feature is enabled in
the Main Company configuration screen. See
Main Company, page 28.

Use feedback
enhancer
Select this check box to use the optional
Feedback Enhancer (if applicable). If the
Feedback Enhancer is not being used, do
not select this check box.

NOTE: The TA500 series clocks need to be
wired for bells and access for this feature to
work.

Display idle time in
military format
Click this check box to display the clock’s idle
time in military format (i.e. a 24-hour format).
Clear this box to display the clock’s idle time
in standard format (i.e. a 12-hour clock). In
both cases, the time is displayed using the
HH:MM:SS format.
Skip recording of diagnostic and programming info

Check this box to skip recording the Diagnostic and Programming information that display on the Diag Info and Prog Info tabs.

These two files are created and written to each time a clock is communicated with and programmed using TA100 Pro. This information is used for troubleshooting communication problems. These files slow the polling process down, although not noticeably, and can be turned off by checking the box.

NOTE: Turning off these files will make it difficult to troubleshoot certain communication problems.

Print Transactions as they occur

If a printer is connected to the time clock’s serial port (TA500) or parallel port (TA620), check this box to print time transactions as they are entered at the terminal. Uncheck this box if a printer is not attached to the clock or you do not wish print transactions.

Line Feed After

Controls how many lines should feed after the receipt has printed.

Header line 1

Enter the first line of the header you wish to print on all transaction listings printed directly from the terminal. Up to 40 characters may be entered in this field. The default is blank indicating Header line 1 will not be printed.

Header line 2

Enter the second line of the header you wish to print on all transaction listings printed directly from the terminal. Up to 40 characters may be entered in this field. The default is blank indicating Header line 2 will not be printed.

Download Bell Schedule

Check this box to download a pre-defined Bell Schedule to this clock. This option is only available with the Bell Schedule module.

4. NOTE: This tab will only apply to TA7000 Clocks using the fingerprint option.

The Assignments tab lists the employees that can use this clock. This is only necessary if you are using fingerprints with TA7000 clocks.
The tab contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Listing</td>
<td>Displays a list of the employees that can use this clock. Includes: employee code, employee name, employee badge number, verification, authority level and if they have a fingerprint template saved.</td>
</tr>
<tr>
<td>Fingerprint Mode</td>
<td><strong>Verify</strong>: This option will only verify employee number with fingerprint.</td>
</tr>
<tr>
<td></td>
<td><strong>Identify</strong>: This option will identify employee from the fingerprint only.</td>
</tr>
<tr>
<td>Division</td>
<td>Click this button to select employees based on Division. Employees selected are assigned the default Authority and Verification automatically.</td>
</tr>
<tr>
<td>Group</td>
<td>Click this button to select employees based on Group. Employees selected are assigned the default Authority and Verification automatically.</td>
</tr>
<tr>
<td>Remove All</td>
<td>Click this button to remove all employees currently assigned to the clock.</td>
</tr>
<tr>
<td>Add All</td>
<td>Click this button to assign all employees to the clock. Employees selected are assigned the default Authority and Verification automatically.</td>
</tr>
<tr>
<td>Add</td>
<td>Click this button to select employees individually. You will be prompted to select the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Authority</strong>: The Authority Level defines which clock menus employee can view or use at the clock. The following options are available: Employee, Supervisor or Configuration.</td>
</tr>
<tr>
<td></td>
<td><strong>Verification</strong>: The Verification Level defines the false read threshold.</td>
</tr>
</tbody>
</table>
TA715, TA777 and TA780 Series

Configuration of the TA715 Series, TA777 Series and TA780 Series time clocks is virtually identical. For this reason, they are combined into one section.

Since multiple clocks can be defined in the TA100 Pro, a copy feature is available to copy an existing clock’s parameters when adding a new clock. This eliminates the need to re-enter an entirely new clock configuration.

Configure a TA715/TA777/TA780 Series Clock

1. Click the Communications menu, Configure, TA715 or TA777 or TA780. The Configure Clock dialog box will open. The dialog box contains several tabs, all of which are described below.

2. The General tab defines the communication and general operation settings and contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter a unique code (up to 4 characters) to identify the clock. Once defined, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description of the clock. This description will be seen in the system and on reports. This field can be used to describe the clock type and it’s location in your facility (i.e. TA715 in BUILDING TWO). The clock description can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the clock is currently in use. Uncheck this box if the clock is not being used at this time.</td>
</tr>
</tbody>
</table>
Readers None or Finger

THIS WILL ONLY SHOW FOR THE TA780 SERIES

Only select finger of the clock will accept fingerprints.

Path

Select the type of connection this clock will use. The options are:

- Direct (RS232)
- LAN (RS485)
- Modem
- Ethernet (External)

For more information on these connections, see Types of Connections, page 195.

Port

Select the communications port on your computer that will be used to communicate with the clock. The factory default is COM 1.

Serial Baud

This is the Direct connection (RS232) in the Communication Path field.

- RS232 Baud = 19200 for all clocks

Lan

These settings become available when LAN has been chosen as the communication type in the Communication Path field.

Baud Rate

The default is 19200 baud. Make sure the baud rate selected here matches the baud rate defined at the clock. All clocks use 19200 for LAN.

LAN ID

Enter the clock’s unique identification number in this field. This number provides a way for the system to distinguish between individual clocks. Any one-character (alphabetic or numeric) ID may be used. Make sure the LAN ID defined here matches the LAN ID defined at the clock.

Ethernet

These settings define how an Ethernet clock will communicate with TA100 Pro.

IP Address

Enter the IP address assigned to the Etherlink converter. DO NOT enter leading zeros.

IP Port

Displays the port used on the Etherlink Converter. The default is 3734 and should not be changed. Altering this number will result in communication failure, and the possibility of only being able to connect to the Etherlink Converter serially.

Modem

These settings define how a modem clock will communicate with TA100 Pro.
**Baud Rate**
Select the modem’s communication speed. Make sure the baud rate selected here matches the baud rate defined at the clock.

**Phone Number**
Enter the phone number the PC modem must dial to communicate with this clock. The number must be entered in the following format:

- **Outside Line Access Code, Wait Symbol, Area Code, Phone Number**

If no outside line is required (such as 9), simply enter the phone number. Omit the area code if not applicable. On most modems, the wait symbol is a comma (,), typically representing a one second pause. Multiple wait symbols can be used if necessary.

**Start/Stop Answer**
These fields control the time of day the clock’s internal modem will answer an incoming call. Enter the modem’s start and stop answer time in military format (HH:MM).

For example, to set the modem to answer only between 7:00 A.M. and 6:00 P.M., enter 07:00 and 18:00 in the fields provided. The default is 00:00 (midnight) and 23:59 (one minute before midnight). In other words, the modem will answer any time it is called during the day.

**Ring Delay**
Enter the number of rings that the clock should wait before picking up the line.

For example, setting the **Ring Delay** to 4 means that after the clock detects a ringing phone; it will wait 4 rings before answering. 0 means DO NOT ANSWER.

**Number of Retries**
Enter the number of times the computer should attempt to connect to the clock if communication either fails or is interrupted during polling.

**Time Difference Between Computer and Clock**
Enter the time difference (in hours) between the computer and time clock. Since the computer can set the clock’s time, this field compensates for time zone differences between the computer’s location and the clock’s location. When the clock’s time is set, the system either adds or subtracts this time difference from the computer’s clock.

A setting of 0 indicates that the clock and computer are in the same time zone.

**Division**
Select the company division where the clock is located. Every transaction entered on this clock is tagged with this division code.
### Supervisor

These options define supervisor settings for the clock.

**Default Date**

Check this box to automatically use the clock’s current date for transactions added using a supervisor’s badge. When this check box is clear, the clock prompts the supervisor for the date of any new transactions.

**Default Time**

Check this box to automatically use the clock’s current time for transactions added using a supervisor’s badge. When this check box is clear, the clock prompts the supervisor for the time of any new transactions.

### Input

These settings determine how data can put entered into the clock.

**Initial Source**

Check the applicable check box(es) to indicate the method by which an employee badge number is entered into the clock.

- **Swipe**
  The employee’s badge number can be entered by swiping a badge.

- **Key**
  The employee’s badge number can be entered by pressing keys on the clock keypad.

- **Bar Code**
  The employee’s badge number can be entered by scanning a bar code.

**Employee Badge Source By Supervisor**

Check the applicable check box(es) to indicate the method by which a supervisor (in supervisor mode) can enter employee badge number into the clock.

- **Swipe**
  The employee’s badge number can be entered by swiping a badge.

- **Key**
  The employee’s badge number can be entered by pressing keys on the clock keypad.

- **Bar Code**
  The employee’s badge number can be entered by scanning a bar code.

---

3. The *Configure* tab defines the message and timeout settings and contains the following information:
**Figure 172: Configure TA715/TA777/TA780 Clocks: Configure Tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time-Outs</strong></td>
<td>These settings determine how long prompts and messages will appear on the clock’s screen.</td>
</tr>
<tr>
<td><strong>For data input</strong></td>
<td>Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to a prompt before returning to an idle state.</td>
</tr>
<tr>
<td></td>
<td>Time is entered in seconds and tenths of a second. For example, 10.0 means that the clock will wait 10 seconds for a response after prompting for input. The default is 60.0 seconds.</td>
</tr>
<tr>
<td><strong>To Enter function</strong></td>
<td>Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to enter a function before returning to an idle state.</td>
</tr>
<tr>
<td></td>
<td>Time is entered in seconds and tenths of a second. For example, 5.5 means that the clock will wait 5½ seconds for a response after prompting for input. The default is 20.0 seconds.</td>
</tr>
<tr>
<td><strong>Displayed messages</strong></td>
<td>Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any message before returning to an idle state.</td>
</tr>
<tr>
<td></td>
<td>Time is entered in seconds and tenths of a second. For example, 1.5 means that the clock will display messages for 1½ seconds. The default is 2.0 seconds.</td>
</tr>
</tbody>
</table>
**Supervisor questions**

Enter the length of time (from **0.1** to **99.9** seconds) the clock will wait for a response to a supervisor question before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, **30.0** means that the clock will wait 30 seconds for a supervisor’s response to a question such as “Employee Badge #”. The default is **90.0** seconds.

**Error messages**

Enter the length of time (from **0.1** to **99.9** seconds) the clock will display any error message before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, **1.0** means that the clock will display error messages for one second. The default is **1.5** seconds.

**Messages**

These settings define the text prompts for certain operations at the clock.

**Enter Function**

This field allows you to replace the default ENTER FUNCTION message with a custom message (up to 16 characters in length).

This message is displayed after swiping a badge or entering a badge number at the clock.

**Invalid Source**

This field allows you to replace the standard INVALID SOURCE message with a custom message (up to 16 characters in length).

This message will display when an input source is used that the terminal has been programmed to ignore. For example, the employee uses a magnetic strip badge to punch in when only keypad entry is recognized.

**Invalid Badge**

This field allows you to replace the standard INVALID BADGE message with a custom message (up to 16 characters in length).

An INVALID BADGE message displays when a badge or card other than the specified badge length is used.

**Invalid Level**

This field allows you to replace the default INVALID LEVEL message with a custom message.

This message is displayed when Validation is used, and an invalid level number is entered. It cannot be more than 16 characters.
**Idle Message**

Enter the message text that displays on the time clock when in an idle state. If this field is left blank, no message will be displayed.

It can accept a one-line message that is up to 16 characters.

**Use Swipe & Go**

Select this feature to activate swipe and go in the clock.

**NOTE:** The Swipe & Go feature is enabled in the Main Company configuration screen. See *Main Company*, page 28.

**Skip recording of diagnostic and programming info**

Check this box to skip recording the Diagnostic and Programming information that display on the *Diag Info* and *Prog Info* tabs.

These two files are created and written to each time a clock is communicated with and programmed using TA100 Pro. This information is used for troubleshooting communication problems. These files slow the polling process down, although not noticeably, and can be turned off by checking the box.

**NOTE:** Turning off these files will make it difficult to troubleshoot certain communication problems.

**Display idle time in military format**

Click this check box to display the clock’s idle time in military format (i.e. a 24-hour format). Clear this box to display the clock’s idle time in standard format (i.e. a 12-hour clock). In both cases, the time is displayed using the HH:MM:SS format.

**Proximity Offset to remove Facility code**

Enter the number of characters defining the Facility code the proximity badge should not read.

**Download Bell Schedule**

Check this box to download a pre-defined Bell Schedule to this clock. This option is only available with the Bell Schedule module.

4. **NOTE:** This tab will only apply to **TA780 Clocks** using the *fingerprint* option.

   The *Assignments* tab lists the employees that can use this clock. This is only necessary if you are using fingerprints with TA780 clocks.
Figure 173: Configure TA780 Clocks: Assignments tab

The tab contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee Listing</strong></td>
<td>Displays a list of the employees that can use this clock. Includes: employee code, employee name, employee badge number, special enrollment and if they have a fingerprint template saved.</td>
</tr>
<tr>
<td><strong>Fingerprint Mode</strong></td>
<td><strong>Verify</strong>: This option will only verify employee number with fingerprint.</td>
</tr>
<tr>
<td></td>
<td><strong>Identify</strong>: This option will identify employee from the fingerprint only.</td>
</tr>
<tr>
<td><strong>Division</strong></td>
<td>Click this button to select employees based on Division. Employees selected are assigned the default Authority and Verification automatically.</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>Click this button to select employees based on Group. Employees selected are assigned the default Authority and Verification automatically.</td>
</tr>
<tr>
<td><strong>Remove All</strong></td>
<td>Click this button to remove all employees currently assigned to the clock.</td>
</tr>
<tr>
<td><strong>Add All</strong></td>
<td>Click this button to assign all employees to the clock. Employees selected are assigned the default Authority and Verification automatically.</td>
</tr>
</tbody>
</table>

**NOTE**: If you use this method to choose employees, you may want to Edit the employee in order to choose another Authority and Verification.
Setting | Definition
--- | ---
Add | Click this button to select employees individually. You will be prompted to select the following:
Authority: The Authority Level defines which clock menus employee can view or use at the clock. The following options are available: Employee, Supervisor or Configuration.
Verification: The Verification Level defines the false read threshold.

Configuring PC Clock

Configuration of the PC Clock is done under the TA600 Series time clock. The PC Clock can use **Messaging**.

Since multiple clocks can be defined in the TA100 Pro, a copy feature is available to copy an existing clock’s parameters when adding a new clock. This eliminates the need to re-enter an entirely new clock configuration.

Configure a PC Clock

1. Click the **Communications** menu, **Configure, TA600**. The **Configure Clock** dialog box will open. The dialog box contains several tabs, all of which are described below.

2. The **General** tab defines the communication and general operation settings and contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter PC for this code.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>In this field enter PC Clock for the description.</td>
</tr>
</tbody>
</table>
**Active**  
Click the Active check box to indicate that the clock is currently in use. Uncheck this box if the clock is not being used at this time.

**Initial Source**  
Check the applicable check box(es) to indicate the method by which an employee badge number is entered into the clock.

**Swipe**  
The employee’s badge number can be entered by swiping a badge.

**Key**  
The employee’s badge number can be entered by pressing keys on the clock keypad.

**Bar Code**  
The employee’s badge number can be entered by scanning a bar code.

**Key**  
The employee’s badge number can be entered by pressing keys on the clock keypad.

3. The **Configure** tab defines the message and timeout settings and contains the following information:

![Figure 175: Configure PC Clock: Configure Tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time-Outs</strong></td>
<td>These settings determine how long prompts and messages will appear on the clock’s screen.</td>
</tr>
<tr>
<td><strong>For data input</strong></td>
<td>Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to a prompt before returning to an idle state. Time is entered in seconds and tenths of a second. For example, 10.0 means that the clock will wait 10 seconds for a response after prompting for input. The default is 60.0 seconds</td>
</tr>
</tbody>
</table>
To Enter function

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to enter a function before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, 5.5 means that the clock will wait 5½ seconds for a response after prompting for input. The default is 20.0 seconds.

Displayed messages

Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any message before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, 1.5 means that the clock will display messages for 1½ seconds. The default is 2.0 seconds.

Supervisor questions

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a response to a supervisor question before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, 30.0 means that the clock will wait 30 seconds for a supervisor's response to a question such as “Employee Badge #”. The default is 90.0 seconds.

Error messages

Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any error message before returning to an idle state.

Time is entered in seconds and tenths of a second. For example, 1.0 means that the clock will display error messages for one second. The default is 1.5 seconds.

Messages

These settings define the text prompts for certain operations at the clock.

Enter Function

This field allows you to replace the default ENTER FUNCTION message with a custom message (up to 16 characters in length).

This message is displayed after swiping a badge or entering a badge number at the clock.

TASC

The TASC terminal is similar to the TA500 and TA600 Series in that it collects punches and transmits them to the software via the polling process. However, TASC is a stand-alone time clock. This means that it does not require a PC to calculate and record employee’s time.

TASC is perfect for situations in which a remote site performs its own transaction editing, while payroll and other functions are processed at a central location. The remote site can print
transactions from the clock locally; the central location can connect to clock only when it needs to retrieve data to process data and run reports.

Since TASC are "stand-alone" clocks, they will not receive Policy and employee information in the same way that other clocks do. As part of the configuration of the clock, you will define the rounding, lockout, and overtime policies, as well as list which employees may use this clock. This information is then programmed into the clock.

Configure a TASC Clock

1. Click the Communications menu, Configure, TASC. The Configure Clock dialog box will open. The dialog box contains several tabs, all of which are described below.

![Configure a TASC Clock](image)

2. The General tab defines the communication and general operation settings and contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter a unique code (up to 4 characters) to identify the clock. Once defined, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description of the clock. This description will be seen in the system and on reports. This field can be used to describe the clock type and its location in your facility (i.e. TASC In BUILDING TWO). The clock description can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the clock is currently in use. Uncheck this box if the clock is not being used at this time.</td>
</tr>
</tbody>
</table>
**Path**
Select the type of connection this clock will use. The options are:

- Direct (RS232)
- LAN (RS485)
- Modem (Internal)
- Serial LAN (Smart Converter)
- Remote Direct (External Modem)
- Modem LAN (Smart Converter)

See *Types of Connections*, page 195.

**Port**
Select the communications port on your computer that will be used to communicate with the clock. The factory default is COM 1.

**Serial Baud**
This setting is for RS232 communication. The factory default is 9600.

**Lan**
These settings become available when LAN has been chosen as the communication type in the Communication Path field.

**Baud Rate**
Select the applicable communication speed. The default is 9600 baud. Make sure the baud rate selected here matches the baud rate defined at the clock.

**TIP**: You can use the Configuration Badge (000000000) at the clock to view/modify the clock’s baud rate.

**LAN ID**
Enter the clock’s unique identification number in this field. This number provides a way for the system to distinguish between individual clocks. Any one-character (alphabetic or numeric) ID may be used. Make sure the LAN ID defined here matches the LAN ID defined at the clock.

**TIP**: You can use the Configuration Badge (000000000) at the clock to view/modify the clock’s LAN ID.

**Converter**
Select the type of converter used in the LAN setup.

The RTS converters have been phased out over the years and were mainly used with AT style computers that used a 25 pin serial port. Most new computers use 9 pin serial ports that connect to the newer SD style converters. If you are unsure which you have, contact your dealer.

**Baud Rate**
Select the modem's communication speed. The default baud rate for the TASC clock is 1200. Make sure the baud rate selected here matches the baud rate defined at the clock.
**Phone Number**
Enter the phone number the PC modem must dial to communicate with this clock. The number must be entered in the following format:

**Outside Line Access Code, Wait Symbol, Area Code, Phone Number**

If no outside line is required (such as 9), simply enter the phone number. Omit the area code if not applicable. On most modems, the wait symbol is a comma (,) typically representing a one second pause. Multiple wait symbols can be used if necessary.

**Start/Stop Answer**
These fields control the time of day the clock’s internal modem will answer an incoming call. Enter the modem’s start and stop answer time in military format (HH:MM).

For example, to set the modem to answer only between 7:00 A.M. and 6:00 P.M., enter 07:00 and 18:00 in the fields provided. The default is 00:00 (midnight) and 23:59 (one minute before midnight). In other words, the modem will answer any time it is called during the day.

**Ring Delay**
Enter the number of rings that the clock should wait before picking up the line.

For example, setting the **Ring Delay** to 4 means that after the clock detects a ringing phone; it will wait 4 rings before answering. 0 means DO NOT ANSWER.

**Number of Retries**
Enter the number of times the computer should attempt to connect to the clock if communication either fails or is interrupted during polling.

**Time Difference Between Computer and Clock**
Enter the time difference (in hours) between the computer and time clock. Since the computer can set the clock’s time, this field compensates for time zone differences between the computer’s location and the clock’s location. When the clock’s time is set, the system either adds or subtracts this time difference from the computer’s clock.

A setting of 0 indicates that the clock and computer are in the same time zone.

**Division**
Select the company division where the clock is located. Every transaction entered on this clock is tagged with this division code.

**Supervisor Badge**
Enter the badge number that activates the Supervisor mode of the clock.
3. The **Policies** tab defines the rounding lunch and break policies for the employees using this clock. These are not the same as the company policies set up under the **Configure** menu, but rather policies that are transferred to the clock when it is programmed. Up to 15 different policies can be defined for the TASC terminal. Any company policy that is not defined here is not downloaded to the TASC.

![Figure 177: Configure TASC Clock: Policies tab](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Policies</strong></td>
<td>Displays a list of the 15 available policies. Select the policy you wish to configure.</td>
</tr>
<tr>
<td><strong>Shift Starts HH:MM</strong></td>
<td>Enter the time of day (HH:MM) the shift starts for employees. Enter the time in military format. The default is 08:00 or 8:00 A.M.</td>
</tr>
<tr>
<td><strong>Round forward to start MM</strong></td>
<td>Enter the number of minutes before the shift’s start time that punches are rounded forward to the shift’s start. A maximum of 99 minutes may be entered. The default is 30 minutes.</td>
</tr>
<tr>
<td><strong>Grace back to start MM</strong></td>
<td>Enter the number of minutes after the shift’s start time that punches are rounded back (in grace) to the shift’s start. A maximum of 99 minutes may be entered. The default is 5 minutes.</td>
</tr>
<tr>
<td><strong>Shift Stops HH:MM</strong></td>
<td>Enter the time of day (HH:MM) the shift ends for employees. Enter the time in military format. The default is 17:00 or 5:00 P.M.</td>
</tr>
<tr>
<td><strong>Grace forward to stop MM</strong></td>
<td>Enter the number of minutes before the shift’s stop time that punches are rounded forward to the shift’s stop. A maximum of 99 minutes may be entered. The default is 5 minutes.</td>
</tr>
<tr>
<td><strong>Round back to stop MM</strong></td>
<td>Enter the number of minutes after the shift’s stop time that punches are rounded back to the shift’s stop. A maximum of 99 minutes may be entered. The default is 30 minutes.</td>
</tr>
</tbody>
</table>
| **Lockout begins**  
**HH:MM** | Enter the start time (HH:MM) of this policy's employee lockout. Enter the time in military format. If the lockout begin and lockout end times are 00:00, no lockout takes place. The default is 00:00. Any employee that enters a punch between these lockout times receives the message SEE SUPERVISOR. Only by swiping a supervisor badge can you override the lockout and accept the punch. |
| **Lockout ends**  
**HH:MM** | Enter the stop time (HH:MM) of this policy's employee lockout. Enter the time in military format. If the lockout begin and lockout end times are both 00:00, no lockout takes place. The default is 00:00 or not used. Any employee that enters a punch between these lockout times receives the message SEE SUPERVISOR. Only by swiping a supervisor badge can you override the lockout and accept the punch. |
| **Outside Round in Minutes** | Enter the increment to which punches that fall outside of the rounding to schedule should round.  
For example, if 6 is selected in this field, time is rounded to the nearest 6 minutes. Punches between 0 and 3 minutes are rounded back to the last increment; punches between 4 and 6 minutes are rounded forward to the next increment. The default is 15. |
| **Daily OT** | Enter the length of time (HH:MM) an employee has to work in one day before overtime is applied. For example, if 8:00 is entered in this field, any hours worked over 8 hours a day is counted as overtime. The default is 00:00. |
| **Weekly OT** | Enter the length of time (HH:MM) an employee has to work in one week before overtime is applied. For example, if 40:00 is entered in this field, any hours worked over 40 hours a week is counted as overtime. The default is 40:00. |
**Link Back Time**

**HH:MM**

Enter the maximum time (HH:MM) an employee who has punched Out can punch back In and still have the new time included in the previous total.

For example, the **Link Back Time** is set to **2:00** and overtime is paid after working 8 hours in a single day. An employee punches In at 8:00 A.M. and Out at 5:00 P.M. with a one hour unpaid lunch. If the employee punches back In at 6:30 P.M. (within the 2-hour link-back time) and out at 9:30 P.M., the daily total shows 8 hours of regular time and 3 hours of overtime.

**Tip Punches**

Check this box to enter tips at the clock for this policy. Clear this box if no tips are entered at the clock.

**Lunch Punches**

Check this box to allow employees to punch In and Out for lunch. Clear this box if employees do not punch for lunches.

**Pay Lunch**

Check this box if employee lunches are paid. Paid lunches are not deducted from the shift's total hours. Clear this check box if employee lunches are not paid.

**Lunch Duration MM**

Enter the lunch period duration in minutes for this policy. The default is **60** minutes or one hour.

**Deduct Lunch after HH:MM**

The lunch duration specified is automatically deducted from daily total hours after this length of time is worked. The default is **5:00**.

In other words, after 5 hours of worked time, the value in **Lunch Duration** is deducted from the total hours for that day.

**Grace Lunch MM**

Enter the number of minutes over **Lunch Duration** that is “in graced.” For example, if **05** is entered here and **60** in **Lunch Duration**, any employee that punches In from Lunch within 65 minutes from punching Out, is not considered late. The default is **05** or 5 minutes.

**Lunch Minimum MM**

Enter the minimum number of minutes an employee must take for lunch to be deducted. Punching Out for Lunch and back In within this time is not counted toward lunch. The default is **05** or 5 minutes.

4. The **TASC Employee** tab lists the employees that can use this clock and contains the following information:
**Figure 178: Configure TASC Clock: Employee tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee Listing</strong></td>
<td>Displays a list of the employees that can use this clock. Includes their Employee ID, Employee Name, Employee Badge, the policy the employee is assigned to, the department, and if their information will be exported to your payroll provider.</td>
</tr>
<tr>
<td><strong>Division</strong></td>
<td>Click this button to select employees based on Division. Employees selected are assigned the default Policy and Department automatically. <strong>NOTE</strong>: If you use this method to choose employees, you may want to Edit the employee in order to choose another Policy or Department.</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>Click this button to select employees based on Group. Employees selected are assigned the default Policy and Department automatically. <strong>NOTE</strong>: If you use this method to choose employees, you may want to Edit the employee in order to choose another Policy or Department.</td>
</tr>
<tr>
<td><strong>Remove All</strong></td>
<td>Click this button to remove all employees currently assigned to the clock.</td>
</tr>
<tr>
<td><strong>Add All</strong></td>
<td>Click this button to assign all employees to the clock. Employees selected are assigned the default Policy and Department automatically. <strong>NOTE</strong>: If you use this method to choose employees, you may want to Edit the employee in order to choose another Policy or Department.</td>
</tr>
</tbody>
</table>
Add Click this button to select employees individually. You will be prompted to select the TASC Policy (as defined on the previous tab) and Department.

Edit Click this button to edit the employee’s badge number, policy or department.

Delete Click this button to remove the employee from the list.

5. The Diag Info tab contains the communication information between the computer and the clock after each attempt to communicate.

6. The Prof Info tab contains the information that was sent to the clock after any type of programming.

ATS Series Clocks

TA100 Pro offers a module that allows it to connect to Third Party clocks such as ATS and Hand Reader. The ATS clocks are badge-swipe clocks similar to the TA500 and TA600 series.

Configure ATS Clocks

1. Click the Communications menu, Configure, ATS. The Configure Clocks dialog box will open. The Configure dialog box contains several tabs, all of which are described below.

![Figure 179: Configure ATS Clock](image)

2. The General tab defines communication and operation settings and contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>This is a required field. Enter a unique code (up to 4 characters) to identify the clock. Once defined, this code cannot be changed.</td>
</tr>
<tr>
<td>ID</td>
<td>Enter a unique ID number to identify the clock. This number will also be programmed into the clock.</td>
</tr>
</tbody>
</table>
**Description**

Enter a description of the clock. This description will be seen in the system and on reports. This field can be used to describe the clock type and its location in your facility (i.e., ATS in BUILDING TWO). The clock description can be up to 30 characters long.

**Active**

Click the Active check box to indicate that the clock is currently in use. Uncheck this box if the clock is not being used at this time.

**RS485 or Serial**

Select this option to choose an RS485 or RS232 connection.

**Modem**

Select this option to choose a modem solution.

**Ethernet**

Select this option to choose an Ethernet solution.

**Baud Rate**

Select the applicable communication speed. Make sure the baud rate selected here matches the baud rate defined at the clock.

- **RS485, Serial and Ethernet**: 9600 baud
- **Modem**: 2400 baud

**Comm Port**

Select the communications port on your computer that will be used to communicate with the clock. The factory default is COM 1.

**Retries**

Enter the number of times the computer should attempt to connect to the clock if communication either fails or is interrupted during polling.

**Connect wait**

The value entered into this field specifies the greatest amount of time TA100 Pro will wait before deciding the clock is unable to be reached and will time out. This value is minutes and tenths of minutes.

Connect wait minutes is used solely for Ethernet communication. ATS series clocks do not respond immediately to a communication query across Ethernet communication, instead, they broadcast continuously on a 30-second cycle. Depending on the speed of the network used, the amount of time needed for the attention signal sent from TA100 Pro to reach the clock, the clock to finish its' 30 second cycle, and send a signal back, can fluctuate greatly.
**Hayes compatible modem**

Check whether the modem used to call the clock is Hayes Compatible. Hayes Corporation is one of the founders of modem technology and as a result some modems list themselves as Hayes Compatible. If not sure, try both configurations. Refers to modem connected to this computer. Needed only if modem communication will be used.

**Modem number**

Enter the phone number the PC modem must dial to communicate with this clock. The number must be entered in the following format:

**Outside Line Access Code, Wait Symbol, Area Code, Phone Number**

If no outside line is required (such as 9), simply enter the phone number. Omit the area code if not applicable. On most modems, the wait symbol is a comma (,) typically representing a one second pause. Multiple wait symbols can be used if necessary.

**IP Address**

Enter the IP address assigned to the clock.

**IP Port**

Displays the port used for Ethernet. The default is 2500 and should not be changed. Altering this number will result in communication failure, and the possibility of only being able to connect to the Etherlink Converter serially.

**Time difference between clock and computer**

Enter the time difference (in hours) between the computer and time clock. Since the computer can set the clock’s time, this field compensates for time zone differences between the computer’s location and the clock’s location. When the clock’s time is set, the system either adds or subtracts this time difference from the computer’s clock.

A setting of 0 indicates that the clock and computer are in the same time zone.

**Division**

Select the company division where the clock is located. Every transaction entered on this clock is tagged with this division code.

**Idle Message**

Enter the message text that displays on the time clock when in an idle state. If this field is left blank, no message will be displayed.

**Keyboard entry**

Check this box to allow employees to enter badge numbers and other data (such as department numbers) on the clock’s keypad.

**Supervisor functions**

Check this box to allow supervisor functions, such as entering punches, at the clock.
**Swipe & Go**  
Check this box to make the clock Swipe & Go. The system then determines whether the individual punch was an In or an Out, based on the last punch the employee did.

**For data input**  
Enter the length of time (duration) the employee will have to enter information after the badge is swiped.

**Displayed messages**  
Enter the length of time (duration) the message displays on the time clock in seconds. For example, 2 means the message displays for two seconds. The maximum message timeout is 9 seconds. If 0 is entered, no message displays.

**Download messages**  
Check this box to download employee messages to the clock for display when they punch in. If an employee does not have a message assigned to them, and this is checked, they will not be able to punch in on an ATS series clock.

### Hand Reader Clocks

The Hand Reader biometric terminals are powerful computers capable of Hand Geometry recognition. These devices collect clock data for TA100 Pro.

**NOTE:** Hand Reader Clocks are not Third Party Terminals; therefore they do not require a separate module.

### Configure a Hand Reader Clock

1. Click the **Communications** menu, **Configure, Hand Reader**. The **Configure Clocks** dialog box will open. The **Configure** dialog box contains several tabs, all of which are described below.

   ![Configure Hand Reader Clock](Image)

   **Figure 180: Configure Hand Reader Clock**

2. The **General** tab configures communication settings and contains the following information:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td>This is a required field. Enter a unique code (up to 4 characters) to identify the clock. Once defined, this code cannot be changed.</td>
</tr>
<tr>
<td><strong>ID</strong></td>
<td>Enter a unique ID number to identify the clock. This number will also be programmed into the clock.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description of the clock. This description will be seen in the system and on reports. This field can be used to describe the clock type and its location in your facility (i.e. HP3000 in BUILDING TWO). The clock description can be up to 30 characters long.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Click the Active check box to indicate that the clock is currently in use. Uncheck this box if the clock is not being used at this time.</td>
</tr>
<tr>
<td><strong>Model</strong></td>
<td>Select the model of your Hand Reader unit. The options:</td>
</tr>
<tr>
<td></td>
<td>• ID3D</td>
</tr>
<tr>
<td></td>
<td>• HP2000</td>
</tr>
<tr>
<td></td>
<td>• HP3000</td>
</tr>
<tr>
<td></td>
<td>• HP4000</td>
</tr>
<tr>
<td><strong>Idle Prompt</strong></td>
<td>Enter the message text that displays on the time clock when in an idle state. If this field is left blank, no message will be displayed.</td>
</tr>
<tr>
<td><strong>RS485 or Serial</strong></td>
<td>Select this option to choose an RS485 or RS232 connection.</td>
</tr>
<tr>
<td><strong>Modem</strong></td>
<td>Select this option to choose a modem solution.</td>
</tr>
<tr>
<td><strong>Ethernet</strong></td>
<td>Select this option to choose an Ethernet solution.</td>
</tr>
<tr>
<td><strong>Baud Rate</strong></td>
<td>Select the applicable communication speed. Make sure the baud rate selected here matches the baud rate defined at the clock.</td>
</tr>
<tr>
<td></td>
<td>• Rs485, Serial and Ethernet: 9600 baud</td>
</tr>
<tr>
<td></td>
<td>• Modem: 9600 baud</td>
</tr>
<tr>
<td><strong>Comm Port</strong></td>
<td>Select the communications port on your computer that will be used to communicate with the clock. The factory default is COM 1.</td>
</tr>
<tr>
<td><strong>Retries</strong></td>
<td>Enter the number of times the computer should attempt to connect to the clock if communication either fails or is interrupted during polling.</td>
</tr>
</tbody>
</table>
**Modem number**  
Enter the phone number the PC modem must dial to communicate with this clock. The number must be entered in the following format:

**Outside Line Access Code, Wait Symbol, Area Code, Phone Number**

If no outside line is required (such as 9), simply enter the phone number. Omit the area code if not applicable. On most modems, the wait symbol is a comma (,) typically representing a one second pause. Multiple wait symbols can be used if necessary.

**IP Address**  
Enter the IP address assigned to the Etherlink converter.

**IP Port**  
Displays the port used for Ethernet. The default is 300 and should not be changed. Altering this number will result in communication failure.

**Time difference between clock and computer**  
Enter the time difference (in hours) between the computer and time clock. Since the computer can set the clock’s time, this field compensates for time zone differences between the computer’s location and the clock’s location. When the clock’s time is set, the system either adds or subtracts this time difference from the computer’s clock.

A setting of 0 indicates that the clock and computer are in the same time zone.

**Division**  
Select the company division where the clock is located. Every transaction entered on this clock is tagged with this division code.

3. The **Time Zones** tab sets time periods during which the clock can be used. When a person is entered into the Hand Reader, they must be assigned a Time Zone. Up to 60 Time Zones can be configured per clock. HP2000 Hand Punch clocks do not support Time Zones. 4 windows for punching may be setup for each Time Zone. By default, the Hand Punch allows punches at any time.

The Time Zones table contains the following information:
Table of Contents

1. Time Zones

2. Description

3. Access Windows

4. Start

5. Stop

6. Day of the Week

4. The Assignments tab lists the employees that can use this clock. This is necessary because the Hand Reader clocks take measurements of an employee’s hand. Each time the employee punches, the reader compares the employee’s hand to the existing template. Employee information and hand templates are stored in the Hand Reader clock. For this reason, employees must be assigned to a clock so their name and template will be downloaded to the correct clock.

The tab contains the following information:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee Listing</strong></td>
<td>Displays a list of the employees that can use this clock. Includes: employee ID, employee name, employee badge number, assigned time zone, personal reject threshold, authority level, and if they have a hand template saved.</td>
</tr>
</tbody>
</table>
| **Division** | Click this button to select employees based on Division. Employees selected are assigned the default Time Zone, Reject Threshold, and Authority automatically.  

**NOTE:** If you use this method to choose employees, you may want to Edit the employee in order to choose another Time Zone, Reject Threshold, and Authority Level. |
| **Group** | Click this button to select employees based on Group. Employees selected are assigned the default Time Zone, Reject Threshold, and Authority automatically.  

**NOTE:** If you use this method to choose employees, you may want to Edit the employee in order to choose another Time Zone, Reject Threshold, and Authority Level. |
| **Remove All** | Click this button to remove all employees currently assigned to the clock. |
| **Add All**  | Click this button to assign all employees to the clock. Employees selected are assigned the default Time Zone, Reject Threshold, and Authority automatically.  

**NOTE:** If you use this method to choose employees, you may want to Edit the employee in order to choose another Time Zone, Reject Threshold, and Authority. |
Add

Click this button to select employees individually. You will be prompted to select the following:

**Time Zone:** Select the Time Zone (defined on the previous tab) that applies to this employee.

**Reject Override:** The reject threshold indicates how closely the hand has to match the original scanned hand template. The lower the number, the more exact the match needs to be.

0 is default and indicates that the default clock threshold (set on the Miscellaneous tab) will be used.

**Authority Level:** The Authority Level defines which clock menus employee can view or use at the clock. 0 is the lowest (employee) and default, 5 is the highest and allows complete at-the-clock setup (supervisor).

Add a Clock

1. Click the **Communications** menu, **Configure**, and select the type of clock you wish to add. The **Configure Clock** dialog box will open.

2. Click the **Add** button. If this is the first clock of this type that you are adding, the **General** tab will become available.

3. Fill in the settings as described in the Configure section for the type of clock you are adding. TA500/600, PC Clock page 196; ATS, page 224; Hand Reader, page 227.

4. If there is already a clock of this type defined, the **Default Clock Add** dialog box will open.
5. Highlight the clock whose settings you would like to copy or click No to start from scratch.

6. Enter a unique code for this clock, up to four characters.

7. Enter a Description of the clock (i.e., Warehouse, Back Office, California, etc.)

8. Click the Yes button to continue. You will be returned to the General tab.

9. Fill in the settings as described in the Configure section for the appropriate clock. See TA500/600, page 196; ATS, page 224; Hand Reader, page 227.

10. When all settings are complete, click OK to commit the changes.

**Edit a Clock**

1. Click the Communications menu, Configure and select the type of clock you wish to edit. The Configure Clock dialog box will open.

2. Highlight the Clock you wish to edit using the drop-down list at the top of the screen.

3. Click the Edit button. The General screen will become available for you to edit the selected category.

4. Edit the settings as described in the Configure Clock section for the clock you are editing.

5. When all settings are complete, click OK to commit the changes.

**Delete a Clock**

1. Click the Communications menu, Configure and select the type of clock you wish to edit. The Configure Clock dialog box will open.

2. Highlight the Clock you wish to edit using the drop-down list at the top of the screen.

3. Click the Delete button. You will be prompted:
4. Click **OK** to confirm the deletion.

5. Click **Close** to exit the *Configure Clock* dialog box.

### Set Date and Time

The Set Date and Time function synchronizes the date and time of the terminals with the computer that is running the software. You can set the date and time on one or more clocks. However, all clocks must be defined in *Clock Maintenance* before the date and time is set.

Before using this function, the host computer must be set to the correct date and time. Otherwise, all clock transactions will have an incorrect date and time stamp (although admittedly they'll all be synchronized).

**NOTE:** It is recommended that you do not perform this function during periods of high clock activity (such as the start of day when employees are clocking In).

1. Click the **Communications** menu, **Set Date and Time**. The *Set Date and Time Clock Selection* dialog box will open.

2. Select the clock(s) for which you wish to set the date and time by using the **Add** button to add the selected clock individually, or **Add All** to add all clocks.

3. Click the **Date/Time** button to display the *Windows Date/Time Properties* dialog box.
4. If necessary, edit the date and time to be accurate and click OK.

5. Click the Set Time button to commit the changes.

6. When TA100 Pro has finished sending the Date and Time to clock, click Close to exit the dialog box.
Chapter XII  Terminal Polling and AutoProcessing

This section describes the concepts and techniques associated with polling clocks and setting up Auto Processes.

Polling is the process of communicating data to and from the clock, including transferring employee time transactions and other data from the clocks to the host computer (PC) for processing. Clocks can be manually polled or automatically polled on a pre-defined schedule.

AutoProcessing allows certain common tasks to be run automatically. Polling, Reports, custom files, and Reindexing can set to Auto Process.

Polling
Polling Time Clocks

Polling is the process of communicating data back and forth between the clock and TA100 Pro. Polling can be done manually, which means a supervisor or administrator must launch the TA100 Pro software and request that the clock be polled. Polling may also be set as an auto process, which means that the TA100 Pro is responsible for communicating with the clock on a pre-defined schedule.

This section describes how to poll the clock manually.

1. Click the Communications menu, Poll. The Poll Clock Selection dialog box will open.

![Poll Clock Selection](image)

Figure 188: Poll Clock Selection

2. Select the clock(s) you wish to poll by using the Add button to add the selected clock individually, or the Add All button to add all clocks.

3. Click the Polling Options tab to select it. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Poll Transactions</strong></td>
<td>Check this option to transfer punches from the clock to TA100 Pro.</td>
</tr>
</tbody>
</table>
**Clear Clock Transactions**

Check this option to clear the transactions from the clock after transferring them to TA100 Pro.

**TIP:** This does not need to be done every time. You may leave the transactions in the clock until payroll is processed successfully, however if you have a lot of employees you will want to clear frequently so the clock does not get full.

**Set Clock Date and Time**

Check this option to send the computer’s current date and time to the clock.

**TIP:** You may not want to do this every time, as the clock’s internal clock tends to be much more accurate than the computer’s.

**Program Clock**

Check this option to send programming and configuration information (such as the settings in the Configure Clock dialog box) to the clock. Clock function keys and function messages are sent to the clock during programming.

This option should only be used when basic clock setup has been changed since the initial programming.

**Load Bell Schedules**

Check this option to send pre-defined Bell Schedule assigned to the clock.

Bell schedules are only checked at midnight, so a bell will not ring on the same day the bell schedule was downloaded. The Bell Module must be installed to use this option.

**Load Messages**

Check this option to send employee messages to the clock.

**Hand Reader**

These settings only apply to the Hand Reader clocks. The options are:

**Send Hand Templates:** Select this option to send employee hand templates to the clock. This can be used to upload a template to a new clock, or to restore templates to a clock that has been cleared.

**Clear Templates:** Check this option to clear the templates from the clock. **USE THIS OPTION VERY CAREFULLY**, as it will delete all existing templates in the clock and employees will not be able to punch until the templates are restored.

**Retrieve Hand Templates:** Check this option to download new hand templates from the clock for input into the TA100 Pro database.
**Process Punches after polling** Check this option to automatically put the punches into the online timecards of the employees.

4. Click the **Poll** button to start the polling process.

**Configure an AutoProcess**

The Auto Process feature allows you to schedule the following tasks to run automatically at predetermined times:

- Poll one or more time clocks
- Launch executable programs
- Generate reports

No user interaction is required when using the Auto Process feature. In fact, you can poll time clocks, run reports, download payroll data, and back up the TA100 Pro data without ever touching the computer. The Auto Process feature is ideal for processes that need to be performed after working hours or during less busy times of the day.

Each automatic procedure can consist of one or more auto process cycles. Each cycle can run a program, poll the time clocks, or generate a report and is assigned a time and day(s) of the week to run. To create an AutoProcess that runs several times a day, you will add several cycles: one for each time you wish the process to run.

**Run as Service**

The autoprocess can be configured to run as a service it must be installed locally as it will not run over a network. The server must run the service.

1. In Windows Explorer find the **TA100 Pro** folder. Locate and double-click **InstallAutoprocess**. A black command prompt window will flash.

2. In Windows Explorer find the **TA100 Pro** folder. Locate and double-click **autoProcess** this will install the automated User responsible for the Auto Process. A white Auto poll dialogue window will appear, but will give the message “nothing to poll.”

**NOTE:** To confirm the success of this action open **TA100 PRO** click the File menu, Security, User Maintenance. There will be a new user: Autoprocess Service.

3. Open **TA100 PRO**, click the **Communications** menu, **Auto Process**. In the **Configure Auto Processing** dialog window select **1000 Autoprocess Service**, click **Edit** and configure your specific auto process features (see **Add an AutoProcess**).

4. Locate your system Services window and **Start** the Time America Auto Process or…

5. In Windows Explorer find the **TA100 PRO** folder. Locate and double-click **autoProcessServiceSetup** this will allow you to start the automated service.

6. Click the **Start** button. If you want the service to start when the operating system is starting, check the appropriate box.
Add an AutoProcess

1. Click the **Communications** menu, **AutoProcess**. The **Configure Auto Process** dialog box will open.

2. Click the **Add** button and the **Auto Process Maintenance** dialog box will open.

3. Enter the Number and Name for this Auto Process.

4. Click the **Add** button. The **Auto Process Schedule Details** dialog box will open.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description for this AutoProcess Schedule. Examples: Poll California Clock, Run Payroll Reports, etc.</td>
</tr>
</tbody>
</table>
Run a File
Select this option to schedule an Event that will launch any sort of executable program. An example of this might be a Batch file that "zips" up your data files and copies them to a safe location on your network. With this option selected, you must enter the path to the desired file.

Poll Clocks
Select this option to schedule an event that will poll the transactions from any or all of your time clocks. This Event can also perform any of the other normal time clock polling options.

You must be sure to "tag" all the time clocks you want to poll by either double-clicking on them or selecting the "tag all" button. You must also select at least one polling option by clicking the "Poll Options" button.

Run Reports
Select this option to schedule an Event that will automatically run any of several reports such as "Missing Punches" or "Hours".

You may notice that the list of available reports is greatly abridged and that none of the Payroll Exports are available. Time Card data should be thoroughly reviewed before running any Payroll Export. Each report to be run must be "tagged" by double-clicking it and choosing the desired settings in the Report Parameter Window. Once set, these parameters can be changed at any time by clicking the Report Options button.

Reindex
Select this option to schedule an event that will Reindex all the system databases.

This Event must be scheduled at a time when it is most likely that all users will be logged out. If another user is logged into the system, this Event will be skipped.

Items List
The items that display in this list depend upon the type of AutoProcess chosen. For example, if Poll Clocks is selected, this list will display all the clocks configured in the program.

To select a single item, double-click the item to "tag" it.

Click the Tag All button to select all items.

Time
Enter the time at which you want the process to occur.

Day of the Week
Select the days of the week you want the process to occur.
**Tag All/Untag All**  
Click the **Tag All** button to select all the items in the list. Click **Untag All** to deselect all the items in the list.

**Poll Clocks AutoProcess**

1. If **Poll Clocks** is selected, select the clock(s) you wish to poll with this process by double-clicking each clock to “tag” it.

2. If **Poll Clocks** is selected, click the **Polling Options** button to configure the settings for polling. The **Polling Options** dialog box will open.

3. Check the options that are appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Poll Transactions</strong></td>
<td>Check this option to transfer punches from the clock to TA100 Pro.</td>
</tr>
<tr>
<td><strong>Clear Clock Transactions</strong></td>
<td>Check this option to clear the transactions from the clock after transferring them to TA100 Pro.</td>
</tr>
</tbody>
</table>

**TIP:** This does not need to be done every time. You may leave the transactions in the clock until payroll is processed successfully, however if you have a lot of employees you will want to clear more frequently so the clock memory does not fill up.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Clock Date and Time</strong></td>
<td>Check this option to send the computer's current date and time to the clock.</td>
</tr>
</tbody>
</table>

**TIP:** You may not want to do this every time, as the clock’s internal clock tends to be much more accurate than the computer's.
Program Clock
Check this option to send programming and configuration information (such as the settings in the Configure Clock dialog box) to the clock. Clock function keys and function messages are sent to the clock during programming.

This option should only be used when basic clock setup has been changed since the initial programming.

Load Bell Schedules
Check this option to send pre-defined Bell Schedule assigned to the clock.

Bell schedules are only checked at midnight, so a bell will not ring on the same day the bell schedule was downloaded. The Bell Module must be installed to use this option.

NOTE: This is not recommended with the TA520 or TA530, as the clock needs to roll past midnight for the bell schedule to take effect.

Load Messages
Check this option to send employee messages to the clock.

Hand Reader
These settings only apply to the Hand Reader clocks. The options are:

Send Hand Templates: Select this option to send employee hand templates to the clock. This can be used to upload a template to a new clock, or to restore templates to a clock that has been cleared.

Clear Templates: Check this option to clear the templates from the clock. USE THIS OPTION VERY CAREFULLY, as it will delete all existing templates in the clock and employees will not be able to punch until the templates are restored.

Retrieve Hand Templates: Check this option to download new hand templates from the clock for input into the TA100 Pro database.

Process Punches after polling
Check this option to automatically put the punches into the online timecards of the employees.

4. Click OK to commit the changes and return to the Auto Process Maintenance screen.

5. Click OK to commit the changes and return to the Configure Auto Process Screen.

6. Click Start to activate the Auto Process schedule.

NOTE: TA100 Pro must be running for the Auto Process to work. You may minimize the TA100 Pro window.
NOTE: For network installs, you will need to check that the network is not doing any backups or running any utilities during the auto processing schedule.

**Run Reports AutoProcess**

1. If *Run Reports* is selected, choose the report(s) you wish to run by double-clicking each report to "tag" it and filling in the report settings. The *Report Parameters* dialog box for the selected report will open.

2. Fill in the *Report Parameters* windows as described in the *Run Reports* section.

3. Click OK to commit the changes and return to the *Configure Auto Process Screen*.

4. Click Start to activate the Auto Process schedule.

**Run a File AutoProcess**

1. If *Run a File* is selected, you will be prompted to choose the file (program, etc.) to run.

2. When all settings are complete, click OK. The AutoProcess will begin on the next occurrence of the date and time specified in the *AutoProcess Schedule Details*.

3. Click OK to commit the changes and return to the *Configure Auto Process Screen*.

4. Click Start to activate the Auto Process schedule.

**Edit an Auto Process**

1. Click the *Communications* menu, **AutoProcess**. The *Configure Auto Process* dialog box will open.

2. Select the AutoProcess you wish to change.

3. Click the Edit button.

4. Edit the settings as described in the *Add an AutoProcess* section.

**Delete an AutoProcess**

1. Click the *Communications* menu, **AutoProcess**. The *Auto Process Maintenance* dialog box will open.

2. Select the AutoProcess you wish to delete.
3. Click the **Delete** button. You will be prompted:

![Confirmation dialog box](image)

*Figure 193: Deletion Confirmation*

4. Click **OK** to confirm the deletion.

5. Click **Close** to exit the dialog box.
Chapter XIII Utilities

This section describes the system utilities built into TA100 Pro. It includes importing and exporting, reindexing, system archiving, system backups, and more.

Importing

It is possible to import data from other programs. Employee data, time transactions, and departments can be imported from previous versions of the software as well as from other third party systems, spreadsheets, and payroll programs.

Advanced Import

Employee data and attendance reports from third party accounting systems, spreadsheets, and payroll programs can be imported into TA100 Pro. The original files may be in any number of formats including ASCII comma delimited, Excel, or Lotus 1-2-3. When imported, the data is appended to the specified system database file. The file types TA100 Pro Import supports are:

- Framework II (FW2)
- Microsoft Multiplan 4.01 (MOD)
- Paradox 3.5/4.0 (DB)
- Rapidfile (RPD)
- Lotus 123 versions 1 through 3 (WKS, WK1, WK3)
- Symphony version 1 through 1.2 (WRK, WR1)
- Microsoft Excel (XLS)
- Comma Delimited
- Tab Delimited
- Space Delimited
- System Data Format (SDF)
- Symbolic Link Format (SYLK)
- Data Interchange Format (DIF)
- FoxPro
1. Click the **File** menu, **Import, Advanced**. The **Configure Import** dialog box will open.

   ![Configure Import](image1.png)

   *Figure 194: Configure Import*

2. Select the type of file to be imported.

3. Click the **Import File** button to select the file that contains the information to be imported. The **Open** dialog box will open.

   ![Open](image2.png)

   *Figure 195: Open File*

4. Navigate to and select the file you wish to import. The file must be of one of the types listed at the beginning of the Import section.

5. Click the **Select** button to commit the change.

6. Click the **Append To** button to select the table onto which this data will be appended. The **Open** dialog box will open.
7. Select the TA100 Pro database file to which you wish to append, and click the **USE** button to continue.

8. Click **OK** to begin the import process.

### Exporting Data

The Export function allows you to extract data from TA100 Pro for use in other programs. When exported, the database files can be used with many commercial spreadsheet programs and report writers to generate custom reports. The supported applications are:

- Microsoft Multiplan 4.01 (MOD)
- Lotus 123 versions 1 through 2 (WKS, WK1)
- Symphony version 1 through 1.2 (WRK, WR1)
- Microsoft Excel (XLS)
- Comma Delimited
- Tab Delimited
- Space Delimited
- System Data Format (SDF)
- Symbolic Link Format (SYLK)
- Data Interchange Format (DIF)
- Database (FoxPlus)

1. Click the **File** menu, **Export**. The **Configure Export** dialog box will open.
2. Click the **Export File** button. The **Open** dialog box will appear.

3. Select the file you wish to export and click the **USE** button to continue.

4. Select the type of file you wish to export to. See above for a list of the available file types.

5. Click the **Save As** button to define the file name of the exported data. The **Save As** dialog box will open.
6. In the **File Name** box, enter the name you wish to use for the exported data file. The extension will fill in automatically based on the type of file chosen in the previous dialog box.

7. Click **Save** to continue.

8. Click **OK** to begin the export.
System Utilities

TA100 Pro provides utilities to keep your system running smoothly. Among other things, these utilities can repair databases, perform backups, and archive data for long-term storage.

Because these utilities affect data, and ultimately your payroll, contact your local representative if you have questions or concerns about the operation of a specific utility.

The following utilities are found under the Utilities menu under File and are described in this section:

- Reindex Databases
- Repair Databases
- Update Databases
- Initialize Databases
- Change Employee Number
- Change Employee Number Width
- Set Reprocess Date
- Fix Unassigned Badges
- Repost R-Files
- Purge R-Files
- Post Historical Data
- Archive Data
- Restore Archived Data
- Back Up System Files
- Restore System Files

Figure 200: Utilities Menu
**Repair Database**

The Repair Databases utility compares the contents of the database to the database’s index and attempts to rebuild the index to compensate for any inconsistencies. This utility cannot replace or recover data that has been lost or corrupted.

It is recommended that you repair your TA100 Pro databases prior to Reindexing in order to ensure that the data is optimized.

1. Click the **File** menu, **Utilities, Update Databases**. The **Repair Selection** dialog box will open.

   ![Figure 201: Repair Selection](image)

2. Select the database you wish to repair by clicking **Add** to select an individual database or **Add All** to add all. It is recommended that you repair all files.

3. Click **OK** to begin the repairing process. A progress bar will show the percentage of completion.

**Reindex Database**

The Reindex Databases utility removes deleted records and sorts the data base in either numeric or alphabetic order depending on the contents. Since this utility has the greatest impact on the speed and reliability of TA100 Pro, it is recommended that you develop a weekly schedule for reindexing system database files. Also, it is a good idea to Repair the database prior to Reindexing. Repairing fixes inconsistencies and potential problems in the data. See **Repair Databases**, page 251.

**TIP**: Reindex can be set as an AutoProcess. See **Configure an AutoProcess**, page 238.

1. Click the **File** menu, **Utilities, Reindex Databases**. The **Reindex Selection** dialog box will open.

   ![Figure 202: Reindex Selection](image)
2. Select the database you wish to reindex by clicking **Add** to select an individual database or **Add All** to add all. It is recommended that you reindex all files.

3. Click **OK** to begin the reindexing process.

**Update Databases**

The Update Databases utility is used when upgrading TA100 Pro to a newer version of the software. It makes all the required modifications to your current database so that it operates with any new file structures.

1. Click the **File** menu, **Utilities, Repair Databases**. The **Update and Compare** prompt will appear.

   ![Figure 203: Repair Selection](image)

   2. Click **OK** to begin the updating process.

**Initialize Databases**

The Initialize Databases utility completely removes the contents of database files. This utility is useful when databases become corrupted beyond recovery.

**NOTE:** This utility completely deletes ALL data in the selected databases. Only the SYSOP is able to initialize data.

1. Click the **File** menu, **Utilities, Initialize Databases**. The **Initialize Selection** dialog box will open.

   ![Figure 204: Initialize Selection](image)
2. Select the database you wish to Initialize by clicking **Add** to select an individual database or **Add All** to add all.

3. Click **OK** to begin the process. **ALL DATA IN THE SELECTED TABLES WILL BE DESTROYED.**

**Change Employee Number**

Once an employee has been added to the system, you can no longer change his or her employee number through the Configure Employees Detail screen. This utility allows you to change employee numbers, one employee at a time.

1. Click the **File** menu, **Utilities, Change Employee Number**. The **Change Employee Number** dialog box will open.

![Figure 205: Change Employee Number](image)

2. Select the employee whose number you wish to change using the drop-down list in the **Old** field.

3. Enter the new employee number in the **New** field.

4. Click **OK** to change the employee’s number.

**Change Employee Number Width**

The number of digits (width) in the Employee Number is initially defined in the Configure Main Company dialog box. However, once employees have been added you can no longer change the setting through the Main Company screen. This avoids accidental data loss.

This utility allows you to change the number of digits for Employee Numbers safely. Typically, the width should only be changed to a higher (longer) number in order to avoid losing data. When digit length is increased, the digits are added on to the left of the current number. When digits are taken away, they are taken from the right.

1. Click the **File** menu, **Utilities, Change Employee Number Width**. The **Change Employee Number Width** dialog box will open.
2. Enter the number of digits for the new employee number.

3. Click OK to commit the change.

Set Reprocess Date

The Set Reprocess Date utility allows you to globally reset the reprocess date for employees.

Processing occurs when TA100 Pro takes the punches from a clock and applies them to the correct employee, taking into account pre-setup information such as Company Policy, Shift rules, etc. Reprocessing is what happens when a user has made changes to the polled punches, and/or configuration information, and now needs to have TA100 Pro recalculate the data. If TA100 Pro had to recalculate data every time a user opened an employee timecard, the usefulness of the program would be offset by the amount of time needed for the calculations. Time is saved by allowing a user to make all necessary changes before reprocessing the data, which is the driving reason behind having automated timekeeping software.

This utility does not actually reprocess the punches. It allows a user to decide how far back, and for whom, the system will process punches. After changing this setting, you will need to manually reprocess, at which time the system will reprocess back to the date entered here for the employees selected.

1. Click the File menu, Utilities, Set Reprocess Date. The Reprocess Punches dialog box will open.
2. Enter the **Reprocess** date.

3. Select the employees for whom you wish to reprocess by using the **Add** button to select an individual employee or **Add All** to select all.

4. Click **OK** to complete the change.

5. Reprocess punches. This can be accomplished by clicking the **Reprocess** button in the *Online Timecard*. See *Online Timecard*, page 158. Or by running a report with the **Reprocess** button selected.

---

**Fix Unassigned Badges**

Employees are able to start punching at the clocks before their data is entered into TA100 Pro. The badge used by the employee is considered to be unassigned if the employee's punches are polled prior to the employee being added to the software. You can repost the employee's punches after adding the employee to the software using this utility.

1. Click the **File** menu, **Utilities, Fix Unassigned Badges**. The *Unassigned Badge Maintenance* dialog box will open.

![Figure 208: Unassigned Badge Maintenance](image)

2. This screen will show the employees whose badges were unassigned at the time of polling.

3. Select the employee you wish to repost. Make sure that this employee is added to the program at this time and has the correct badge number. You may also click **Print** to view a list of all unassigned badges.

4. Click the **Repost** button. TA100 Pro will match the badge in the transaction to a badge assigned to the employee.

5. The Special Repost option will compare the listed **badges** to current **employee numbers** (rather than comparing to a badge number). It assigns any transaction to the employee whose employee number matches the unassigned badge number. This option should only be chosen after a regular reposting.

6. Click **Close** to exit the dialog box.
Repost from R-Files

R-Files are the files that store punch data downloaded from the clocks. There is one R-File for each day, which contains all the punches from that day. This data is imported into TA100 Pro, but the original file is kept so that it can be referenced or re-imported if necessary. Reposting an R-File allows you to re-import the punch data stored in one of these files.

1. Click the File menu, Utilities, Repost from R-Files. The Repost R-Files dialog box will open.

![Figure 209: Repost R-Files](image)

2. Select the file you wish to repost by double-clicking it to "tag" it. Or select all files by clicking the Tag All button.

3. Click OK to repost the files.

Purge R-Files

R-Files are the files that store punch data downloaded from the clocks. There is one R-File for each day, which contains all the punches from that day. This data is imported into TA100 Pro, but the original file is kept so that it can be referenced or re-imported if necessary. These files are kept indefinitely, taking up space on your hard drive. You may wish to purge (delete) these files periodically in order to free up disk space.

This should not be done before a particular R-File has been successfully imported to TA100 Pro, as doing so will result in a loss of the punches contained in the R-File.

1. Click the File menu, Utilities, Purge R-Files. The Purge R-Files dialog box will open.
Figure 210: Purge R-Files

2. Select the file you wish to purge by double-clicking it to "tag" it. Or select all files by clicking the Tag All button.

3. Click OK to purge the files.

Post Historical Data

Posting Historical Data allows you to move historical information to another location, where it can still be accessed for reports, but where it is not slowing down the performance of the program. You must also Post Historical Data prior to Archiving it. (See Archive, page 258).

TA100 Pro keeps track of a large amount of information. As the number of employees goes up, the amount of data that pertains to those employees goes up. After awhile, the amount of data that needs to be processed will noticeably slow down the computer. TA100 Pro allows a user to decide when past transactions will no longer be needed for editing, and 'saves' the processed punches to another file. The transactions in this new file cannot be edited in any way.

Posted transactions will appear in reports, but will not appear in online timecards or transactions screens. If the transactions do need to be edited, they will need to be unposted. The difference between posting data and archiving data is posted data will appear on reports, archived data will not. Data cannot be archived until it has been posted.

1. Click the File menu, Utilities, Post Historical Data. The Post Historical Data dialog box will open.

Figure 211: Post Historical Data

2. Enter the date up to which you wish to post data. As posted data can no longer be edited on screen, make sure that the date entered is far enough in the past to suit your needs.
3. If you wish to Unpost previously posted data (in order to edit it, for example), check the **Unpost** data box.

4. Click **OK** to complete the action

**Archive**

The Archive utility removes time and attendance data from your system and stores it in another location for archive purposes. Unlike the System Backup utility that only copies files, the Archive utility copies specific data, then deletes it from the system to free up more of the hard drive space.

You must Post Historical Data prior to archiving. See above.

1. Click the **File** menu, **Utilities, Archive**. The *Archive Maintenance* dialog box will open.

![Figure 212: Archive Maintenance](image)

2. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ending Date</strong></td>
<td>Enter the date up to which to archive. Database files are archived prior to this user-defined date. The ending date must be at least 14 days earlier than the Posting/Unposting Historical Data date. For example, if you want to archive data from 1999, you would input 12/31/1999. If this is the first time you are archiving, the archive file will consist of all the data from January 01, 1900 to the selected date.</td>
</tr>
<tr>
<td><strong>FileName</strong></td>
<td>Enter a name for the archived file. The Filename can be any combination of characters up to 8 digits long. The default name for this file is the Ending Date of the archive.</td>
</tr>
</tbody>
</table>
**Archive To**  
Select the destination drive for the file. The options are:
- **Drive A**: Typically a floppy drive.
- **Drive B**: Typically a floppy drive.
- **Other**: Can be the local hard drive or any network drive.

**Destination**  
Enter the destination drive letter and directory for the archived file.

**Compression Method**  
Select the Compression method for the archived data. The options are:
- **Maximum**: Saves as much disk space as possible, but takes longer.
- **Fast**: Compresses quickly with high data integrity, and is the default option.
- **Store Only**: Does not compress data, but stores it all in one file.

**Format**  
If Drive A or B are selected, these settings will become available. TA100 Pro will format the floppy drive prior to copying the archived file onto it. Choose the method of formatting desired. The options are:
- **Quick**: Deletes all information on the drive, without formatting.
- **Conditional**: Saves the table that is on the disk.
- **Unconditional**: Deletes everything on the disk, and reformats.
- **Low Density**: Formats a low density disk, which almost never heard of anymore and should only be used by knowledgeable users.

**Span Floppies**  
Select this option if TA100 Pro should split a large archive file so that it can be "spanned" over more than one floppy disk. You will be prompted to insert disks as needed.

**Append to File**  
Select this option to have new archive information add to an existing archive file of the same name.

**Overwrite File**  
Select this option to have new archive information overwrite an existing archive file of the same name.

**Overwrite Records**  
If append to file is selected, you will need to decide how duplicate records should be handled. Select this option to overwrite existing duplicate records with new information.
Discard Records  Select this option to discard the new duplicate records and keep the existing records.

3. Click OK to complete the Archive.

Restore Archive

Archived data is data that has been removed from the TA100 Pro software, but has not been deleted. The only information that is stored in an archive is transactions and schedules. This information can be added back into TA100 Pro by Restoring the Archive. If the information is going to be edited, the Post Historical Data utility needs to be run after Restoring from Archive to unpost the data and make it available for edits.

TA100 Pro archive files ending with ".ARC". It is important to note that when restoring an archive, the archive does not get deleted or altered in any way. It still exists in the same state as before the restoring process. The transactions in the archive are copied into the appropriate TA100 Pro database. It is possible to restore individual employees from the archive.

1. Click the File menu, Utilities, Restore Archive. The Restore Archive Maintenance dialog box will open.

2. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select File</strong></td>
<td>Click the Select File button to choose the Archive file you wish to restore.</td>
</tr>
<tr>
<td><strong>Archive overwrites existing records</strong></td>
<td>Check this option to have TA100 Pro overwrite duplicate records with the archived data.</td>
</tr>
<tr>
<td><strong>Keep existing records</strong></td>
<td>Check this option to have TA100 Pro keep existing records and ignore the duplicate archived data.</td>
</tr>
<tr>
<td><strong>All Employees</strong></td>
<td>Check this option to restore data for all employees.</td>
</tr>
</tbody>
</table>

Figure 213: Restore Archive Maintenance
Individual Employees
Check this option to restore data for individuals. You have the opportunity to choose employees after clicking the OK button.

Date Range
Enter the date range for which you wish to restore records.

**TIP:** To restore all transactions for the chosen employees contained in this archive, put in 01/01/1900 in the first field and today’s date in the second field.

3. Click OK. If All Employees was selected, the restoration process will begin immediately. If Individual Employees was selected, you will be prompted to select the employees, after which the restoration will begin.

System Backup
System Backup takes a copy of the database files as of the date of the backup. These backup files can be restored if necessary. If for some reason the computer/network crashes, the data can be loaded into a new or existing installation of TA100 Pro with no downtime. Backing up TA100 Pro should be done on a regular basis.

1. Click the File menu, Utilities, System Backup. The System Backup Maintenance dialog box will open.

![System Backup Maintenance dialog box](image)

**Figure 214: System Backup Maintenance**

2. Fill in the settings as appropriate:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup File Name</td>
<td>Enter the name you wish to use to refer to this backup file. A good practice is use the date of the backup as the file name.</td>
</tr>
<tr>
<td>Backup To</td>
<td>Select the destination drive for the file. The options are:</td>
</tr>
<tr>
<td></td>
<td>Drive A: Typically a floppy drive.</td>
</tr>
<tr>
<td></td>
<td>Drive B: Typically a floppy drive.</td>
</tr>
<tr>
<td></td>
<td>Other: Can be the local hard drive or any network drive.</td>
</tr>
</tbody>
</table>
**Destination**
Enter the destination drive letter and directory for the backup file.

**Compression Method**
Select the Compression method for the backup data. The options are:

- **Maximum**: Saves as much disk space as possible, but takes longer.
- **Fast**: Compresses quickly with high data integrity, and is the default option.
- **Store Only**: Does not compress data, but stores it all in one file.

**Format**
If Drive A or B are selected, these settings will become available. TA100 Pro will format the floppy drive prior to copying the backup file onto it. Choose the method of formatting desired. The options are:

- **Quick**: Deletes all information on the drive, without formatting
- **Conditional**: Saves the table that is on the disk.
- **Unconditional**: Deletes everything on the disk, and reformats
- **Low Density**: Formats a low density disk, which almost never heard of anymore and should only be used by knowledgeable users

3. Click **OK** to begin the backup.

**System Restore**
System Restore restores your TA100 Pro database files from backup. When Restoring a Backup, all changes made after the backup was performed will be lost. If a clock has been polled after the backup was performed, the transactions from that polling will have to be reposted.

1. Click the **File** menu, **Utilities, System Restore**. The **System Restore Maintenance** dialog box will open.

![System Restore Maintenance dialog box](image)

2. Fill in the settings as appropriate:
### Setting Definition

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select File</td>
<td>Click this button to choose the backup from which to restore.</td>
</tr>
<tr>
<td>Restore Original Date/Time</td>
<td>Check this box to change the creation date of the files being restored to the backup's date and time (rather than the current date).</td>
</tr>
<tr>
<td>DOS Verify On</td>
<td>Check this box to verify the files checksum between the backup version and the restored version.</td>
</tr>
<tr>
<td>Overwrite Existing</td>
<td>Check this box to overwrite existing records with the backup records. This should always be checked, otherwise you will be prompted to overwrite each table in the database.</td>
</tr>
</tbody>
</table>

3. Click **OK** to begin the restoration process.

### Additional Utilities

TA100 Pro provides some "nice-to-have" utilities in addition to the System Utilities, including:

- Calculator
- Calendar
- Conversion Table
- System Info
- Macros

These utilities are found under the Help menu.

![Help Menu](image)

**Figure 216: Help Menu**

### Calculator

1. Click the **Help** menu, **Calculator**. The **Calculator** will open.
2. You may enter numbers and functions by typing or by clicking the appropriate buttons on the keypad.

Calendar

1. Click the Help menu, Calendar. The Calendar will open.

   ![Calendar Image]
   
   Figure 218: Calendar

2. You may scroll through months and years using the navigation buttons.

   NOTE: The Calendar can also serve as a daily diary.

About

The About screen displays the serial number information and all extra modules the client has purchased. This is also where you can activate the Hand Reader.

   NOTE: This only applies to Hand Readers that do not match the Time America internal code and were not purchased directly from Time America.

   1. Click the Help menu, About. The About will open.
   2. Click on Hand Reader Activation button as shown below.
System Configuration

The System Configuration screen displays the technical setup of your computer.

1. Click the Help menu, System Configuration. The System Configuration window will open.

2. Press Esc to exit the dialog box.

Conversion Table

The Conversion Table displays conversions from 12 Hour to 24 Hours and minutes to hundredths of an hour.

1. Click the Help menu, Conversion Table. The Conversion Table will open.
Macros allow you to record keyboard steps in TA100 Pro and play them back by pressing a key. For example, you could record a macro to Poll time clocks.

1. Click the Help menu, Macros. The Record Macro dialog box will open.

![Record Macro](image)

2. Press the key or key combination that will run this macro.
3. Enter a name for the macro (no spaces.)
4. Click OK to begin recording.
5. Perform the steps you wish to record. Type the keystrokes you normally press to perform an operation on the keyboard. Remember, only keyboard operations can be recorded.
6. Press Shift + F10 to stop recording. The Stop Recording Macro dialog box will open.
7. Click one of the following:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Click OK to stop recording the macro.</td>
</tr>
<tr>
<td>Continue</td>
<td>Click continue to continue recording the macro after a pause.</td>
</tr>
<tr>
<td>Discard</td>
<td>Click Discard to cancel recording and discard the macro.</td>
</tr>
<tr>
<td>Insert Literal</td>
<td>Click Insert Literal to record the literal meaning of the next keystroke.</td>
</tr>
<tr>
<td>Insert Pause</td>
<td>Click this button to insert a pause into the macro, then select the Key to Resume or Seconds option below.</td>
</tr>
<tr>
<td>Key to Resume</td>
<td>Select this option to pause the macro until SHIFT+F10 is pressed to continue.</td>
</tr>
<tr>
<td>Seconds</td>
<td>Click Seconds to pause the macro for a period of time (in seconds). Enter the number of seconds in the adjacent field.</td>
</tr>
</tbody>
</table>
Additional polling key ....................................... 16
Approval Editor............................................... 164
Archive ........................................................... 241
  restore....................................................... 243
ATS ................................................................ 208
  configure..................................................... 208
Audit Trails ..................................................... 161
Automatic Processes ....................................... 222
AutoProcess................................................... 222
  add.............................................................. 222
  delete.......................................................... 227
  edit.............................................................. 227
AutoProcessing .............................................. 220
Background
  change.......................................................... 25
Backup ........................................................... 244
  restore......................................................... 245
Badges ........................................................... 145
  add.............................................................. 146
  delete.......................................................... 147
edit.............................................................. 147
employee...................................................... 145
Bell Schedules .............................................. 81, 110
  add ............................................................... 82
  configure..................................................... 81
  edit.............................................................. 83
Benefit Accumulators
  configure..................................................... 103
Benefit Entitlement
  configure..................................................... 132
  delete.......................................................... 134
details .................................................................133
grant .................................................................134
Benefits ....................................................................101, 110
accumulators ..........................................................103
configure .................................................................135
employee .................................................................132
Categories ...............................................................37
add ...........................................................................41
configure ................................................................38
delete ......................................................................42
edit ...........................................................................41
Change Employee Number ........................................236
Change Employee Number Width ................................236
Change Password ...................................................100
Clocks .....................................................................188
adding .....................................................................216
ATS ...........................................................................208
ATS, configure ..........................................................208
auto polling ..............................................................222
connections ...........................................................188
Deleting .....................................................................217
edit ...........................................................................217
Hand Reader ............................................................211
Hand Reader, configure ............................................211
polling .....................................................................220
TA500/600 Series .....................................................189
TA500/600 Series, configure ......................................189, 197
TASC .......................................................................200
TASC, configure .......................................................200
Configuration ...........................................................27
Bell Schedules .........................................................81, 110
Benefits ....................................................................101, 110
categories .................................................................37
Departments ............................................................73, 77
Divisions ...................................................................34
Groups .....................................................................70
Holidays ....................................................................68
Main Company ........................................................28
Policies .....................................................................43
Security .....................................................................84
shifts .......................................................................55
Configure Users ........................................................95
Databases
initialize ..................................................................235
reindex .....................................................................234
repair ........................................................................234
update .....................................................................235
Demonstration (demo) key ..........................................17
Departments ............................................................73, 77
add ...........................................................................76
configure ..................................................................76
delete ........................................................................76
edit ...........................................................................76
Differential
configure ....................................................................51
Divisions ...................................................................34
Employee info ..........................................................147
Employee Level Wage ..................................................144
Employee Maintenance ..............................................132
Employee Maintenance ..............................................115
Employee Settings .....................................................147
Employee Status ........................................................129
Employees ................................................................115, 116
add ...........................................................................149
badges .....................................................................145
benefits .....................................................................132
delete ........................................................................151
details ......................................................................147
edit ...........................................................................150
messages ..................................................................139
schedule ....................................................................120
selecting ..................................................................169, 170
Status .......................................................................129
transactions ..............................................................128
wages .......................................................................141
Environment
bell tones ....................................................................25
change background ...................................................25
large button toolbar ....................................................26
Ethernet .....................................................................188
Exceptions
configure ....................................................................52
Exiting Genesis Pro ....................................................20
Exporting .................................................................230
From Schedule ..........................................................161
Getting Started ..........................................................19
Global .......................................................................169
message assignment ...................................................170
transactions ..............................................................171
Employee Details
configure ..................................................................147
INDEX, Cont.

R-Files
purge................................................. 239
repost................................................. 239

Rounding Rules
add ..................................................... 66
edit ..................................................... 67

Running a Report
by individual....................................... 179
by range ............................................. 174

Schedules ........................................... 120
assign ............................................... 122
copy .................................................. 125
delete ............................................... 123
employee ........................................... 120
rotating ............................................. 124
template ............................................ 125

Security
add a user .......................................... 84
change password .................................. 99
configure levels .................................. 85
configure users .................................. 95
User Maintenance ................................. 95

Security Levels
add ..................................................... 93
configure .......................................... 85
delete ............................................... 94
edit ................................................... 94

Serial .............................................. 188

Set Date and Time ................................ 218

Shift Group
add ..................................................... 64
configure .......................................... 55
delete ............................................... 65
edit ................................................... 64

Shifts .............................................. 55
add ..................................................... 65
delete ............................................... 66
edit ................................................... 65
shift group ........................................ 55

Shortcut keys ..................................... 22

Starting Genesis Pro ......................... 19

Status ............................................. 129
add ..................................................... 130
edit ................................................... 131
employee .......................................... 129

Support
Technical .......................................... 9

System requirements ............................ 10

System Environment
customizing ........................................ 25

System Utilities .................................. 233
TA500 Series ...................................... 189
configure .......................................... 189, 197
TA520/530 .......................................... 189
TA600 Series ...................................... 189
configure .......................................... 189, 197
TA620 ................................................. 189
TASC ............................................... 200
configure .......................................... 200
Technical support ................................ 9

Terminals ......................................... 188
customizing ........................................ 25
connections ........................................ 188
Timecard .......................................... 152
accessing .......................................... 152
description ........................................ 117
navigating .......................................... 153
online ............................................... 152
Timecards ......................................... 152

Tips and Techniques ............................. 21

Toolbar
displaying large buttons ....................... 26

Transactions ...................................... 152, 154, 161
add ..................................................... 155, 156, 158, 159, 161
adding ............................................... 154
deleting ............................................. 161
description ........................................ 128
edit ................................................... 158, 159
editing ............................................... 154, 164
global ............................................... 171
navigating .......................................... 154

Unassigned Badges .............................. 238

Underlined letters ............................... 21

Update ............................................. 235

User Accounts
SYSOP ............................................. 19
User Maintenance ............................... 95

Users
add ..................................................... 99
delete ............................................... 100
edit ................................................... 99

Utilities .......................................... 228
additional .......................................... 246
system ............................................. 233

Wages ............................................. 141
add ..................................................... 143
customizing ....................................... 141